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DM Genie Help Contents
Please pick a topic below to learn more...
If you are using Player Genie please see the Player Genie Users topic.

General Information
•
•
•
•
•
•
•
•
•
•
•
•
•

DM Genie at a Glance
Converting a 3.0 Campaign to 3.5
System Requirements
Open Gaming License v1.0a
Glossary of Terms
Registering DM Genie
Registering Player Genie
Shareware Evaluation
Customizing Game Rules
Why Doesn’t DM Genie have data from book X?
Can DM Genie work with Game System X?
Maximums in DM Genie
Tips for Performance

Learning to Use DM Genie
•
•
•
•

Word Processor Commands
Automatic File Saving
Keyboard Shortcuts
Options Dialog

•
•

Steps for Running a Battle
Tutorials

Help for Each Window
•

Main Window
o Main Window Menus
o Creature List
Creature List Display Options
Creature List Popup Menu
o Combat Log
Buttons Above the Combat Log
o Quick-Info Frame
o Creature Tab Strip
Combat Statistics Frame
Conditions Frame
Skills Frame
Feats Frame
Spells Frame
• Learning a Spell
• Casting a Spell
• Memorizing/Preparing Spells
• Spells Pop-up Menu
Psionics Frame
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Notes Frame
Desc Frame
Items Frame
• Items Pop-up Menu
o Actions Tab Strip
Attacks Frame
Actions Frame
Class Abilities Frame
Classes Frame
Stat Block Frame
o Searching for Text (Main Window
•

Campaign Manager
o Writing Adventures
Adventure Description
Adventure Items
Adventure Creatures
Random Encounters
Adventure Map
Adventure Campaign Notes
o Adventure Hyperlinks
o Creating a Campaign
o Selecting a New Campaign
o Searching Adventures for Text
o Printing an Adventure

•

New Creature Screen
o New Creature: PC or NPC
o New Creature: Monster
o New Creature: Import Stat Block
o New Creature: Other Sources

•

Group Manager
o Editing the Groups
o Adding Creatures

•

Race Editor
o Basic Race Info
o Race Attacks Frame
o Skills and Misc. Information
o Race Description
o PC Races
o Automatic Race Creation

•

Condition Setter

•

Conditions Editor
o About Conditions
o Editing Spells’ and Powers’ Associated Conditions

•

Roll Window
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•

Timekeeping Window
o Events Log
o Current Weather
o Movement Speed and Distance Traveled
Terrain/Road
Hampered Movement
o Reminders

•

Dice Roller

•

Appraisals Window

•

Weather Generator
o Choosing a Climate and Terrain
o Latitude
o Weather Adjustment
o Daily Weather

•

Importing and Exporting
o Exporting a Creature, Importing a Creature
o Exporting a Group, Importing a Group
o Exporting Other Files, Importing Other Files
o Exporting an Adventure, Importing Adventures
o Unknowns Found During Import
o Exporting a Campaign, Importing a Campaign

•

Standard Weapons Editor

•

Items Editor

•

Random Treasure Generator

•

Class Editor
o Class General Information
o Class BAB/Saves
o Class Requirements
o Class Skills
o Class Bonus Feats
o Class Features
o Class Spellcasting Information
o Class Spell Slots
o Class Psionics Information
o Class Starting Packages
o Class Scripting

•

PC Leveling Wizard
o Leveling – Class Selection
o Leveling – HP, Abilities, BAB and Saves
o Leveling – Skills
o Leveling – Feats
o Leveling – Features
o Leveling – Spells
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o Leveling – Psionics
•
•

Hit Dice Detail
Templates
o Templates – Applying to a Character
o Templates – Editing

•

Custom Data Editor

•
•

Character Sheet Output
Character Sheet Templates

•

Scripting
o Scripting for Feats
o Scripting – General Functions Available
o Scripting – Debugging
o Scripting – func Object
o Scripting – Creature
o Scripting – Creature Functions
o Scripting – Race
o Scripting – Attacks
o Scripting – LastDamage Object
o Scripting – Item Properties
o Scripting – Skill Object
o Scripting – Spell Object
o Scripting – Modifying Feats
Bulk Data Entry

•
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Player Genie Users
This help file covers the use of both DM Genie and Player Genie. However, several of the
features in DM Genie are not included in Player Genie. Please ignore the help topics covering: the
Group Manager; the Campaign Manager and adventure writing; the Random Treasure generator;
the Weather Generator and weather display in the Timekeeping window; the Roll Window.
These unavailable features will be preceded by the following text in red:
(Feature not available in Player Genie)
About Groups: Some help topics mention groups – there is only one group in Player Genie,
and it holds all the PCs you created. References to the "PC'
s Party" group, the "All Creatures" group
and the "Current Encounter" group can be thought of as one and the same in Player Genie.
Player Genie is a subset of DM Genie – all features that are in Player Genie are also in DM
Genie, but the opposite is not true. If you plan on DMing a game, check out DM Genie as it has
more capabilities to make a DM'
s job easier.
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DM Genie at a Glance
DM Genie is the ultimate in-game aid for DMs running role-playing games based on 20sided die, such as the 3rd edition of the world’s most popular RPG or the new revision 3.5. It allows
you to keep your mind on the story and the action – not on the rules and the math. When your PCs
enter a combat, you can create hordes of different enemies in a few clicks, roll their initiative and
sort them instantly, and have them attack the PCs with weapons, spells or special attacks, all
without stopping to consult reference books.
DM Genie keeps track of nearly 300 different conditions and spell effects, automatically
calculating the effects. Quick! Your monster is under the effect of the Barkskin spell, is prone and
has 50% cover. How fast can you tell me what his AC is? With DM Genie, you’ll know instantly.
You cast a spell on round 3, initiative count 14, with a duration of 6 rounds? DM Genie will
automatically remove the condition on round 9 and on initiative count 14, and warn you that the
creature is no longer under the spell. A NPC gains 4 temporary points to his Strength score? His
attack bonuses for every one of his melee weapons are adjusted accordingly, automatically – as are
his Str-based skill bonuses.
DM Genie holds a database of over 540 spells, 280 psionic powers, 580 types of monsters,
73 skills, 277 feats and special/class abilities, 20 armors and shields, 80 weapons and 1900 items –
and nearly everything has a useful description. And you can add or customize monsters, spells,
feats, items, armor and weapons – at any time.
DM Genie’s main window clearly displays all the information you need to run a battle in
one screen – even if your computer’s display is only 800x600. You can read a creature’s stats with
just a glance, and the descriptions for spells, feats and skills are always right there when you need
them.
See the System Requirements.
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System Requirements
Minimum System
Pentium 133 MHz
16 Megs of RAM + virtual memory
20 Megs of free hard drive space
800x600 display, 256 colors
Windows 95/98/XP/Me/2000/NT
DM Genie will run on older machines with enough virtual memory (we have tested it successfully
on a 486-66 Mhz, although it was quite slow), but needs a display of at least 800x600.
Recommended System
Laptop recommended for in-game use
Pentium 200 MHz
32 Megs of RAM
20 Megs of free hard drive space
1024x768 display, 16-bit color
Windows 95/98/XP/Me/2000/NT
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Converting a 3.0 Campaign to 3.5
This guide will help you convert your DM Genie/Player Genie characters to use the revised 3.5
rules. You will most likely still have a lot of work to do, especially for characters that changed a lot,
like Monks and Rangers. For these it may be better to start again the leveling process from scratch
(or create a brand new character).
First of all, Backup Your Data! You can use Winzip to save your entire campaign'
s directory (and
subdirectories), or you can export the campaign from within DM Genie.
This procedure assumes you'
ve been using a custom campaign. See the tutorial for instructions of
creating custom campaigns.
1. Before reinstalling DM Genie for revision 3.5 export all custom items you'
ve created (skills,
feats, races, etc, if any). Use the File->Export menu and the "Find Custom" button in it. Don'
t
export any of the standard skills/feats/etc.
2. Reinstall DM Genie with the revision 3.5 changes.
3. Start up DM Genie again and select the old 3.0 campaign.
4. Click the '
Customize->Rename for Conversion to 3.5'menu. This function will rename the
skills, feats and spells whose names have changed.
5. Export your characters, monsters, and/or adventures. To save time you can export entire groups
instead of one character at a time.
6. Then, create a new custom campaign using the 3.5 data sets. Go to the Campaign Manager'
s
'
File->Create a New Campaign'menu.
7. Start up DM Genie again in the new 3.5 campaign.
8. Import all the custom items you exported previously (if any).
9. Import your characters, monsters, and/or adventures. You will encounter the '
Unknown founds
during import window'
. For example, the Innuendo skill is unknown because it no longer exists in
3.5. Click Ignore to continue.
10. Check your characters for errors.
•
Important: The size bonus (or penalty) to attacks is no longer included in the BAB.
You need to change your Base Attack Bonus to get the correct attack bonuses. For example,
a size Small creature has +1 to attacks. It'
s BAB was previously increased by one to reflect
this - now you need to reduce it by one to match the new system.
•

Damage Reduction works differently - check your conditions and monster'
s DR

•
Any PC who had taken ranks in deleted skills or chosen now non-existent spells will
need some work to rebalance them.
•
Your custom races may have incorrect names in their '
Skills'
,'
Feats'
,'
Spell-Like
Abilities'boxes.
•

Class abilities/skill points have changed for some classes.
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Lots of items have changed. The ones currently in your PC'
s inventory will stay the
same, but you may replace them for the new version if you wish.
•

•
Conditions have moved around so you may find that your character has odd
conditions activated that weren'
t on before the update. Use the '
Clear all conditions'menu to
fix that.
•
Watch out for attacks that have an extra damage dice (e.g. "1d8 + 1d6") because
those have changed now and may need fixing.
•
Skill Synergy is now automatically handled. If you had manually given the synergy
bonus before you'
ll need to remove it because it will now be applied twice.

11. Start playing!
Good Luck!
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Registering DM Genie
Registering DM Genie will unlock the disabled features (if your evaluation has expired) and
will do away with all shareware reminders.
Thanks to shareware, you don'
t have to pay for pretty packaging and the software retailers'
profits. That means we can bring you a great product at a great price! Compare DM Genie to other
RPG helper programs that offer fewer features and are more complicated to use - the choice is clear.
Purchase your copy today!

Why Should I Register DM Genie?
•
•
•
•
•
•
•

files.

It'
s a great time saver!
It makes your job as a DM much easier!
You can use it for multiple different campaigns and gaming worlds.
Updates are free!
You get Technical Support.
No more shareware reminders!
After your 60-day evaluation period is over, you can no longer load or save most

Get help from the community in the discussion forums.
DM Genie will evolve according to your feedback and become exactly what you
want in a RPG program.
•
•

Getting a Registration Code
Go to our website’s purchase page at http://www.dmgenie.com/purchase.shtml. For
ordering-related questions, contact us at sales@dmgenie.com. The purchase price as of this version
of DM Genie is 29.95$ US, although this may change in the future. Consult our website for updated
prices.
From there, you can purchase the program via Paypal. You can use any major credit card to
pay. If you are not already a Paypal member, you will be asked to register – doing so takes only a
minute, and is completely free.
Once your payment is confirmed, we will send you your personalized registration code by email.

Once you have a Registration Code
Go to the “Help->Register DM Genie” menu from any DM Genie window to open the
Registration Form.
First, enter the e-mail address you used to purchase DM Genie in the text box at the top.
Make sure you are typing it correctly, and do not enter any spaces, punctuation or quote marks. DM
Genie verifies the syntax of the address to make sure it is correct.
Then, enter the Registration Code we gave you. To ensure the correct code is entered,
simply copy/paste it from the e-mail you received. If you do type it in, make sure you are respecting
the case, including every needed character, and not adding any other characters.
If your evaluation period had already expired, DM Genie will close automatically. When
you start it up again, all the data you had saved before the end of the evaluation period will be
loaded again.
After registering, you will not see any shareware reminders.
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What if my Registration Code doesn’t Work?
Double-check the spelling and case of both your e-mail address and the Registration Code.
Ideally, you should Copy/Paste the text directly. If you are still having problems, contact us at
sales@dmgenie.com for help.

Can I use my Registration Code on more than one computer?
As long as you are the only person who will be using the program, yes. For example, you
could install DM Genie on your laptop and your desktop and use it on both computers.
It is illegal for you to share your registration code with anyone. You alone are licensed to
use DM Genie.
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Registering Player Genie
Registering Player Genie will unlock the disabled features (if your evaluation has expired)
and will do away with all shareware reminders.
Thanks to shareware, you don'
t have to pay for pretty packaging and the software retailers'
profits. That means we can bring you a great product at a great price! Compare Player Genie to
other RPG helper programs that offer fewer features and are more complicated to use - the choice is
clear. Purchase your copy today!

Why Should I Register Player Genie?
•
•
•
•
•
•
•

files.

It'
s a great time saver!
It makes playing your RPG more about fun and less about rules.
You can use it for multiple different campaigns and gaming worlds.
Updates are free!
You get Technical Support.
No more shareware reminders!
After your 60-day evaluation period is over, you can no longer load or save most

Get help from the community in the discussion forums.
Player Genie will evolve according to your feedback and become exactly what you
want in a RPG program.
•
•

Getting a Registration Code
Go to our website’s purchase page at http://www.dmgenie.com/purchase.shtml. For
ordering-related questions, contact us at sales@dmgenie.com. The purchase price as of this version
of Player Genie is 18$ US, although this may change in the future. Consult our website for updated
prices.
From there, you can purchase the program via Paypal. You can use any major credit card to
pay. If you are not already a Paypal member, you will be asked to register – doing so takes only a
minute, and is completely free.
Once your payment is confirmed, we will send you your personalized registration code by email.

Once you have a Registration Code
Go to the “Help->Register Player Genie” menu from any Player Genie window to open the
Registration Form.
First, enter the e-mail address you used to purchase Player Genie in the text box at the top.
Make sure you are typing it correctly, and do not enter any spaces, punctuation or quote marks.
Player Genie verifies the syntax of the address to make sure it is correct.
Then, enter the Registration Code we gave you. To ensure the correct code is entered,
simply copy/paste it from the e-mail you received. If you do type it in, make sure you are respecting
the case, including every needed character, and not adding any other characters.
If your evaluation period had already expired, Player Genie will close automatically. When
you start it up again, all the data you had saved before the end of the evaluation period will be
loaded again.
After registering, you will not see any shareware reminders.
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What if my Registration Code doesn’t Work?
Double-check the spelling and case of both your e-mail address and the Registration Code.
Ideally, you should Copy/Paste the text directly. If you are still having problems, contact us at
sales@dmgenie.com for help.

Can I use my Registration Code on more than one computer?
As long as you are the only person who will be using the program, yes. For example, you
could install Player Genie on your laptop and your desktop and use it on both computers.
It is illegal for you to share your registration code with anyone. You alone are licensed to
use Player Genie.
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Purchasing DM Genie
Please see Registering DM Genie.
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Shareware Evaluation
When you first install DM Genie or Player Genie, you have 60 days to evaluate the program,
completely free of charge. There is also a limit of 400 runs, but under nearly all circumstances the
60-day period will expire first.

During the Evaluation
-

You have access to every function DM Genie/Player Genie has – this is not crippleware or
demoware.
Shareware reminders will pop up occasionally to remind you to register DM Genie/Player
Genie before the end of the evaluation.
You have plenty of time to use DM Genie/Player Genie in a few of your games, and to see
just how useful it is.

After the Evaluation Period is Over...
-

Some functions are disabled. You can no longer:
Load or save creatures, groups, adventures or custom races.
Create new skills, feats, spells, powers, races, standard items or standard weapons. Any
modifications made (to the description text for example) are not saved when you close DM
Genie/Player Genie.
Create or import campaigns. You can still use the campaigns you have already created.
You can still create custom items and weapons for creatures and adventures – however, they
will not be saved when DM Genie/Player Genie is closed.
All import/export functions are disabled. Stat block export/import is also disabled.
New weather generation is disabled.
You can still create adventures, groups, monsters and PCs, and run battles with them.
However, they will not be saved to disk.
The frequency of shareware reminders is higher.

What happened to my characters, adventures, etc.?
Don’t panic! They are all still on disk – you just cannot load them because the evaluation
period has expired. As soon as you register the program (see Registering DM Genie), all your old
files will be accessible again, just as when you left them.
Make sure you don’t uninstall DM Genie/Player Genie or erase any of the files in the DM
Genie/Player Genie directory or your campaign directory – then you would lose your data!
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Customizing Game Rules
All of the game rules DM Genie uses can be customized. Open your campaign’s
RULES.TXT file (or use the Campaign Manager’s File->Edit Rules menu). An invalid
RULES.TXT version will give a warning. Each campaign must have an up-to-date version of
RULES.TXT, but DM Genie will automatically copy the Core Rules'file (after a user prompt) to
make it easier to update. DO NOT copy the file if you have modified RULES.TXT – your changes
will be lost! (DM Genie does do a backup).
RULES.TXT holds comments to help you edit the rules to suit your needs. See that file for
more information on specific game rules. Here are a few examples of the things you can change:
-

Specify what dice to roll when making attacks, ability checks etc. In theory, you could
design a d30 system for example (although this would probably require modifying all the
other rules in the game...)
Change the names and modifiers of the abilities.
Change the way attack/damage bonuses are calculated.
Decide what types of AC bonuses stack or are lost when flat-footed or in touch attacks.
Customize time/movement data and calculations.
Decide how a creature dies and stabilizes.
Decide how the conditions’ modifiers are added.
Change the way creatures are sorted by play order, and the way delaying/readying affects
play order.
You can now create your own custom action buttons. You can thus automate any common
rolls you make.
Change the default level progression.
Change prices of magical/MW weapons and armor.

You may edit this file, but to avoid errors:
- Do not add or remove any line.
- Do not change the order of the entries.
- Make sure that you enter the correct number for multiple entries.
Many, many additional rules are to be found in the VBScript code that provides
functionality to feats, templates, and more. See Scripting for full details.
Errors in RULES.TXT might not be caught during start-up and could show up only during use (as
strange or invalid results). DM Genie must be restarted for changes to have an effect.
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Steps for Running a Battle
A great way to learn to use DM Genie is with the in-program Tutorials. You can also follow these
steps.
-

First, create the PCs and enter their data into DM Genie. This is described in New
Creature Screen and the Classes Frame. Put the PCs in the “PC’s Party” group.

If you haven’t created the monsters ahead of time
- Optionally, create a group that will hold the enemies for this battle, for example
“Goblins in Tower”. If it is a quick battle, like a random encounter, you can add enemies
directly to the “Current Encounter” group. See Group Manager.
- Create a set of monsters or enemies. This is described in the New Creature Screen.
Prepare the combat
- You must put both the PCs and the monsters in the same group. The easiest way to do
this is to select the group of monsters, and click “Prepare Combat”. This will put all
the PCs and all the monsters of that group into the “Current Encounter” group. (Note:
You can run a battle from any group, for example by putting the PCs in the same group
as the monsters, but it is best to use only “Current Encounter” because this keeps PCs
and monsters separated except during battle). The Prepare Combat button also rolls
initiative for all combatants.
- Another way to prepare the combat would be to use the Group Manager to move the PCs
and the monsters they will be fighting into the Current Encounter group
Start the combat
- You can use the Roll Window to roll or enter initiative values. Select “Initiative” in the
Roll List. Click “Make Roll” to open the Roll Window.
- If the PCs have rolled their own initiative, then select the checkboxes to display only the
friends. Click on “Manually” to open the manual entry window. For each PC, call out
their name, type in the roll or total initiative that the player gives you, and press enter.
- Click Done to apply the initiative.
- Click “Start Combat” to start the combat. This sets all rounds to 1. You can also set
friends or enemies as "surprised", which will have them start only in round 2. Also, you
can specify whether friends and/or enemies start out flat-footed (normally all combatants
are flat-footed at the beginning of combat).
Each creature’s turn
- If the creature is a PC, ask the player what his or her character does. You can use the
references in the Skills Frame, the Spells Frame, the Psionics Frame or the Feats Frame
to decide what DC to apply to a skill or what the effect of a spell or power will be. You
can enter damage to a creature hit by right clicking on the target in the Creature List and
entering the appropriate amount. You can apply conditions resulting from the PC’s
action with the Condition Setter
- If the creature is a monster or NPC, you can use the various frames described above to
select an appropriate action. If you make an attack, the Combat Log reports what AC is
hit. You can then inform the player who was attacked whether or not his character was
hit. The player will adjust his hit points on his character sheet appropriately, and you
may adjust them in the program as well, if you wish to keep track of the players’
statistics as well.
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Going to the next creature
- The “Done with ‘...’” button signals the end of the round for the currently selected
character. You can click the button or press Ctrl+D. The character'
s round is increased
by one, putting it at the end of the play order (except when delaying).
- Under most circumstances you should only click Done With for the character whose
turn it is to act. Click Whose turn is it? to select the character who should be acting
right now.
- If you click Done With for a character who should not act yet, his round will increase by
one. When his turn comes up later in the current round, he will simply be skipped.
- The expiration of conditions is checked before each creature acts. Expiration is reported
in the combat log if that option is set in the Options Dialog.
On each new round
- A creature that is dying will automatically lose a hit point, unless it stabilizes (10%
chance)
- Creatures in the current group are saved. See Automatic File Saving.
Delaying and Readying
- To have a character start a delay or ready, select the Actions Frame and click Delay or
Ready.
- When a character is delaying or readying, he is placed apart in the order of play, but
when the Creature List is sorted by play order, they are placed immediately after the
character whose turn it is to act, to keep them visible.
- Delaying characters don'
t come up automatically until the very end of the round. If the
characters are still delaying, the Done With button becomes the Continue Delay – click
it and they will continue delaying into the next round.
- Readying characters will automatically continue readying into the beginning of the
next round. Do not ready all the characters!
- To ensure proper functioning, you should only begin a ready when it is the PC'
s turn to
act.
Ending a Delay/Ready
- When a player declares "I'
m ending my delay/ready!", use the End Delay or the End
Ready buttons to stop his delay or ready.
- The character is moved to the correct spot in the initiative order.
- For Delayers: the new position is immediately after the last character who finished his
action (for whom you clicked done with)
- For Readiers: the new position is immediately before the creature whose turn it is to act
right now. The new '
creature whose turn it is to act'becomes the PC who just ended the
ready.
- The character'
s init is also changed to match the initiative of the creature who triggered
the delay/ready. A line in the combat log gives you the PC'
s new initiative and indicated
before/after which character they now are placed.
- PCs who have readied for one round will have their ready end automatically, and their
initiative goes back to their previous value. If you start a ready for a PC before that PCs
turn, then the ready will end prematurely (when the encounter'
s initiative reaches the
readying PC'
s initiative).
- Note: avoid starting a delay and then ending it immediately (before anyone else acts) as
that can sometimes increase a character'
s initiative. The play order will still be correct
though.
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Adding New Combatants and Init
- If you create a new monster and add it to Current Encounter, it will automatically start
playing the next round. For example, if you are in round 5 and an Orc comes in (is
created), he will act on his initiative (which is rolled automatically) on round 6.
- Moving creatures into Current Encounter works similarly, except that the group manager
has a textbox where you can specify which round the new combatants enter.
Ending the Combat
- When the combat is finished you can award XP to the PCs. Use the Battle->Encounter
Difficulty/XP menu or press Ctrl+F3.
- Afterwards, you can use the Battle->End Combat menu to clean up. You can select to
clear all conditions for everyone, reset their hit points to full, and remove or permanently
delete all the enemies in Current Encounter.
- You can also use the Rest All menus to restore HP through natural healing, and restore
memorized spells, etc.
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Why Doesn’t DM Genie have data from book X?
DM Genie uses game data covered by the Open Gaming License v.1.0a. The Open Gaming
License allows publishers to legally reproduce specific parts of the core rulebooks, called Open
Game Content. Not everything in the core rulebooks is Open Game Content, however – in most
circumstances, only the text describing the game statistics is open game content. Descriptions,
examples, art, names of sample characters, and others, are usually not. Here is a list of some of the
text you may have noticed is not in DM Genie. All these items are NOT open game content, hence
they were not included.
-

Races’ full descriptions
Pictures of monsters
Psionic Powers’ full description

In addition, many other books by Wizards of the Coast contain NO open game content at all,
for example, the Wheel of Time sourcebook, Star Wars d20, Sword and Fist and the other classspecific handbooks. It is illegal to reproduce text from these publications (like feats for example)
without Wizards of the Coast’s permission.
Note about missing monsters: Some monsters (beholder, gauth, carrion crawler, tanar’ri,
baatezu, displacer beast, githyanki, githzerai, mind flayer, illithid, umber hulk, yuan-ti) are not
included in the DM Genie release because they have not been released by Wizards of the Coast as
Open Game Content. Thus, they cannot be legally redistributed. You can however enter these
monsters'data in the Race Editor for your personal use. Thank you.
Entering your own data: There are many places in DM Genie where you can add to the
core campaign. There is the Customize menu in the main window, as well as the Custom Data
Editor. Also see Bulk Data Entry for a powerful feature allowing the automatic entry of large
amounts of data.
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Can DM Genie work with Game System X?
If the game system you are trying to use is based on 20-sided die, the answer is probably
yes. The more your gaming system shares with the core rules, the easier it will be to adapt. For
example, if the system consists of different races, classes, skills and feats, you can simply enter the
new data and use DM Genie as is.
If your gaming system has additional properties, a different way of leveling, etc. you can
apply the changes manually when possible (for example in the PC Leveling Wizard). You can also
use Scripting in feats and classes to extend the possibilities of DM Genie.
If your system is not compatible with the 20-sided die system, DM Genie is probably not
compatible with it. Depending on how many differences there are between the gaming systems, you
may be able to use most, some, or none of the capability of DM Genie.
DM Genie will not be extended in future versions to handle systems far removed from the
20-sided die system. The first reason is legal: that most gaming systems are copyrighted and NOT
licensed for use by third parties (i.e. they are not under the Open Game License). The second reason
has to do with the large technical difficulty in changing such a complex program: it is not possible
to have a single program handle completely different gaming systems.
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Maximums in DM Genie
To ensure compatibility between versions, there are maximum numbers of items that can be
added in various parts of the programs. In version 2.09 and 2.13, the maximums have been
increased; but creature files are still backwards-compatible. The maximums listed below apply
independently to each campaign you create.
-

Skills: 1250.
Spells and Powers: 32000 total, or available memory.
Feats and special/class abilities: 32000 in the database; but 1000 known by a specific
creature.
Different conditions: 32000.
Classes for a single character: 20
Levels in one class: 80
Creatures: about 32000.
Groups: about 32000.
Creatures per group: 500.
Standard Items: about 32000.
Races: about 32000 or available memory.
Adventures: about 32000 or available memory.
Sub-adventures for a single parent adventure: 500
Items in one adventure: 250
Hotspots on one map: 150
Entries in a random encounter table: 50
Amount of text in a single box: About 75 kb for most rich text boxes, 500 kb for an
adventure’s description. 75 kb is enough for a few dozen pages of text with formatting,
500 kb is enough for one 400x400 color image. These limits were set because larger
amounts of data could cause DM Genie to respond sluggishly.
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Tips for Performance
DM Genie can become slow to load for large campaigns. Here are a few tips to help
improve overall performance:
•

•
•
•

Clean up creatures that will no longer be required – like those from random encounters for
example. The Group Manager'
s "Edit Group>Delete ungrouped creatures" menu can do this
automatically.
If you have completed an adventure module, consider exporting it (as a backup) and deleting it
from your campaign.
Disable the '
Auto-generate Psionic Items'option (File->Options menu) if you are running a nonpsionic campaign.
Remove unneeded campaign data – use the Custom Data Editor to easily filter by source.
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Word Processor Commands
Most of the boxes of text in DM Genie use “Rich Text” (like descriptions for skills or spells,
or notes in an adventure). This means that you can format text just like a mini-word processor
similar to Microsoft Word (although with fewer features).
Another way to access these commands is to right click the selected text with the mouse.
You can set the font size, bold, underline, italics, and color from the popup menu. You can also
change the font’s alignment or indentation (which you cannot do with the keyboard), or open the
font editor.
Many rich text boxes also have a Font Bar, which is a small toolbar that pops up when you
are editing the text. From it you can select font name, size, bold, italics, underline and color. You
can hide it or show it again by clicking the arrow.
You can use the Ctrl+C key to copy, Ctrl+X to cut, and Ctrl+V to paste, just like in every
other windows text editor program. When indenting a paragraph for example, use Ctrl+Tab instead
of just Tab.
To change the formatting of some text, select it using the mouse or by holding shift while
moving the cursor with the keyboard or the mouse. Then, press one of these hotkeys to change the
format:
- Ctrl+B: Sets the text to Bold.
- Ctrl+U: Sets the text to Underline.
- Ctrl+I: Sets the text to Italics
- Ctrl+K: Sets the text color to Black.
- Ctrl+R: Sets the text color to Red.
- Ctrl+L: Sets the text color to bLue.
- Ctrl+G: Sets the text color to Green.
- Ctrl+]: Increases the size of the font by 1. Some fonts can only display specific font
sizes (like 8, 10, 12), and so you might need to press more than once to see the change.
- Ctrl+[: Decreases the size of the font by 1. Again, for some fonts you might need to
press more than once to see the change.
- Ctrl+F: Opens the font editor. There, you can set the font style, emphasis, color and
size.
- Ctrl+Tab: Adds a tab to the text (pressing just Tab will cause the cursor to move to the
next text box)
You can also insert small images into the text, by copying them from an image editor
program, (dragging and dropping the file creates just a link). Caution! Image files inserted into text
this way are stored uncompressed, which means that large images will be both slow to load, require
a lot of memory and take up a lot of space when saved to disk. Black and white images use up less
memory than color. For large images, use the Adventure Map frame. See Maximums in DM Genie
for more info.
You can even insert links to any windows file type, such as .MP3 files, by dragging and
dropping. Double-click the icon to open the default program for that file type.
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Tutorials
The tutorials give you step-by-step instructions on how to use DM Genie. They are a great
way to learn it quickly, and are highly recommended for first time users. To start a tutorial, go to the
Help menu in the main window, select “Tutorials” and click on the tutorial of your choice. To move
the tutorial window out of the way, click anywhere on the form except a button or text box, and
drag with the mouse.
A window will move around the screen, pointing at various buttons and text boxes,
explaining their purpose. Click “Next” to go to the next step in the tutorial. Click “Prev” to go
back one step. Click “Restart” to start over at the beginning. Click “More Help” to open the help
file to explain more. The tutorial window will minimize, click on it again in the taskbar to open it
again. Finally, click “Close” to end the tutorial at any time.
Sometimes, the tutorial will ask you to perform an action, such as clicking a button or
entering text. Do the action before clicking Next, or else future steps may not make sense or be
possible to do. At anytime during the tutorial, don’t hesitate to stop and play around with the
buttons in the window, and then return to the tutorial – it’s a great way to learn.

Tutorials Available

To completely learn DM Genie, it is best to do all the tutorials in order. The 2nd and 3rd
tutorials are the most important and will get you running a game in the shortest amount of time.
• Main Window: The information displayed in the main window and how to edit it.
• Adding PCs and Monsters: How to select a race and create a new PC or monster and add it
to the right group. It will also guide you through the PC Leveling Wizard. Finally, it will
show you how to generate creatures from stat blocks.
• Combat: Step-by-step instructions on running a battle: making the list of creatures and PCs,
rolling initiative, going from creature to creature making attacks and actions, and
delaying/readying characters. This is the most useful of the tutorials.
• Managing Groups: How to create and delete groups, and moving creatures around between
them. (Not available in Player Genie)
• Creating and Editing Races: Views the information displayed for a race and how to
change it or create your own races.
• Time and Weather: Keep track of the current time, generate weather based on the
location’s climate, calculate traveling speeds and distances. (Not available in Player Genie)
• Creating Adventures: Use the adventure tree; add descriptions, items and monsters; create
hyperlinks and clickable maps. (Not available in Player Genie)
• Handling Items: Use the Items Editor to create or edit items, associate conditions. Manage
a creature’s inventory, an adventure’s treasure and appraise the items.
• Importing and Exporting: Learn how to share data with your players and other DMs by
exporting anything from a single creature to an entire campaign.
• Customizing your Campaign: Create your own gaming world by entering custom skills,
feats, spells and items into DM Genie.
The entire text of all the tutorials is Open Game Content, and is licensed for public use under the
terms of the Open Gaming License v1.0a.
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Automatic File Saving
To avoid data loss due to an empty laptop battery or Windows crashing, you can set DM
Genie to automatically save all campaign data (all races, creatures, feats, skills, spells, powers,
items, conditions) at a specified interval of time. Go to the Files->Options menu to pick the number
of minutes between saves.
In addition to this automatic saving, DM Genie also saves data when certain conditions are
met:
- Starting each new round of combat: All creatures in the current group are saved.
- Closing the Campaign Manager: All adventures are saved.
- Closing the Race Editor: All races that were viewed and/or edited are saved.
- Closing the Timekeeping window: The event notes are saved.
- Closing the Conditions Editor: All conditions, spells and psionic powers are saved.
- Closing the Items Editor: If any standard item was changed, all standard items are
saved.
- Each time you generate weather: The weather file is saved.
- Closing any window: The window’s position is saved and, when reopened, will stay the
same.
- Quitting DM Genie: All campaign data is saved.
Use the File->Save All Files menu to manually save all the campaign data. The undo
functions from the Main Window and the Race Editor rely on loading the file previously saved to
disk. If you save the data after changing it, either manually or by doing one of the actions listed
above, you may load some of the changes you are trying to undo.
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Keyboard Shortcuts
The following is a list of keyboard shortcuts common to all or most DM Genie windows.
Specific windows may have additional shortcuts.
For all windows, pressing Alt+any underlined character visible will select that item or
press that button. This can be on a menu (like File), on a button or on a label.
Genie:

F2: Main Window
F3: Campaign Manager
F5: New Creature Screen
F6: Group Manager
F7: Race Editor
F8: Condition Setter
F9: Roll Window
F11: Timekeeping Window
F12: Dice Roller
Shift+F4: Standard Weapons Editor
Shift+F5: Items Editor
Shift+F8: Conditions Editor
Shift+F11: Weather Generator
Shift+F12: Appraisals Window
F1: Opens the help appropriate for the selected window or control.
Ctrl+F1: DM Genie Help Contents
Ctrl+S: Searching for Text (Main Window or Searching Adventures for Text

In addition, some keyboard shortcuts are universal to Windows and can help in using DM
-

Alt+F4: Close the current window.
Alt+Tab: Switch between windows.
Windows Key+M: Minimize all windows.
Alt+Space: Open the window’s menu (like when clicking the top left corner of the
window)
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Open Gaming License v1.0a
Designation of Open Game Content
All help topics marked “distributed as Open Game Content” are OGC. All other help topics are
product identity and are Copyright 2002-2003 Mad Scientist Studios.
The following are product identity:
-Form layout
-Interface
-Artwork and icons
-Program code and algorithms
The following are designated as Open Game Content:
-XP table (in XP.txt)
-Game rules (in RULES.TXT)
-Treasure Table (in TREASURE.TXT)
-Weather rules descriptions (in Weather_Desc.TXT)
-Text of tutorials
For all skills, feats, spells, powers, items, weapons, conditions, races, templates:
-Names are OGC
-Descriptions are OGC
-Any associated data is OGC
-Scripting code is OGC
This includes everything in the \Data\ directory except Weather.dat.
The text of the Open Gaming License itself is not Open Game Content. Instructions on using the
License are provided within the License itself. More information on the Open Game License can be
found at www.opengamingfoundation.org.
The terms of the Open Gaming License Version 1.0a are as follows:

Open Gaming License Version 1.0a
The following text is the property of Wizards of the Coast, Inc. and is Copyright 2000 Wizards of
the Coast, Inc ("Wizards"). All Rights Reserved.
1. Definitions: (a)"Contributors" means the copyright and/or trademark owners who have
contributed Open Game Content; (b)"Derivative Material" means copyrighted material including
derivative works and translations (including into other computer languages), potation, modification,
correction, addition, extension, upgrade, improvement, compilation, abridgment or other form in
which an existing work may be recast, transformed or adapted; (c) "Distribute" means to reproduce,
license, rent, lease, sell, broadcast, publicly display, transmit or otherwise distribute; (d)"Open
Game Content" means the game mechanic and includes the methods, procedures, processes and
routines to the extent such content does not embody the Product Identity and is an enhancement
over the prior art and any additional content clearly identified as Open Game Content by the
Contributor, and means any work covered by this License, including translations and derivative
works under copyright law, but specifically excludes Product Identity. (e) "Product Identity" means
product and product line names, logos and identifying marks including trade dress; artifacts;
creatures characters; stories, storylines, plots, thematic elements, dialogue, incidents, language,
artwork, symbols, designs, depictions, likenesses, formats, poses, concepts, themes and graphic,
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photographic and other visual or audio representations; names and descriptions of characters, spells,
enchantments, personalities, teams, personas, likenesses and special abilities; places, locations,
environments, creatures, equipment, magical or supernatural abilities or effects, logos, symbols, or
graphic designs; and any other trademark or registered trademark clearly identified as Product
identity by the owner of the Product Identity, and which specifically excludes the Open Game
Content; (f) "Trademark" means the logos, names, mark, sign, motto, designs that are used by a
Contributor to identify itself or its products or the associated products contributed to the Open
Game License by the Contributor (g) "Use", "Used" or "Using" means to use, Distribute, copy, edit,
format, modify, translate and otherwise create Derivative Material of Open Game Content. (h)
"You" or "Your" means the licensee in terms of this agreement.
2. The License: This License applies to any Open Game Content that contains a notice indicating
that the Open Game Content may only be Used under and in terms of this License. You must affix
such a notice to any Open Game Content that you Use. No terms may be added to or subtracted
from this License except as described by the License itself. No other terms or conditions may be
applied to any Open Game Content distributed using this License.
3.Offer and Acceptance: By Using the Open Game Content You indicate Your acceptance of the
terms of this License.
4. Grant and Consideration: In consideration for agreeing to use this License, the Contributors grant
You a perpetual, worldwide, royalty-free, non-exclusive license with the exact terms of this License
to Use, the Open Game Content.
5.Representation of Authority to Contribute: If You are contributing original material as Open
Game Content, You represent that Your Contributions are Your original creation and/or You have
sufficient rights to grant the rights conveyed by this License.
6.Notice of License Copyright: You must update the COPYRIGHT NOTICE portion of this License
to include the exact text of the COPYRIGHT NOTICE of any Open Game Content You are
copying, modifying or distributing, and You must add the title, the copyright date, and the copyright
holder'
s name to the COPYRIGHT NOTICE of any original Open Game Content you Distribute.
7. Use of Product Identity: You agree not to Use any Product Identity, including as an indication as
to compatibility, except as expressly licensed in another, independent Agreement with the owner of
each element of that Product Identity. You agree not to indicate compatibility or co-adaptability
with any Trademark or Registered Trademark in conjunction with a work containing Open Game
Content except as expressly licensed in another, independent Agreement with the owner of such
Trademark or Registered Trademark. The use of any Product Identity in Open Game Content does
not constitute a challenge to the ownership of that Product Identity. The owner of any Product
Identity used in Open Game Content shall retain all rights, title and interest in and to that Product
Identity.
8. Identification: If you distribute Open Game Content You must clearly indicate which portions of
the work that you are distributing are Open Game Content.
9. Updating the License: Wizards or its designated Agents may publish updated versions of this
License. You may use any authorized version of this License to copy, modify and distribute any
Open Game Content originally distributed under any version of this License.
10. Copy of this License: You MUST include a copy of this License with every copy of the Open
Game Content You Distribute.
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11. Use of Contributor Credits: You may not market or advertise the Open Game Content using the
name of any Contributor unless You have written permission from the Contributor to do so.
12. Inability to Comply: If it is impossible for You to comply with any of the terms of this License
with respect to some or all of the Open Game Content due to statute, judicial order, or governmental
regulation then You may not Use any Open Game Material so affected.
13. Termination: This License will terminate automatically if You fail to comply with all terms
herein and fail to cure such breach within 30 days of becoming aware of the breach. All sublicenses
shall survive the termination of this License.
14. Reformation: If any provision of this License is held to be unenforceable, such provision shall
be reformed only to the extent necessary to make it enforceable.
15. COPYRIGHT NOTICE
Open Game License v 1.0a Copyright 2000,Wizards of the Coast,Inc.
DM Genie – software code, artwork, layout, interface, design, algorithms, Copyright 2002-2003
Mad Scientist Studios; Author Janik Zikovsky.
System Reference Document Copyright 2000,Wizards of the Coast, Inc; Authors Jonathan Tweet,
Monte Cook, Skip Williams, based on original material by E.Gary Gygax and Dave Arneson.
Open Spells Collection Copyright 2002 Mark Alexander Clover. The Open Spells Collection can
be found at www.creativemountaingames.com
END OF LICENSE
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Glossary of Terms
This help topic is Open Game Content, and is licensed for public use under the terms of the Open Gaming License
v1.0a.

•
•
•
•
•
•
•

•

•

•

•
•
•
•
•
•
•
•

Ability check: A check of 1d20 + the appropriate ability modifier vs. a DC.
Ability modifier: The bonus or penalty associated with a particular ability score.
AC: Armor Class.
Alignment: One of the nine descriptors of morality and ethics: lawful good (LG),
neutral good (NG), chaotic good (CG), lawful neutral (LN), neutral (N), chaotic neutral
(CN), lawful evil (LE), neutral evil (NE), and chaotic evil (CE).
Armor Class: A number representing a creature’s ability to avoid being hit in combat.
An opponent’s attack roll must equal or exceed the target creature’s Armor Class to hit
it.
Attack of opportunity: A single extra melee attack per round that a combatant can
make when an opponent within reach takes an action that provokes attacks of
opportunity.
Blinded: Unable to see. A blinded character suffers a 50% miss chance in combat, loses
any Dexterity bonus to AC, moves at half speed, and suffers a -4 penalty on Search
checks and on most Strength- and Dexterity-based skill checks. Any skill check that
relies on vision automatically fails. Opponents of a blinded character gain a +2 bonus to
their attack rolls, since they are effectively invisible.
Charisma (Cha): an ability. Charisma measures a character’s force of personality,
persuasiveness, personal magnetism, ability to lead, and physical attractiveness. It
represents actual personal strength, not merely how one is perceived by others in a social
setting.
Chaotic evil: A chaotic evil character does whatever his greed, hatred, and lust for
destruction drive him to do. He is hot-tempered, vicious, arbitrarily violent, and
unpredictable. Chaotic evil is the most dangerous alignment because it represents the
destruction not only of beauty and life but of the order on which beauty and life depend.
Chaotic good: A chaotic good character acts as his conscience directs him with little
regard for what others expect of him. He makes his own way, but he’s kind and
benevolent. Chaotic good is the best alignment you can be because it combines a good
heart with a free spirit.
Chaotic neutral: A chaotic neutral character follows his whims. He is an individualist
first and last. Chaotic neutral is the best alignment you can be because it represents true
freedom both from society’s restrictions and from a do-gooder’s zeal.
Constitution (Con): An ability. Constitution represents a character’s health and
stamina.
Dazed: Unable to act normally. A dazed character can take no actions, but can defend
against attacks normally.
Dazzled: Unable to see well because of over stimulation of the eyes. A dazzled creature
suffers a –1 penalty on attack rolls until the effect ends.
DC: Difficulty Class.
Deafened: Unable to hear. A deafened character suffers a –4 penalty to initiative,
automatically fails Listen checks, and has a 20% chance of spell failure when casting
spells with verbal components.
Dexterity (Dex): An ability. Dexterity measures hand-eye coordination, agility,
reflexes, and balance.
Difficulty Class (DC): The target number that a player must meet or beat for a check or
saving throw to succeed.
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Entangled: Entanglement impedes movement, but does not entirely prevent it unless the
bonds are anchored to an immobile object or tethered by an opposing force. An
entangled creature moves at half speed, cannot run or charge, and suffers a –2 penalty to
attack rolls and a –4 penalty to its effective Dexterity score.
Exhausted: Tired to the point of significant impairment. A fatigued character becomes
exhausted by doing something else that would normally cause fatigue. An exhausted
character moves at half normal speed and suffers an effective ability decrease of –6 to
both Strength and Dexterity. After 1 hour of complete rest, an exhausted character
becomes fatigued.
Extraordinary ability (Ex): A nonmagical special ability (as opposed to a spell-like or
supernatural ability).
Fatigued: Tired to the point of impairment. A fatigued character can neither run nor
charge and suffers an effective ability decrease of –2 to both Strength and Dexterity.
After 8 hours of complete rest, fatigued characters are back to normal.
Feat: A quality or special ability of a character.
Flat-footed: Especially vulnerable to attacks at the beginning of a battle. Characters are
flat-footed until their first turns in the initiative cycle. Flat-footed creatures cannot use
their Dexterity bonuses to AC or make attacks of opportunity.
Fortitude save: A type of saving throw, related to a character’s ability to withstand
damage thanks to his physical stamina.
Frightened: Fearful of a creature, situation, or object. Frightened creatures flee from the
source of their fear as best they can. If unable to flee, they may fight, but suffer a –2
morale penalty to all their attack rolls, weapon damage rolls, and saving throws.
Hit points (hp): A measure of character health or object integrity. Damage decreases
current hit points, and lost hit points return with healing or natural recovery. A
character’s hit point total increases permanently with additional experience and/or
permanent increases in Constitution, or temporarily through the use of various special
abilities, spells, magic items, or magical effects (see temporary hit points and effective
hit point increase).
Hp: Hit points.
Incorporeal: Having no physical body. Incorporeal creatures are immune to all
nonmagical attack forms. They can be harmed only by other incorporeal creatures, +1 or
better magical weapons, spells, spell-like effects, or supernatural effects. Even when
struck by spells, magical effects, or magic weapons, however, they have a 50% chance
to ignore any damage from a corporeal source. In addition, rogues cannot employ sneak
attacks against incorporeal beings, since such opponents have no vital areas to target. An
incorporeal creature has no natural armor bonus, but does have a deflection bonus equal
to its Charisma modifier or +1, whichever is greater. Such creatures can pass through
solid objects at will, but not through force effects. Therefore, their attacks negate the
bonuses provided by natural armor, armor, and shields, but deflection bonuses and force
effects (such as mage armor) work normally against them. Incorporeal creatures move
silently, so they cannot be heard with Listen checks unless they wish it.
Intelligence (Int): An ability. Intelligence determines how well a character learns and
reasons.
Lawful evil: A lawful evil villain methodically takes what he wants within the limits of
his code of conduct without regard to whom it hurts. Lawful evil is the most dangerous
alignment because it represents methodical, intentional, and frequently successful evil.
Lawful good: A lawful good character acts as a good person is expected or required to
act. Lawful good is the best alignment you can be because it combines honor and
compassion.
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Lawful neutral: A lawful neutral character acts as law, tradition, or a personal code
directs her. Order and organization are paramount to her. Lawful neutral is the best
alignment you can be because it means you are reliable and honorable without being a
zealot.
Masterwork: Exceptionally well-made, generally adding +1 to attack rolls (if the item is
a weapon), reducing the armor check penalty by 1 (if the item is armor), or adding +2 to
relevant skill checks (if the item is a tool). A masterwork weapon’s bonus to attack rolls
does not stack with enhancement bonuses.
Melee attack roll: 1d20 + base attack bonus + Strength modifier + size modifier. The
attack hits if the result is at least as high as the target’s Armor Class.
Nauseated: Experiencing stomach distress. Nauseated creatures are unable to attack,
cast spells, concentrate on spells, or do anything else requiring attention. The only action
such a character can take is a single move (or move-equivalent action) per turn.
True neutral: A "true" neutral character does what seems to be a good idea. She doesn’t
feel strongly one way or the other when it comes to good vs. evil or law vs. chaos. Most
neutrality is a lack of conviction or bias rather than a commitment to neutrality. Some
neutral characters, on the other hand, commit themselves philosophically to neutrality.
They see good, evil, law, and chaos as prejudices and dangerous extremes. They
advocate the middle way of neutrality as the best, most balanced road in the long run.
Neutral is the best alignment you can be because it means you act naturally, without
prejudice or compulsion.
Neutral evil: A neutral evil villain does whatever she can get away with. Neutral evil is
the most dangerous alignment because it represents pure evil without honor and without
variation.
Neutral good: A neutral good character does the best that a good person can do. Neutral
good is the best alignment you can be because it means doing what is good without bias
toward or against order.
Nonintelligent: Lacking an Intelligence score. Mind-affecting spells do not affect
nonintelligent creatures.
Panicked: A panicked creature must drop anything it holds and flee at top speed from
the source of its fear, as well as any other dangers it encounters, along a random path. In
addition, the creature suffers a –2 morale penalty on saving throws. If cornered, a
panicked creature cowers and does not attack, typically using the total defense action in
combat.
Paralyzed: Unable to move or act physically. Paralyzed characters have effective
Dexterity and Strength scores of 0 and are helpless.
Petrified: Turned to stone. Petrified characters cannot move or take actions of any kind,
and they have effective Strength and Dexterity scores of 0. They are completely unaware
of what occurs around them, since all of their senses have ceased to operate. If a
petrified character cracks or breaks, but the broken pieces are joined with the body as it
returns to flesh, the character is unharmed. Otherwise, the DM must assign some amount
of permanent hit point loss and/or debilitation.
Prone: Lying on the ground. An attacker who is prone has a –4 penalty to melee attack
rolls and cannot use a ranged weapon (except for a crossbow). Melee attacks against a
prone defender have a +4 bonus, and ranged attacks against a prone character have a –4
penalty.
Ranged attack roll: 1d20 + base attack bonus + Dexterity modifier + size modifier +
range penalty. The attack hits if the result is at least as high as the target’s Armor Class.
Reflex save: A type of saving throw, related to a character’s ability to withstand damage
thanks to his agility or quick reactions.
Saving throw (save): A roll made to avoid (at least partially) damage or harm.
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Skill: an ability or area of knowledge or expertise that can be improved over time.
Spell-like ability (Sp): A special ability with effects that resemble those of a spell. In
most cases, a spell-like ability works just like the spell of the same name.
Staggered: Having nonlethal damage equal to current hit points. Staggered characters
can only take partial actions. Characters are no longer staggered once their current hit
points exceed their nonlethal damage.
Strength (Str): Strength measures a character’s muscle and physical power.
Stunned: A stunned creature can’t take actions and loses any positive Dexterity modifier
to AC. Each attacker gains a +2 bonus to attack rolls against that creature. In addition,
stunned characters immediately drop anything they are holding.
Nonlethal damage: Non lethal damage typically resulting from an unarmed attack, an
armed attack delivered with intent to subdue, a forced march, or a debilitating condition
such as heat or starvation.
Supernatural ability (Su): A magical power that produces a particular effect, as
opposed to a natural, extraordinary, or spell-like ability. Using a supernatural ability
generally does not provoke an attack of opportunity. Supernatural abilities are not
subject to dispelling, disruption, or spell resistance. However, they do not function in
areas where magic is suppressed or negated, such as inside an antimagic field.
Take 10: To reduce the chances of failure on certain skill checks by assuming an
average die roll result (10 on a 1d20 roll).
Take 20: To greatly reduce the chances of failure for certain skill checks by assuming
that a character makes sufficient retries to obtain the maximum possible check result (as
if a 20 were rolled on 1d20).
Will save: A type of saving throw, related to a character’s ability to withstand damage
thanks to his mental toughness.
Wisdom (Wis): An ability. Wisdom describes a character’s willpower, common sense,
perception, and intuition. While Intelligence represents one’s ability to analyze
information, Wisdom is more related to being in tune with and aware of one’s
surroundings.
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Options Dialog
The options dialog allows you to change the way information is displayed in DM Genie, and
set special game rules. You can access it from the File->Options menu of the Main Window.

Appearance/Reporting
-

-

-

Show Roll+Bonus: When making a roll (attack, skill check or other), reports the value
rolled on the dice and the bonus, as in (18+4) = 22.
Condition Activated: Adds a line in the Combat Log when a condition is added from
the Conditions Frame.
Condition Expires: Adds a line in the combat log when a condition automatically
expires.
Damage Entered: Reports damage entered through the damage form (opened by rightclicking on a creature from the list).
Creature Stabilizes: DM Genie can automatically roll the stabilization for dying
character – this reports successful rolls.
Creature Dies: Reports the death only when DM Genie automatically reduced the dying
creature’s hp by 1 at the end of a round.
Detailed bonuses when attacking: The source of each attack and damage bonus is
reported for each attack. This can be quite long, so its not recommended keeping this
active always. Double-click the “Attack” label from the Attacks Frame to give the same
information.
Description boxes grow: Skills, spells and psionic powers’ description boxes can grow
automatically to fill up more of the screen whenever they receive the focus (the cursor is
clicked on it with the mouse or tabbed with the keyboard). This is useful for low
resolutions.
Show tips at startup: Check this to show the tips again at the next startup.
Font Size: This affects for the combat log, the stat block and a few other text boxes.
Does not affect spell descriptions, etc.
Hide Item Conditions: Active item conditions are not shown except in the condition
setter. This reduces the amount of text in the Notes column of the creature list for
creatures with many magical items.
Auto-Generate Psionic Items: Generate psionic dorjes, tattoos and power stones from
the list of psionic powers when DM Genie starts.
Hide Unidentified Magical Items: Useful when printing out character sheet for your
PCs without them knowing what their unknown magical items are. Replaces the name of
each unidentified item with the first word followed by '
...'
Auto-Save: Sets the time between auto-saves. See Automatic File Saving.

Colors
Select the type of entry you wish to change color. The window at right is a sample of the
color. To set the foreground (text) color, click “Foreground color”. To set the background color,
click “Background color”

Special Game Rules
Only one item is present in this window for this version of DM Genie. Please contribute
your ideas for other game rules you would like to see at feedback@dmgenie.com
-

Default HP for new creature: Roll Hit Dice: If unchecked, use the standard number of
HP as a default for new creatures.

36

37

Main Window
The main window is where most of the action happens in DM Genie. On the right is the list
of creatures in the current encounter (see Creature List). Above it are buttons to step through a
battle. Below it is the Combat Log, the transcript of the current battle. On the right you’ll find
information about the creature and its’ attacks. The menus and shortcut keys allow you to get
around DM Genie quickly and easily.
To get more help about a specific subject, click below:
•
•
•
•
•

•

•

Main Window Menus
Creature List
o Creature List Display Options
o Creature List Popup Menu
Combat Log
Quick-Info Frame
Creature Tab Strip
o Combat Statistics Frame
o Conditions Frame
o Skills Frame
o Feats Frame
o Spells Frame
Learning a Spell
Casting a Spell
Memorizing/Preparing Spells
Spells Pop-up Menu
o Psionics Frame
o Notes Frame
o Desc Frame
o Items Frame
Items Pop-up Menu
Actions Tab Strip
o Attacks Frame
o Actions Frame
o Class Abilities Frame
o Classes Frame
o Stat Block Frame
Searching for Text (Main Window
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Main Window Menus
(Go back to Main Window)

File Menu
-

Options: Open the Options Dialog
Show Toolbar: Show or hide the toolbar.
Search: Open the Searching for Text (Main Window dialog.
Save All Files: Saves all the data for this campaign – all races, creatures, feats, skills,
spells, powers, items, weapons and conditions.
Export: See the Exporting a Creature, Exporting a Group and Exporting Other Files
topics.
Import: See the Importing a Creature, Importing a Group and Importing Other Files
topics.
Quit: Quits the program normally, and saves all changes made.
Quit Without Saving: Quits but doesn'
t save anything recently changed. Can be useful
if you accidentally messed up your data and don'
t want to save that. Note that closing
windows usually saves related information, and the auto-save feature saves everything.

Battle Menu
Many of the menu items perform the same way as the buttons in the main window. See
Steps for Running a Battle to learn more.
- Remove All: You can remove all creatures, or only the enemies, from the current group.
This does not delete them permanently.
- Encounter Difficulty/XP opens a window telling you the encounter level for this battle
and the amount of XP to give.
- Rest All: Rests ALL characters in the current group for 8 or 24 hours. This resets spell
slots, power points, talents, and calculates natural healing of regular damage and of
nonlethal damage. Also, some feats have a rest script, resetting the # of uses per day of
certain abilities for example. This will also increase the current time by 8 or 24 hours.

Current Character
This is nearly the same menu as seen when right-clicking the Creature List, except it only
applies to the currently selected creature.
- Attack with...: same as the buttons in the Attacks Frame
- Clear All Conditions: unsets all the conditions for the creature.
- Copy Current: Create another creature with exactly the same name and stats.
- Remove Current: Removes the creature from the group but keep it on disk and in the
All Creatures group. This can be undone using the Group Manager.
- Delete Current: Delete the creature from the disk and from all groups. This cannot be
undone.
- Undo Changes: Load the creature as was last saved to disk. See Automatic File Saving
to learn when a creature is saved. This cannot be undone.
- Resting: Rests the current character for 8 or 24 hours. This resets spell slots, power
points, talents, and calculates natural healing of regular damage and of nonlethal
damage. Also, some feats have a rest script, resetting the # of uses per day of certain
abilities for example.
- Detailed Information: Pops up text boxes detailing DM Genie'
s calculations of:
o AC and Touch AC bonuses.
o The current attack'
s Attack (and damage) Bonuses
o A Conditions Summary
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-

o Hit Dice Details: this allows you to edit each hit die a PC has gained (from race,
levels, templates, etc.). See Hit Dice Detail for more information.
Add A Level: Adds a class or creature advancement level, just like the button in the
Classes Frame.
Make Character Sheet: Opens the Character Sheet Output dialog to create a HTML
character sheet for you.

Customize
From this menu you can customize your campaign by manually creating or editing skills,
feats, spells, psionic powers and armor/shield. Another way to add these items to a campaign is by
Importing Other Files from the File->Import menu. After you have created custom items, you can
export them – see Exporting Other Files. If the menu is disabled, select a creature to enable it
(viewing and editing these items are both done when viewing a creature).
-

-

-

-

New [skill/feat/spell/power]: Creates a new item. Asks you the name of the item and if
necessary, additional information. Afterwards, you can edit the description from the
main window. For this version of DM Genie, the information entered during creation
(except the name) cannot be changed. You will need to create a new item, enter the
correct information, copy the description, and delete the old item.
Rename [skill/feat/spell/power]: Change the name of the select item. It is
recommended not to change the names of the items that come with DM Genie (those
from the core rules) because they should be universal. The New Creature: Import Stat
Block function and some of the automated skill, feat and spell settings when creating a
monster rely on the names of the skills to be exact. Creatures who already have the item
will have the new renamed item as well, without any intervention on your part.
Delete [skill/feat/spell/power]: Permanently delete the selected item. Note that if you
delete a feat (for example) that some creatures had in their feat list, and then create a
new feat, some creatures may have that new feat immediately –you’ll have to remove it
from their list manually. Newly created creatures will not however have the new feat by
default (except if it is in the race’s list of feats). This is because DM Genie saves the list
of feats as an array, but when a feat is deleted and then replaced by another, the new feat
takes the old feat’s place in the array. For this reason, it is best not to delete a feat before
any creature has it.
Delete All [skill/feat/spell/power]: Deletes every item in this campaign. You cannot use
this option from the core rules campaign (See Creating a Campaign to learn how to
create a custom campaign). This is useful when you are making a new campaign from
scratch, or if for example your campaign has no psionics in it (Delete all Powers).

Spells
This menu is the same as the Spells Pop-up Menu.

Windows
Select what window to open. All windows in DM Genie have this menu. You can also open
the windows anywhere using the Keyboard Shortcuts, also displayed in the Windows menu.

Help
From the help menu you can open this file at the DM Genie Help Contents; run one of the
Tutorials; view the About box, which holds the text of the Open Gaming License; open the DM
Genie website at http://www.dmgenie.com/; or open the form for Registering DM Genie.
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Creature List
(Go back to Main Window) This help topic is Open Game Content, and is licensed for public use under the terms
of the Open Gaming License v1.0a.

This is the list of all creatures (PCs, NPCs, or monsters) in the current encounter, along with
some of their stats. You can also edit a stat by clicking on it (ACM, ACR and Notes cannot be
edited). Right click a creature for more options (it opens the Creature List Popup Menu, or use the
Main Window Menus) The most useful information for each creature is displayed in the following
columns:
En.: An ‘X’ in this box indicates that the creature is an enemy (fighting the PCs). A blank box
means the creature is a friend (on the same side as the PCs).
HP: The current number of hit points for this creature.
AC: The character'
s current AC, modified for conditions.
In some cases you will see two values here, for example, 15/19. These are the effective AC
versus Melee attacks and the effective AC versus Ranged attacks, respectively. This is equal to the
creature’s current AC (taking into account losing its Dexterity bonus, and spells) to which is
subtracted an attacker’s bonus to attack. This modification comes from conditions. For example,
according to the official rules, someone attacking a prone character gets +4 to his attack roll when
in Melee. In DM Genie, the attack rolls are made without a need to specify the target first. Hence,
the effective AC versus Melee allows you to know whether an attacker has hit the prone creature,
without having to specify the target on every attack. This makes it much easier to track attack
bonuses, because they are always the same no matter who the target is. For example:
John is prone (attackers get +4 melee, -4 ranged). His regular AC is 15. His AC versus Melee
attacks is 15-4 = 11, and his AC versus ranged weapons is 15+4 = 19.
William is not under any conditions. His AC is 15, so his ACM is 15 and his ACR is 15 also.
Robert makes an attack with a Longbow and gets a 17. If he was trying to hit John, he missed,
because John’s AC versus ranged weapons is 19. If he were trying to hit William, then he would hit.
This system simplifies attack rolls, and also means that a creature’s statistics are a constant – that is,
they do not change depending on the creature attacked. This makes combat simpler, since only a
creature’s own conditions will affect its statistics
Note: These stats are not a part of the regular third edition rules, but are provided here for
convenience in making attack rolls.
Init: Abbreviation for Initiative. This is the creature’s total initiative roll.
Rd: Abbreviation for Round. This is the round in which the creature will act next. At the
beginning of combat, all creatures are on round 1. When the first creature acts, its round is
incremented to 2. The next time that creature will act is when all other creatures have acted in round
1.
Notes: This displays the list of conditions or conditions from spells currently affecting this creature.
Display Options
The options for displaying the creatures are described in Creature List Display Options. The
width of the columns is adjustable using the mouse on the grid lines between the headers.
Display Colors
The colors for the text and background of each creature, depending on status, are set using
the Options Dialog (File menu -> Options -> Colors tab).
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Displaying Two Lines
You can display each creature as two lines in the creature list by using the Options Dialog
(File menu -> Options). This is useful if you have a small screen resolution and want to shrink the
creature list without losing information.
Tooltips
As you move the mouse over a creature in the creature list you will see a balloon pop up that
gives you some vital stats for that creature. If you do not want to see the tooltips you can remove
them from the Options Dialog.
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Creature List Display Options
(Go back to Creature List) This help topic is Open Game Content, and is licensed for public use under the terms of
the Open Gaming License v1.0a.

“Group” list box
(Feature not available in Player Genie) Selects what is the current group or encounter in
which we are playing. The first three groups are special: All Creatures displays every creature in
every group. Current Encounter is a placeholder to run combat. This is the item that will be selected
during most, if not all combats. PC’s Party holds the player’s characters and their allies. The other
entries in the list are the groups in this campaign. Select these to edit the creatures in them.

Sorting
To sort either click on the Name or Init columns or right-click the creature list and select the
sort menu.
Sort by Play Order
The creatures are sorted in the order in which they will act, with the next creature that will
act at the top of the list. The order is determined thusly: first, those creatures that have already acted
this round are at the end of the list. Then, the creatures that have yet to act are sorted by initiative. If
two creatures have the same initiative, the one with higher Dexterity goes first. If both have the
same Dexterity, the order of the two is decided randomly.

Displaying Enemies/Friends
Right-click a creature in the list and check or uncheck the '
Show Enemies'or '
Show Friends'
check boxes to show/hide creatures of that type.

Display Colors
The colors for the text and background of each creature, depending on status, are set using
the options (File menu -> Options -> Colors tab).
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Creature List Popup Menu
Right-Click on a creature on the list to pop up this menu. The commands apply to the
clicked creature only.
-

-

'Name'Current: Make that creature the current creature. Same as left-clicking.
Auto-Damage: Applies the damage dealt from the last time you clicked an attack button
– if the AC of the target is low enough. For example, an orc makes an attack that says
that it hits AC 20 for 3 hp of damage. If you use Auto-Damage on Markus who has AC
19, he will lose 3 hp. But if you do it on Bilbo who has AC 23, he will not be harmed.
Enter Damage or Healing: Opens a window where you can enter the amount of hp to
add/remove to a PC. Click "Apply Damage" to remove, and "Apply Healing" to add hit
points.
Stabilize: Stops the hp loss that a dying character suffers.
Clear All Conditions: (except permanent magical item effects).
Remove from group: Removes the creature but it isn'
t deleted (it remains in '
All
Creatures'
)
Delete Creature: Permanent deletion from all groups.
Copy: Makes an identical copy of the creature in the same group.
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Buttons Above the Combat Log
(Feature not available in Player Genie)

Make Roll
Select the type of roll to make in the listbox to the right of this button. Click “Make Roll” to
open the Roll Window with the selected type of roll. You can also press F9 to open the roll window.

Quick Combat
This button helps you quickly start a combat between monsters and your PCs.
First, select a group of monsters in the drop-down box next to “Group” (see Creature List
Display Options).
Then, click this button. Whoever was in the “Current Encounter” group will be removed
(but not permanently deleted – they are still in other groups they were a part of, and also in “All
Creatures”). All the creatures in the current group, plus all the PCs (in “PC’s Party”) will be added
to the Current Encounter. Initiative is also rolled for all creatures.
After that, you may want to manually set the init for your players, or make any changes to
the creature list. Then, you can press the “Start Combat” button to set everyone’s round to 1, and
set them flat-footed or not. See Steps for Running a Battle for more details.
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Combat Log
(Go back to Main Window) This help topic is Open Game Content, and is licensed for public use under the terms
of the Open Gaming License v1.0a.

The combat log holds the text of every event that has happened during this encounter. Each
time a creature does something (for example if you double-click a skill to make a skill roll) the
result is displayed in the combat log. You can also edit this text manually using Word Processor
Commands.
By default the combat log is saved automatically to a file
(c:\YourCampaign\Log\LastLog.rtf) when closing DM Genie. Go to the Options Dialog (File>Options menu) to also load the last log automatically at startup; and you can also choose to save a
copy of the log with the current date as the name (for example 031023.rtf is saved on October 23rd).
That way you can keep a running diary of what happened on previous game sessions. Outside of
DM Genie you can edit the log files using Wordpad or Microsoft Word.

When the turn of a creature starts
After a delimiter line, the creatures’ name is written in bold, and the conditions or spells that
the creature is under are written afterwards. In parentheses is written the number of rounds left for
that condition or spell. If the condition has no expiration set, then nothing is written in parentheses.
Long expiration times are written in hours, minutes and rounds. For example:
-----------------------Aragorn: Bless (3), Haste (2), Sitting/Kneeling, Barkskin (3h56m2)

When a creature makes an attack
The format of an attack report is thus:
Name of creature (Weapon) hits (Rolled+Bonus) AC 10, for 6 HP of [nonlethal] damage.

(Rolled+Bonus): This reports what the creature actually rolled on the d20, as rolled by the
computer. This is shown if it is set in the Options Dialog (File menu -> Options).
For example, Bilbo has an attack bonus of +4 for a short sword. He rolls a 19 on the d20, giving
him a total roll of 19+4 = 23. He can hit any creature with an AC of 23 or less. He rolls damage
(1d6+1) and gets a total of 4. Since he rolled 19 and a short sword is a critical threat on 19-20/x2, he
rolls a second attack roll (for a total of 12), and the additional damage if the critical is successful (if
the opponent has AC 12 or less). He rolls a 6 for additional damage, giving him 10 HP of total
damage on a successful critical. This is what is reported in the combat log:
Bilbo (Short Sword) hits (19+4) AC 23 for 4 HP of damage
----> Critical threat to (8+4) AC 12, total damage 10 HP

If Bilbo had rolled a natural 20 or a natural 1, that is indicated. The total attack roll is still displayed.
He still makes a critical threat, and makes an attack and damage roll for that. This is what would be
reported:
Bilbo (Short Sword) Natural 20 (20+4) (AC 24) for 2 HP of damage
----> Critical threat to (12+4) AC 16, total damage 7 HP
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You can then use the enter damage function or the auto-damage function to apply the damage to
another creature in the list (both are available in the Creature List Popup Menu). See the Attacks
Frame for more information on attacks.

When a creature uses a skill
The combat log reports the name of the creature, the name of the skill, the value rolled on
the d20, the bonus to the roll, and the total roll. For example:
Bilbo uses skill Concentration. Rolls 5+3 = 8

When a creature makes an ability check
You can make an ability check by double-clicking the ability’s label (Str, Dex, etc.). The
combat log reports the name of the creature, the ability and the total roll. In parentheses is written,
in this order: the value of the roll, the bonus from the ability, and the sum of ability bonuses from
spells or conditions. For example, if Bilbo has 18 of Dexterity, and is under the effect of a Doom
spell (-2 to ability checks), and he rolls 9 on the d20, the combat log reports:
Bilbo makes a Dex check: 11 (9+4-2)

When a condition expires
If a condition affecting a creature has expired (for example, a spell duration is over), then
the combat log can report it if that option is selected (File menu -> Options -> Reporting tab). For
example:
Bilbo is no longer Slowed.

See the Conditions Frame for more information on setting conditions.
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Quick-Info Frame
(Go back to Main Window)
This frame holds information to quickly identify the currently selected creature.

Name
The name of the creature. This can almost anything, from “Bilbo Baggins” to “Goblin 3”.
Try to avoid giving different creatures the same name, even if their stats are identical, because
telling them apart will be difficult.

Race
The race of the creature, like Human, Half-Orc or Goblin. In the case of monsters, this is the
kind of monster. Many times the monster’s name will be the same as his race.

Lvl (Level)
For PCs and NPCs, the level(s) of the character. For example: “Sor 3, Brd 1”. Add classes in
the Classes Frame to change this.
For monsters, enter the number of hit die, and bonuses to HP. For example, an Aboleth has
“8d8+40” hit points.
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Searching for Text (Main Window)
(Go back to Main Window)
The Search Text window is useful in locating a specific piece of information from DM
Genie’s large database of skills, feats, spells and powers. Enter the text to search for in the “Find
What” text box. Check the “Case Sensitive” box if you want to return only results where the case
is identical. The “Search In...” checkboxes allow you to limit your search to specific elements.
Click “Find Next” and DM Genie will highlight the next place the text is found. Whenever you
change the text in “Find What”, the search will restart from the beginning.

Searching Creatures
You may search for a creature’s name, for some text in a creature’s description, or for the
name of an item the creature is carrying, or for any combination of the three. DM Genie will search
either only in the current group or in All Creatures, depending on what you select in the box at right.

Searching the Database
Check the box next to what you want to search: skills, feats, abilities, spells and/or powers.
Searches are done in the full description of each of these items. Once the text has been found for
one item (skill, spell, etc.), the program does not search further into the description for that item –
clicking “Find Next” will return the next item with the selected text.
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Creature Tab Strip
(Go back to Main Window)
This tab strip offers a quick way to view and edit information about the currently selected
creature. It also offers quick reference guides to the rules, in the appropriate sections. Clicking on
each tab opens a different frame. Select the frame you wish to learn more about:
•
•
•
•
•

•
•
•
•

Combat Statistics Frame
Conditions Frame
Skills Frame
Feats Frame
Spells Frame
o Learning a Spell
o Casting a Spell
o Memorizing/Preparing Spells
o Spells Pop-up Menu
Psionics Frame
Notes Frame
Desc Frame
Items Frame
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Combat Statistics Frame
(Go back to Main Window) This help topic is Open Game Content, and is licensed for public use under the terms
of the Open Gaming License v1.0a.

The combat statistics frame shows you at a glance all the information about a creature that is
relevant for combat: Ability scores, AC, Hit Points, Attack bonuses, Saves, and the effect of
conditions.

Ability Scores

Each ability score has three numbers displayed:
- First, the base ability score. This is as was rolled when creating the character, plus any
permanent ability score change, such as wish spells or ability drains. You can change this
number at any time.
- Next is the current ability score. This is different from the base score if the creature is affect
by spells, magic items, temporary ability damage, or fatigue (see Conditions Frame). You
can also edit this number manually. When the score has been improved, its background is
light green, and when it’s been reduced, its background is light red.
- Finally, the modifier for the current ability score is displayed.
You can make an ability check by double-clicking the ability’s label (Str, Dex, etc.). This is
described in Combat Log.

Armor Class (AC)

On the right are the calculated armor classes. You cannot edit these 3 values:
- Total: The sum of all AC contributions (Dex, Armor, Magic, etc.). This is a creatures’ AC
in regular combat. Double-click the label to get a complete report of the source of bonuses to
AC, including those from conditions.
- Lose Dex: If the creature has lost it’s Dexterity bonus to AC (from being Flat-Footed for
example), then the check box will be checked, and the creature’s AC is that written in the
text box.
- Touch: This is the AC versus touch attacks. Armor and shields (and their magical bonuses)
do not contribute to this AC, nor do spells that create an armor effect, such as Barkskin.
On the left are the contributions from various sources
- Armor, Shield: This is the armor bonus to AC from shields, armor, or natural armor. This
includes magical bonuses to armor. All these bonuses are lost in touch attacks. See the Items
Frame for instructions on setting armor/shield.
- Misc: Other contributions to AC: Magic rings, modifiers for size, and any other permanent
modifier.
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-

Temp: The sum of AC contributions from conditions or spells. This is determined from
conditions and cannot be edited. See Conditions Frame.

AC Mods from Conditions

Different spells provide different types of bonuses to AC. The total bonus or penalty for
each of these types is displayed in this frame. Bonuses of different types always stack, while
bonuses of the same type usually do not stack (except dodge, and general). To viewThis frame may
not be visible if you are running DM Genie at 800x600. Positive AC modifiers are signaled with a
pale green background, while negative AC modifiers have a pale red background.

Hit Points

-

-

Current: The creature’s current hit point total. This is adjusted downwards when receiving
damage, upwards when being healed, and can temporarily exceed the creature’s base HP.
Temporary HP from a spell or other effect must be removed manually after the duration of
the spells ends.
Base: The creature’s base hit points. This is the maximum HP a creature can have under
normal circumstances,
Nonlethal: This is the amount of nonlethal damage received. When the amount of nonlethal
damage equals the number of remaining HP, the creature is staggered. When it exceeds the
remaining HP, the creature falls unconscious.

Base Attack Bonuses
Each box holds the base attack bonus for attacks 1 thru 5, starting on the right. If the box is
grayed, then the creature does not have that attack. If all boxes are grayed except the first, then the
creature does not have multiple attacks. To remove an attack, select the text and erase it. The box
will then become grayed. To add an attack, simply enter any number into the box, even 0 or a
negative number will enable that attack.

Initiative
The box labeled “Init” holds the current creature’s initiative. The box labeled “Bonus” holds
the creatures’ bonus when rolling initiative. Note that the initiative bonus is not automatically
recalculated if the creature’s Dexterity changes. Double-click the “Init” label to roll a new initiative.

Saving Throws
Three text boxes hold the saving throw bonuses for Fortitude, Reflex and Will saves. These
values can be edited and also change automatically if the relevant ability score is modified. Double-
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click the label to roll that saving throw. The save has a pale green background if a condition affects
it positively; a pale red background if the modifier is negative; and the normal background if no
condition affects the save.

Speed, Size and Face/Reach

These text boxes display the size, speed and face/reach of this creature. These can be edited
but serve only as reminders, and hence do not alter game statistics. If a creature changes size
categories (a very rare occurrence), you need to modify the AC manually (in the Misc. box).

Conditions Summary

These box,es display the sum of the effects of conditions and spells. Beneficial modifiers are
indicated with a pale green background. Harmful modifiers are signaled with a pale red background.
Indicated values are
- The creature’s attack bonuses for melee and ranged weapons
- The attack bonuses for someone attacking this creature (This affects effective ACs: ACM
and ACR. See Creature List).
- The creature’s bonus to damage rolls.
- The creature’s miss chance when being attacked. Double-click the label to roll a d100 and
check if an attack hit.
- Whether the creature can perform full actions.
- Whether the creature can perform partial actions. If the full actions box is checked, then this
box will be checked as well.
- If the only action the creature can take is movement.
- If none of the previous boxes are checked, then the creature cannot act at all.
- An abbreviated list of the conditions is displayed below the conditions summary frame.
When running DM Genie at a resolution higher than 800x600, or if you shrink the creature list, you
can also see:
- The temporary damage resistance, spell resistance and power resistance
- The environmental damage resistance from the conditions.
- The spell failure from the conditions (double-click the label to roll it).
- The bonus to saves vs. fear effects.
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Conditions Frame
(Go back to Main Window)
The conditions frame offers a quick way to view and edit the most common conditions that a
creature can be under. Every one of these conditions, plus the many more conditions specific for
spells, can be edited in the Conditions Editor. Another way to set these conditions is by using the
Condition Setter. To learn more about conditions and how they are applied, see About Conditions.
Check Boxes: If a check box for a particular condition is checked, then the creature has that
condition. Simply click on the check box to set/remove a condition.

Text Boxes: a text box accompanies each condition. If it is empty, then this means that the
condition has no expiration – it will stay active until the DM removes it. If it isn’t empty, then the
number in it is the number of rounds until that condition expires. Longer times are displayed with
the format '
2h30m4'which gives the number of hours, minutes and rounds respectively. The last
number is in rounds (10 rounds per minute). To set the expiration, simply type in the number of
rounds (or use the '
#h#m#'format). The initiative at which the condition will expire is the initiative
of the creature whose turn it is to act. For example:
-

-

An evil sorcerer, acting on round 3, initiative count 18, casts a spell that blinds Marcus for 5
rounds. The DM selects Marcus, enters 5 in the text box next to “Blinded”. Now Marcus
will be blinded until round 8, on initiative count 18, at which point DM Genie will warn that
the condition has expired. Until then, the effect of being blinded is calculated and all stats
are adjusted.
Marcus uses a potion of invisibility that renders him invisible for 90 minutes. Check the
'
Invisible'box and enter '
1h30m'in the box next to it. '
1h30m'is the same as 900 rounds –
you can enter either.

Cover/Concealment/Fatigue/Fear

Four dropdown lists allow you to set the cover, concealment, fatigue and/or fear of any
creature. These conditions do not normally automatically expire, but if you wish, use the Condition
Setter to set expiration for these conditions. The label above the list summarizes the game effect.
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Other Active Conditions
Uncommon conditions, for example conditions from spells set using the Condition Setter,
are displayed here. Uncheck a box to remove that condition. Hover the mouse on the conditions’
name to get a summary of its effects.

Counters
Six counters are available to help keep track of other conditions or durations. The first box
holds the name of the counter. The second box holds the number of rounds left until it expires. For
example, if a dragon can use its breath weapon every 1d4 round, you could create a “Breath
Weapon In” counter. When the dragon has used its breath weapon, you roll a d4 and get 3. So, you
set the second text box to 3, and in 3 rounds DM Genie will warn you that the counter “Breath
Weapon In” has expired.
-

Here are some ways you can use the counters:
Breath weapons
Summoned monster’s existence
Time until the creature can use a special ability
Duration of a magic item’s effect
Duration of a monster’s special quality or ability
Time until the door is magically barred (or some other event)
Time until the monsters get reinforcements

Condition Summary
This rich text box displays a summary of the effects of all active conditions. This can be
useful because it also displays special notes (underlined) for active conditions, usually effects that
aren'
t automatically calculated by DM Genie. This box is not visible when running at 800x600, but
you can still get the information by using the Current Character->Detailed Bonuses->Condition
Summary menu.
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Skills Frame
(Go back to Main Window) This help topic is Open Game Content, and is licensed for public use under the terms
of the Open Gaming License v1.0a.

The skills frame contains a list of skills (either all skills or just those available to the
creature), as well as a description box, which allows you to quickly determine how a skill applies
and what DCs to use.

The List of Skills
The skill list displays all skills if the “Show All” box is selected. If the "Usable" box is
selected then only those that the creature can use are displayed – skills with 1 or more ranks, and
skills with no training required. Finally, select “Ranks” to display only skills for which the creature
has 0.5 or more ranks.
- Skill name: The name and specialization, if any, of the skill. Skills affected by an armor
check penalty have a * after their name. See the Items Frame to set the armor/shield of a
character.
- Ab.: The relevant ability score.
- Tot.: The total bonus when rolling this skill. A value of –99 indicates that the creature is
untrained in a skill that can only be used by someone who is trained. This value is the sum
of ranks, misc. bonuses, and the bonuses for the relevant ability score.
- Rnk.: The ranks this creature has in this skill. This can use decimals (0.5, 1.5, etc.) if the
skill is cross-class. Synergy between two skills (one gets a +2 bonus if the other has 5 or
more ranks) is handled automatically when you change the number of ranks. To change
synergy edit RULES.TXT (see Customizing Game Rules).
- Misc.: Various bonuses to the skills. This may come from skill synergy, from racial
bonuses, or from temporary (condition) skill bonuses.

Other Info
This is a text box to help the DM when characters have non-standard skills or skill
specializations. For example, he could put ranks in Craft (Other) and note here that Craft (Other) is
actually Craft (Pottery).

Description Box
This describes the skills and DCs for various tasks. You can edit the description in any way
you desire, using the Word Processor Commands.
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Feats Frame
(Go back to Main Window) This help topic is Open Game Content, and is licensed for public use under the terms
of the Open Gaming License v1.0a.

The feats frame holds a list of all feats and special or class abilities. Special abilities are
usually for monsters and are designated with a *. Class abilities are gained by PCs as they advance
in levels for specific classes, and the name of the class for which it applies is indicated in
parentheses.

“Feats” and “Special/Class Abilities” checkboxes: Check either one or both of the
checkboxes to select what to display in the list.
Only feats that the creature has are displayed if the “Show All Feats” checkbox is
unchecked. The description of the selected feat is displayed in the text box on the right.
To add a feat to a creature, check “Show All Feats”, then select the desired feat, and click
“Has Feat”. If the feat has a calculable effect on the character your PC will automatically be
changed. For example, selecting Improved Initiative will give your PC +4 to its initiative bonus.
Some feats require you to choose on what weapon it applies (for example, Weapon Focus). A few
feats that only work under specific conditions, for example Dodge or Point Blank Shot can be
enabled by clicking the '
Use'and '
Stop'buttons (below). Other feats have no calculable game effects
and so must be handled manually.

The "Use" button will perform different actions depending on the feat you have selected. It
will usually automate some rolls and report the result in the Combat Log. For example, Deflect
Arrows will roll the Reflex save and report its success or failure. Some feats also have a "Stop"
button, for example Barbarian Rage, where Stop will end the rage.
Some feats have a "Rest" button activated, which will usually reset the number of daily (or
weekly) uses of an ability.
The "Take Again" button is available for feats that can be obtained multiple times. Each
time the effects will be calculated again. For example, you could take Toughness again and gain
more HP, or take Weapon Focus on a different weapon.
The "Edit" button will open the Feat Script Editor, allowing you to change the way any feat
works by entering a small VBScript program. For more info on this very powerful function, see
Scripting for Feats.
The “Info” text box holds notes for the DM specifying what weapons or spells each feat
applies to. For example, a wizard could select Spell Focus for Evocation spells. In the info box, you
would see “Spell Focus (Evocation)”.
The Description text box holds the effects of having the feat or special ability. For many
feats, a paragraph in green gives hints on how to apply the feat to DM Genie in cases where it
cannot be automated. You can edit this text any way you like, using the Word Processor
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Commands. This paragraph is distributed as Open Game Content along with the rest of the
description.

Why Include Special Abilities With Feats?
You may be wondering why we list special and class abilities along with the feats. We have
decided to do this because of the great similarity between them. The only real difference is that
special abilities are in-bred (from the race) and class abilities are automatic upon level increase. In
fact, some class abilities are “Virtual Feats” because they act just like a real feat.
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Spells Frame
(Go back to Main Window) This help topic is Open Game Content, and is licensed for public use under the terms
of the Open Gaming License v1.0a.

List of Spells: This is an alphabetical list of spells. You can filter the spells by selecting a
radio box: All displays all the spells; Known only displays the spells the PC knows (are in his spell
list); Mem. displays only memorized spells. Spell names followed by a * have conditions associated
with them.
Filter Spell List: Check the “With Text” checkbox to show only those spells whose
description contains the phrase in the text box at right. You can use this to show only spells of a
specific level. For example, enter "Clr 1" to show only level 1 Cleric spells. For sorcerer spells, use
Sor/Wiz #, because that is the way the level is written in the descriptions. You can search for
multiple strings by separating them with semicolons. Both strings have to be present in the
description in order for the spell to be listed. For example, "Sor/Wiz 1; Evocation" will return 1st
level evocation spells accessible to a sorcerer.
Known by: To add a single spell to a character’s spell list, display “All” the spells, then
select the spell in the list, and check the “Known By” checkbox.

Spell Slots Grid: This grid has two rows for each spell casting class that the character has.
The first row is the maximum number of spell slots the character can have. The second row is the
number of spell slots left today.
Spell Description Box: Information about spell duration, effects, range, domain, level, etc.
is displayed in this box. You can edit this any way you like, using the Word Processor Commands.

Learning a Spell

Check the Known By box to have a PC learn a spell. If the PC has a single spellcasting
class, and the spell can be cast by that class, then the text box next to the checkbox will
automatically read the name of that class. For example, a Cleric learns Cure Light Wounds, so his
Known by box reads "Clr".
If the PC is a multiclass Cleric/Druid, and you want the Cure Light Wounds spell to be
known by both classes, edit the box to read "Clr, Drd". This means that either class can cast the
spell, with different caster levels, etc.
Some creatures have spell-like abilities. These are noted as "Race" in the Known by box. A
PC can also have spell-like abilities, so the Known by box would read "Race, Clr" for example. If
you try to give a spell to a creature who does not have any class that can learn it, it defaults to be a
spell-like ability.
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Casting a Spell

To cast a spell, use the Cast Spell button. If more than one class knows the spell (see
above), you can select in the list at right which class does the casting. You can also use the box to
opt to cast a memorized spell rather than use a spell slot (see below).
When casting, a note in the combat log is added, for example:
Markus casts Align Weapon as Clr 9 (DC 12).

The note indicates which class is casting, what is the caster level (including prestige classes), and
the spell DC. If you exceed the number of spell slots available, you will see a warning:
Markus casts Align Weapon as Clr 9 (DC 12). Warning! No spell slots available to cast.

If you attempt to cast an unknown spell, you will get a warning, and the caster level will not be
calculated:
Markus casts Acid Fog. Warning! Cannot cast this spell.

If the "caster" is actually a monster with a spell like ability, the caster level will be obtained from
the race'
s data:
Angel, Solar casts Blade Barrier as Race (effective caster level 20) (DC 23).

If the spell has a condition associated (its name is followed by a *) with it, it then opens the
Condition Setter with that condition selected. See Editing Spells’ and Powers’ Associated
Conditions to associate conditions.

Memorizing/Preparing Spells
To prepare a spell, click the Memorize button. This will add an item in the list at the right of
the frame indicating which class memorized the spell, for example, "Mem. by: Clr"
To memorize while applying a metamagic feat, click the Meta Mem button. You will be
presented with a window which will display a list of checkboxes for each metamagic feat available.
Check those you wish to use. In some cases you also need to give a "number of times" to apply the
feat (like Heighten Spell). The list of memorized spells will read for example: "Mem. by: Clr,
Heightened +2"
If more than once class knows the spell, select it in the list before clicking Memorize. The
class memorizing it (and its spell slots) will be decided from the selection in the list.
Times memorized: The total number of times the spell has been memorized.

Spells Pop-up Menu
Right click on the frame or on the spell slots grid to open the pop-up menu.
Cast Spell: Same as pressing the Cast Spell button.
Spell Slots to Full: This resets the number of spell slots left to the maximum number. Click
this when the character has rested.
Auto Spell List: This command allows you to automatically give a creature all spells for
several classes, up to a specified spell level for each class. Enter the class abbreviation (Brd, Clr,
Drd, Pal, Sor/Wiz, Rgr) or the domain of the spell (Fire, Knowledge, etc.), a space, then the
maximum level, separated by semi-colons for each class. Use Sor/Wiz instead of just Sor or Wiz for example '
Sor/Wiz 3; Brd 2; Fire 3'
. This function is particularly useful for divine casters, who
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usually have access to all spells up to their level limit. For arcane casters, remove spells that aren’t
in the character’s spell list.
Clear Memorized Spells: Sets, for all spells, the number of times memorized to zero.
Mostly useful after your character has rested and wants to change the spells he/she has memorized.
Saved Spell Lists: You can create preset lists of memorized spells that you can reuse. The
Save Memorized Spell List menu will ask you to name the current spell list for later reference. For
example, spells useful for a dungeon crawl would be '
Dungeon'
. Later, you can click the Use Saved
Spell List menu and select which list to reuse. This resets your memorized spells. Edit Saved Lists
allows you to rename/delete existing lists.
Rename/Delete/Create New Spell: See the Customization menu in the Main Window
Menus.
Edit Spell Conditions: Opens the Conditions Editor.

Note: Spells With Names of NPCs
Wizards of the Coast has released the spells and their description as Open Game Content
(see Open Gaming License v1.0a) but has taken out the names of famous NPCs (Leaving, for
example, Floating Disk, Sword). We have renamed the spell using the abbreviation or a
modification of the original name. For example, Big’s ... Hand spells and Oti’s ... Sphere spells
instead of the originals. Hopefully this will not cause too much confusion. Other third-party
publishers such as Necromancer Games and Creative Mountain Games have used this or a similar
approach.
This might cause problems when importing creatures from a stat block. However, if DM
Genie does not find the exact spell name on the first try, the program tries again but checks the
imported spell name with DM Genie’s spells, this time with the names with the NPC names
removed (anything before an apostrophe, e.g. Oti’s Freezing Sphere becomes Freezing Sphere,
etc.). This means that Oti’s Freezing Sphere will match Otlukke’s Freezing Sphere and Freezing
Sphere; so there is no need to correct the spell names when importing (unless they do not have an
apostrophe before the after the name).
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Notes Frame
(Go back to Main Window) This help topic is Open Game Content, and is licensed for public use under the terms
of the Open Gaming License v1.0a.

Enemy/Friend radio buttons: Choose whether the current creature is an enemy (against the
PCs) or a friend (allied with the PCs).
Inactive: This creature will not enter in a combat (for example, when clicking '
Quick
Combat'
). Also, an inactive character doesn'
t count in the Encounter Level or the average PC Party
level. Also it does not affect XP calculation (in counting the number of members in the PC'
s party).
For example, the mule that travels with the party would be checked as inactive.
Familiar or Summoned: Check this box if the creature will participate in combats but
won'
t count in the Encounter Level or the average PC Party level. For example, a wizard may
summon a few monsters. These creatures'CR is included in the CR of the wizard, so they should
not be counted twice. Familiars and inactive monsters do not count when calculating the XP to
award the PCs for defeating enemies.
Alignment: The creature’s alignment.
CR: The creature’s challenge rating. Use decimal points (0.5) rather than fractions like
“1/2”.
XP: The creature’s current experience point total.
XP Goal: XP needed to reach next level
Gets % of XP: The percentage of the share of XP this character will get. For example, if
there are four PCs and one henchman in your group you could give 100% of XP to each PC and
50% to the henchman. So a total XP award of 450 XP will give 100 XP to each PC and 50 to the
henchman (under the orginal 3rd edition). Under 3.5 rules, if a PC is set to get 50% of XP he will get
half of the XP calculated for him based on his level and the CR of the monsters.
SR: The creature’s spell resistance.
PR: The creature’s power resistance.
DR: Damage Resistance (permanent). The first box is the number of hp absorbed, the
second box is the type of weapon that overcomes it (for example, "evil" or "cold iron".
Carrying Capacity: Maximum weight (in pounds) for the character. This is calculated from
the Strength, and the size of the creature, and assumes the creature is 2-legged. Some conditions
(Starting with "Load: ") are automatically set if the total weight carried exceeds the light load value.
Quadrupeds can carry more weight; enter the multiplier to the carrying capacity in the "Multiplied
by" text box.
Languages: The languages that the creature can speak, read and write (except for
Barbarians, who are illiterate).
Proficient Weapons: List of the weapons this character can use without penalty. This isn'
t
applied automatically – DM Genie assumes proficiency with the weapons used.
Cleric Domains: The domains the cleric has, separated by commas. This can affect spell
levels when casting cleric spells.
Forced Class Skills: Comma-separated list of skills which are to be considered as classskills for all levels gained by the PC.
Spell Notes: Misc notes about spell casting or related to the spell caster classes.
DM’s notes: Holds notes from the DM relating to the current adventure/campaign, and is
useful for information that does not fit anywhere else. You can edit this any way you like.
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Desc Frame
(Go back to Main Window) This help topic is Open Game Content, and is licensed for public use under the terms
of the Open Gaming License v1.0a.

The Desc (Description) frame holds information that relates to PCs and NPCs. Most
monsters will not need any information in this frame. This information is used in the Character
Sheet Output.
-

Player Name: The person who plays this PC
Age: in years.
Height: in feet and inches.
Weight: in pounds
Gender: Male, Female or neutral
Eye, Hair and Skin Color: any text you wish.
Deity: The god the PC worships.
Backstory: Notes about what happened to the PC before this adventure.
Picture File: Click "Choose File" to select a picture file for your character (like his portrait
for example). Click "View Picture" to open the graphic file in your default editor/viewer.
The picture is also displayed on the Character Sheet Output.
Description: Holds miscellaneous information about the creature. For example, face, reach,
special attacks and qualities, appearance, treasure carried, etc. You can edit this any way you
like, using the Word Processor Commands.
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Psionics Frame
(Go back to Main Window) This help topic is Open Game Content, and is licensed for public use under the terms
of the Open Gaming License v1.0a.

This frame displays the number of power points and talents left, as well as the list of psionic
powers and the description for each power. The Psionics frame is identical to the Spells Frame
except without the Spell Slots grid, and with the following additional controls:
-

Max PP: The character’s maximum power points total. This is the amount he has when
fully rested. This value includes bonuses from high ability scores – double-click the Max PP
label to get an accounting of where the power points come from.
PP Left: The number of power points left for the character to use today. If a player tries to
use a power with too few power points left, a warning is displayed in the Combat Log.
Psi Focus: Indicates whether the PC has psionic focus (necessary for metamagic feats under
the revised psionics rules). Double-click the label to give psionic focus.
Talents left: The number of times left today that the character can manifest a talent (0-level
power) for free.

Memorizing Psionic Powers
The psionic classes in the Psionicist'
s Handbook do not require that powers be prepared in
advance, unlike some spellcasting classes. Since psionics and magic share the same engine, the
capability remains. This would allow you to create a psionic class that requires preparing powers
ahead of time; however for the normal classes you don'
t need to use the Memorize buttons.
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Items Frame
(Go back to Main Window) This help topic is Open Game Content, and is licensed for public use under the terms
of the Open Gaming License v1.0a.

This frame display information about the armor and shield the character is currently using,
as well as a list of the items in his possession. To edit details of an item, use the Items Editor.

Armor and Shield

The two textboxes show the current armor and shield that the creature is using. To equip a
shield or armor, select it in the dropdown box at right and click "Add". Make sure the armor
you wish to use is equipped (right-click and check the "Equipped" menu). Equipped items are in
bold.
Normally, you should equip a maximum of one armor and one shield. If multiple armors
are equipped, the best bonuses of each type will be used, and the worst penalties also – this can
cause problems. For example, a "Full Plate" and "Studded Leather +3" will use the regular Full
Plate bonus AND the +3 magical bonus, resulting in an excessive bonus.
To make a magic armor or shield with abilities, or to buy armor in different sizes (e.g. a
Small suit of armor for a Small PC), click the Create button.
If the currently selected weapon is two-handed or if you are wielding two weapons (Hand
Used is set as '
Off-Hand'or '
Primary Hand w/ 2 weapons'
) then you can choose to ignore the
current shield's stats. This basically means that whenever a PC starts fighting with weapons in
both hands, he puts away his shield and so loses the shield bonus to AC. To activate this select the
option in File->Options.

Cash

pp, gp, sp, cp: Number of platinum pieces, gold pieces, silver pieces and copper pieces,
respectively.
Total (gp): Total amount of coins, in gold piece equivalent.
Coin Wt: The weight of all the coins (50 coins/pound).
Valuables: Note valuable items such as gems, art, land, objects not carried with the
character, etc.
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Items List

This is the list of all items owned or carried by the creature. The margin on the left holds the
buttons to expand or collapse containers. The first column is the name, the second is the weight in
pounds including all contents (wt), and the third is the price in gold pieces (gp). The weight and
price can be fractional. For example, if an object costs 1 silver piece, enter 0.1 in the “gp” column.
You can also click on the last line of the grid (which is blank) to create an item from scratch. If you
are running DM Genie at a resolution greater than 800x600, you can also see a fourth column, “#”.
This column gives either the number of items (for example 20 arrows), or the number of charges
left for a magical item (if the item can hold charges, for example a wand or a staff). You can also
edit this from the Items Editor.
Right-click on the item to show the Items Pop-up Menu and change the item’s type
(magical or psionic). The list can have different colors depending on the type of item and whether
or not the PCs have identified it. You can change these colors in the Options Dialog.
Below the list of items is the total weight and value of all the items in the list. Multiple
items’ weights and prices are multiplied – for example 20 arrows at 1 cp and 0.01 lb each are worth
2 sp and weigh 0.2 lbs. Total Weight also includes weight from coins (50 coins/pound).

Add/Buy Buttons

Select an item from the list at left. Clicking this button adds that item to the current
creature’s inventory. You can also click on the last line of the grid (which is blank) to create an item
from scratch. Note: some magic items come in several versions with different abilities and prices,
which are described in the item’s description. The default price indicated for these items is 0 – so
you must set the real price manually so that it corresponds with the correct version. You can also
add items from the Adventure Items tab or from the Items Editor.
The Add button will get the item for free, while the Buy button will subtract the correct
amount of money from the total. Note that the buy button won'
t make change for you – if you buy a
1 cp item but have only silver pieces, you will end up with –1 cp.

Dragging and Dropping
Dragging and dropping is an easy way to move items around in DM Genie. Click the mouse
on an item and hold down the button while you move it. Releasing the button will move the item,
depending on what is under the cursor:
- Dropping in a container: will put the item inside that container. For example, if you drag a
Dagger on a Backpack, the dagger will go inside the backpack. Note that when you
drag/drop a container, you automatically move it'
s contents as well.
- Dropping next to another object: If you drop on an object that'
s not a container you will
simply place your dragged object next to it in the list.
- Dropping on a character in the Creature List: will move the item to that other character.
- Dropping in the Items list of the Campaign Manager: will move the item to that
adventure.
- Dropping in the Items list of the Random Treasure window: will add that item to the
treasure list.

66
See also the Items Pop-up Menu.
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Items Pop-up Menu
Right-click an item on an inventory list in the Main Window, the Campaign Manager, or the
Random Treasure Generator to see this menu.
-

-

Use Item: Adds a line in the combat log saying that the creature has used the item. If the
item is disposable, the number of items is reduced by one. If the item has charges, the
number of charges is reduced by one. Finally, if the item can generate conditions (like some
magic items, especially scrolls), the Condition Setter is opened, with the related conditions
in the list. The Items Editor can be used to associate conditions to an item.
Edit Item: Opens the Items Editor with this item selected.
Remove: Removes that item from the list
Sell Item: Sells the item and gives the corresponding coins to the PC. Asks for the
percentage of full value to give in GP (default is 100%).
Equipped: When checked, the item is equipped. This means it is either being worn, in hand,
or activated in some way. Magical items with conditions that are always on have those
conditions automatically activated.
Container: You can expand all containers (show all contents) or collapse them all. Also,
you can take out all the contents of one container.

The next options allow you to select the type of item.
- Mundane Item: Neither magical nor psionic.
- Magical but unidentified: The players do not know the effect of this item. This reminds
you to apply them for the players. For example, add +2 to every attack roll made with a
longsword +2 if the PCs have not determined its power yet.
- Magical & Identified: The players know about this item’s power, so you don’t need to keep
track of them
- Psionic but unidentified: See Magical but unidentified
- Psionic & Identified: See Magical & Identified
The next options are useful to move items around.
- Give Item To: A list of the creatures in the PC'
s Party group are presented. Select the PC
who will receive the item you selected. From this menu you can also give the item to the
currently selected adventure, or to the Random Treasure Generator window.
- Copy All To: As above, except you will give a copy of ALL items to the target PC or
adventure.
A few more menu items allow you to use the appraisals window, under the Appraisal submenu
(Not available in Player Genie):
- Add to Appraisals: Adds that single item to the list of appraisals. See the Appraisals
Window.
- Add to Appraisals: Adds all the items to the list of appraisals. See the Appraisals Window.
- Open Appraisals Window: See the Appraisals Window.
Still more misc. menu options:
- Ignore weight: The item'
s weight doesn'
t count in the player'
s total weight and so won'
t
cause his load to go from light to medium. For example, an object carried in a bag of
holding. An asterix * next to the weight signals those items with ignored weight.
- Sort Item list: Choose by name, weight or value.
- Read Item String: Reads a comma-separated string of items, much like those accepted by
the Stat Block importer (see New Creature: Import Stat Block).
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Finally,
- Clear All Items: removes all the items in the list.
To give random treasure, see the Random Treasure Generator.
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Actions Tab Strip
(Go back to Main Window)
The actions tab strip allows you to switch between different frames to select specific actions:
attacks, other actions, class-specific actions. A frame to set what classes the character has is
included, as well as a stat block exporter to allow printing of a character or monster’s important
statistics. Click below for more information.
•
•
•
•
•

Attacks Frame
Actions Frame
Class Abilities Frame
Classes Frame
Stat Block Frame
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Attacks Frame
(Go back to Main Window) This help topic is Open Game Content, and is licensed for public use under the terms
of the Open Gaming License v1.0a.

This frame displays a list of the creature’s available attacks, and, for the selected attack, the
damage and attack bonuses for that attack.

List of Attacks

This holds the list of all types of attacks available to the creature. The humanoid races
(humans, elves, orcs, etc.) typically have a list of weapons available to them: swords, bows,
unarmed, etc. These creatures can usually only attack with one kind of weapon on a particular
round, except when they are fighting with a weapon in each hand. Monsters and animals typically
have a list of natural attacks: claws, bite, slam, etc. These creatures can typically use all their types
of attacks in a single round. For example, a dragon might have a bite attack and two claw attacks,
which means he has 3 attacks per round.
Separate alternative of attacks with an “or” to signify that not all the attacks can be done in
the same round. For example, a human could have “Shortsword” and “or Crossbow”, meaning he
can use either of the weapons but not both in one round. A dragon, on the other hand, could have
“Bite”, “Claws” and “Wings”, three types of attacks that can all be made in the same round.

List of Attacks Right-Click Menu
Right-click the list of attacks to pop up a menu. Menu options are applied on the currently
selected attack. The Move Up, Move Down, Move to Top and Move to Bottom menus allow you
to move the attack along in the list.
Use the Hide Attack to temporarily remove the selected attack from the list. The attack
won'
t show up in the stat block or the character sheet. Afterwards, use Unhide All Attacks to show
all hidden attacks.

Description of the Elements in the Frame

-

Remove: Deletes the currently selected attack.
Add New: Opens the Standard Weapons Editor, which will allow you to add a new attack
to this PC.
Weapon/Type: The name of the weapon or natural attack
Main Dmg: (Main Damage) A string indicating how many dice of what value are rolled,
and what is added to the roll to get the total. The format is “2d6 + 4 and notes”. The amount
added to the roll “+ 4” is the sum of the Strength modifier, temporary modifiers to damage,
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-

-

-

and the weapons’ damage bonus. You can add notes such as “and paralysis” as reminders of
the creature’s special attacks or qualities.
Secondary: Some weapons deal two dice of damage, for example, a flaming longsword is
1d8 (regular longsword) + 1d6 (fire damage). Enter the second dice in this text box and
check the checkbox to roll it when making an attack. For example, you would uncheck the
box when fighting a monster that'
s immune to fire damage. Another good use of this box is
for sneak attack damage – check the box when a sneak attack is possible.
Type of damage: Each dice can have it'
s own type of damage. This is displayed as a note in
the combat log when attacking. When Damage Reduction is automatically handled in a
future version the damage type will be used to determine whether or not it applies.
Secondary damage is not multiplied in critical hits, unless you enter "CRIT" in the damage
type.
Extra Atk bonus: This is the sum of bonuses to attack rolls coming from: magic weapons,
masterwork weapons, feats such as weapon focus, and other bonuses that apply to this
weapon only.
[Extra] Dmg bonus: This is the sum of bonuses to damage rolls coming from: magic
weapons, feats such as weapon specialization, and other bonuses that apply to this weapon
only.
Critical: This string describes the range of critical threat and the effect of a successful
critical hit. For example, “19-20/x2” means that a 19 or 20 is a critical threat, and that
damage is doubled. “20/x3” means that only 20 is a critical threat, but damage is tripled.

Attack Type

-

-

Melee/Ranged: The type of attack this weapon makes. Melee attacks add the Strength
bonus to attack and damage; ranged attacks add the Dexterity bonus to attack.
Touch: Check this box for a touch attack. These attacks ignore any AC contribution from
armor.
Nonlethal: If checked, then this weapons deal nonlethal (temporary) damage.
Nonlethal Instead: When checked, the creature voluntarily tries to inflict nonlethal damage
instead of normal damage. This incurs a –4 penalty to attack rolls. Dealing normal damage
with a nonlethal weapon also incurs a –4 penalty.
Size: The size of the weapon. This determines whether a character can use it one-handed,
and affects disarm rolls. This also affects penalties when fighting with two weapons.
Cat (Category): Whether the weapon is designed to be a light, one-handed or two-handed
weapon. Starting in version 2.11, the size of the weapon (relative to the wielder) along with
this setting determines what hand(s) can be used with it. For example, a Medium, Light
weapon in the hands of a Medium PC cannot be used two-handed. A Huge, Light weapon in
the hands of a Medium PC MUST be used two-handed, and also incurs a –4 penalty to
attacks due to having two sizes of difference.
Category (continued): Other choices are Unarmed, Ranged, and N/A. Note that if your
weapon is set to N/A, the size of the weapon will be used to determine if it is light, for the
purposes of calculating attack bonuses in two-weapon fighting. This corresponds to how the
system was implemented in the 3.0 rules. No size mis-match penalties are applied in that
case (e.g. a medium PC with a small weapon does not get a –2 penalty if the Category is
N/A)
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Range Calculator

-

Increment: For ranged weapons, the range increment in feet. For melee weapons, this is the
range increment when thrown. Each full range increment in the distance between attacker
and target gives a cumulative –2 penalty.
Distance: The distance between the attacker and target for this attack (in feet).
Penalty: The penalty to the attack roll, if any, for being one full increment or further away.
This is not automatically included in the final attack bonus, but is presented for the user’s
information.
Apply: Check this box to apply the range penalty. Note that no penalty is applied when the
weapon is used as a melee weapon.

Natural Attacks
-

-

Is Natural Attack: When checked, all attacks are performed using the full Base Attack
Bonus – that is, the base attack bonus for the first attack the creature has. This is normally
used for creatures with several natural attacks, like an 8-headed hydra making 8 bite attacks,
all at the same bonus.
Number of Attacks: The number of natural attacks performed. This only applies if the '
Is
Natural Attack'box is checked. All attacks will be made using the full BAB.

Hand Used

-

-

-

Primary: The weapon is used normally, in the character’s most dexterous hand. This is the
only selection that should be used for ranged attacks.
Off-hand: If checked, then the weapon is used in the characters “off” hand (left if he is
right-handed, right if he is left-handed). Penalties apply, but can be reduced with feats. For
melee attacks, the character’s strength modifier bonus to damage is reduced by half
(rounded down, negative strength modifiers are unchanged). This rule applies even with
feats such as ambidexterity (see the WotC FAQ).
Pri. hand w/2 weapons: (Primary hand with Two weapons) If checked, then the weapon is
used in the character’s primary hand, but he is using another weapon in his other hand.
Penalties apply, but can be reduced with feats or automatically if the off-hand weapon is
light (one or more size categories smaller than the creature).
Two Hands: The character grasps the weapons in both hands. The damage bonus is 1 ½
times the character’s strength bonus (rounded down, negative strength modifiers are
unchanged).
O-H Alone: Off-hand alone, primary hand is free.
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Applying Feats
-

-

The next three checkboxes/text boxes are only visible if your PC has the feat in question.
Power Attack: The weapons’ attack bonus is decreased by the amount entered while the
damage bonus is increased by the same amount, as by the feat. The maximum adjustment is
equal to the creature’s full base attack bonus.
Expertise: The weapons’ attack bonus is decreased by the amount entered while the
player’s AC is increased by the same amount, as by the feat. The maximum adjustment
possible is +5. The bonus to AC is set in the form of a condition (e.g. “Expertise +2”) that
is removed when the checkbox is set to 0. Set the box to 0 before switching to another
weapon, or the condition will remain.
Weapon Finesse: The creature has the feat weapon finesse and uses it with this weapon.
Instead of the Strength modifier being applied to attack rolls, the Dexterity modifier is used.

Attack Buttons

-

-

1:+12, 2:+7, etc.: These buttons allow you to make a single attack. The first number is the
number of the attack. After the colon is displayed the total bonus to attack rolls for that
attack. When you click on one of these buttons, the AC hit and damage is displayed in the
combat log: see When a creature makes an attack. If a button is disabled, this means that the
creature does not have that attack. To add/remove multiple attacks, see Base Attack
Bonuses, in the Statistics Frame. If you are dealing with multiple natural attacks (all attacks
are to be made at the same Base Attack Bonus), check the Is Natural Attack box and set the
number of attacks.
Charge: This makes a charge with the first attack of the selected weapon. The creature must
run at least 10 feet in a straight line, and gets a +2 bonus to a single attack (at full BAB). For
the next round, the creature loses 2 from its AC (in the form of the “Charging” condition).

Auto Attack

-

Current Target: The name of the creature you wish to attack. You can edit this manually,
but when you use the "Auto Damage" menu of the Creature List Popup Menu it is
automatically set.
Auto-Attack: When checked, you will be prompted whether or not you want to attack the
'
Current Target'again. If you select yes, "Auto Damage" will be automatically applied to the
target – which means that the target will only lose hp if it'
s AC is low enough.
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Actions Frame
(Go back to Main Window) This help topic is Open Game Content, and is licensed for public use under the terms
of the Open Gaming License v1.0a.

The actions frame allows you to execute special combat actions. To the right, it also holds a
reference list of common actions, along with the time needed to execute them and whether or not
they provoke attacks of opportunity. Double-click an item in the list to add it to the combat log. The
buttons in the actions frame can be edited, see Customizing Game Rules.

Delay
The creature does not act at its given initiative; instead it waits. Delaying characters are
placed apart in the play order. See Steps for Running a Battle for more details.

End Delay
Click this when a creature stops delaying, but after its other actions have been done. The
creature'
s initiative is set to that of the character whose turn it is to act, but immediately afterwards.
Also, its round is incremented by one, so it will only come up again in the next round.

Ready
Make a partial action later, when a certain condition is fulfilled. Readying works just like
delaying except when comes time to end it. See Steps for Running a Battle for more details.

End Ready
Click this when the readied action has been accomplished. The creature'
s new initiative is
set to the same as the creature whose turn it is to act, but is placed before in the play order. The
creature’s round is incremented by one. On the next round, it will act just before the creature that
triggered its readied action.

Refocus
Sets the initiative of the creature to its maximum (as if the creature had rolled 20). No
actions can be done this round. Not normally present in the 3.5 version of the rules.

Fight Defensively
Sets the “Fighting Defensively” condition for one round. A character can choose to fight
defensively when taking the attack action. If a character does so, the character takes a -4 penalty on
all attacks in a round to gain a +2 dodge bonus to AC for the same round.

Total Defense
Sets the “Total Defense” condition for one round. A character doesn'
t attack or perform any
other activity other than moving at base speed, but the character gets a +4 dodge bonus to AC for 1
round. The character'
s AC improves at the start of this action, so it helps against any attacks of
opportunity provoked while moving.
See Also:
Bull Rush
Grapple
Disarm
Tripping
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Bull Rush
This help topic is Open Game Content, and is licensed for public use under the terms of the Open Gaming License
v1.0a.

Make a bull rush: a Strength check modified for size and charging (+2). A character can bull
rush as an attack action or a charge action.
When a character bull rushes, the character attempts to push an opponent straight back instead of
attacking him. A character can only bull rush an opponent who is one size category larger than the
character, the same size, or smaller.
Initiating a Bull Rush: First, the character moves into the defender'
s space. Moving in this way
provokes an attack of opportunity from each foe that threatens the character, probably including the
defender. Any attack of opportunity made by anyone other than the defender against the character
during a bull rush has a 25% chance of accidentally targeting the defender instead, and any attack of
opportunity by anyone other than the character against the defender likewise has a 25% chance of
accidentally targeting the character.
Second, the character and the defender make opposed Strength checks. The character adds a +4
bonus for each size category that the character is above Medium-size or a -4 penalty for each size
category that the character is below Medium-size. The character gets a +2 charge bonus if the Bull
Rush is attempted at the end of a Charge. The defender gets a +4 stability bonus if he has more than
two legs or is otherwise exceptionally stable.
Bull Rush Results: If the character beat the defender, the character pushes the defender back 5 feet.
If the character wishes to move with the defender, the character can push the defender back up to a
distance of an additional 1 foot for each point by which the character exceeded the defender'
s check
result. A character can'
t, however, exceed his or her normal movement limit.
If the character fails to beat the defender'
s Strength check, the character moves 5 feet straight back.
If that space is occupied, the character falls prone in that space.
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Grapple
This help topic is Open Game Content, and is licensed for public use under the terms of the Open Gaming License
v1.0a.

To change the current character'
s Grapple Bonus, edit the Grapple Stat box above the Do Grapple
button. This box holds the total grapple bonus from size, race, strength, etc.
When clicking Do Grapple, you will make a grapple check (a Str check modified for size).
Grappling means wrestling and struggling hand-to-hand.
Repeatedly in a grapple, a character needs to make opposed grapple checks against an opponent. A
grapple check is something like a melee attack roll.
A character'
s attack bonus on a grapple check is: Base attack bonus + Strength modifier + special
size modifier
Special Size Modifier: The special size modifier for a grapple check is as follows: Colossal +16,
Gargantuan +12, Huge +8, Large +4, Medium-size +0, Small –4, Tiny – 8, Diminutive –12, Fine –
16. Use this number in place of the normal size modifier a character uses when making an attack
roll.
A character provokes an attack of opportunity from the target the character is trying to grapple. If
the attack of opportunity deals the character damage, the character fails to start the grapple.
To start a grapple, a character first needs to grab and hold a the target. Attempting to start a grapple
is the equivalent of making a melee attack. If a character gets multiple attacks in a round, a
character can attempt to start a grapple multiple times (at successively lower base attack bonuses).
A monk can use his unarmed attack rate of attacks per round while grappling.
Step 1: Grab:
The character makes a melee touch attack to grab the target. If the character fails to hit the target,
the character fails to start the grapple.
Step 2: Hold:
Make an opposed grapple check. If the character succeeds, the character has started the grapple, and
the character deals damage to the target as if with an unarmed strike.
If the character loses, the character fails to start the grapple. The character automatically loses an
attempt to hold if the target is two or more size categories larger than the character is (but the
character can still make an attempt to grab such a target, if that'
s all the character wants to do).
Step 3: Move In:
To maintain the grapple, the character must move into the target'
s space. Moving, as normal,
provokes attacks of opportunity from threatening enemies, but not from the character'
s target.
Step 4: Grappling:
The character and the target are now grappling.
If a character'
s target is already grappling someone else, then the character can use an attack to start
a grapple, as above, except that the target doesn'
t get an attack of opportunity against the character,
and the character'
s grab automatically succeeds. The character still has to make a successful
opposed grapple check to deal damage and must still move in to be part of the grapple.
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When a character is grappling (regardless of who started the grapple), the character can make an
opposed grapple check as an attack. If the character wins, the character can do the following:
Damage A character's Opponent: A character deals damage as with an unarmed strike (1d3
points for Medium-size attackers or 1d2 points for Small attackers, plus Strength modifiers). If a
character wants to deal normal damage, the character suffers a -4 penalty on the grapple check.
Exception: Monks deal more damage on an unarmed strike than other characters, and the damage is
normal. However, they can choose to deal their damage as nonlethal damage when grappling
without paying the usual -4 penalty for changing normal damage to nonlethal damage.
Pin: A character can hold an opponent immobile for 1 round. (If a character gets multiple attacks,
the character can use subsequent attacks to damage the opponent. A character can'
t use a weapon on
a pinned opponent or attempt to damage or pin a second opponent while holding a pin on the first.)
While a character is pinned, opponents other than the one pinning the character get a +4 bonus on
attack rolls against the character (but the character is not helpless).
Break Another's Pin: A character can break the hold that an opponent has over an ally.
Escape: A character can escape the grapple. A character can take whatever movement the character
gets. If more than one opponent is grappling a character, the character'
s grapple check result has to
beat all their check results to escape. (Opponents don'
t have to try to hold a character if they don'
t
want to.)
When an opponent has pinned a character, the character is held immobile (but not helpless) for 1
round. The character can make an opposed grapple check as a melee attack. If the character wins,
the character escapes the pin, but the character is still grappling.
In addition to making opposed grapple checks, a character has a few other options while grappling.
Weapons: A character can attack with a light weapon while grappling (but not while pinned or
pinning). A character can'
t attack with two weapons while grappling.
Wriggle Free: A character can make an Escape Artist check (opposed by a character'
s opponent'
s
grapple check) to get out of a grapple or out of being pinned (so that the character is just being
grappled). Doing so counts as a standard action; if a character escapes a grapple, the character can
also move in the same round.
Several characters can be in a single grapple. Up to four characters can grapple a single opponent in
a given round. Opponents that are one size category smaller than a character count for half,
opponents that are one size category larger than a character count double, and opponents two or
more size categories larger count quadruple.
Additional enemies can aid their friends with the aid another action.
While a character is grappling, that character'
s ability to attack others and defend a itself is limited.
No Threatened Area: A character doesn'
t threaten any area while grappling.
No Dexterity Bonus: A character loses it'
s Dexterity bonus to AC (if a it has one) against
opponents a it isn'
t grappling. (A character can still use the bonus against opponents the character is
grappling.)
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Disarm
This help topic is Open Game Content, and is licensed for public use under the terms of the Open Gaming License
v1.0a.

Make a disarm attempt with the currently selected weapon. A defender gets a +4 bonus for
2-handed weapons – that is not automatically calculated.
The character and an adjacent target make opposed attack rolls with the their respective weapons. If
the weapons are different sizes, the opponent with the larger weapon gets a bonus on the attack roll
of +4 per difference in size category. If the target is using a weapon in two hands, he gets an
additional +4 bonus. If the character beats the target, the target is disarmed. If a character attempted
the disarm action unarmed, the character now has the weapon. Otherwise, it drops to the ground at
the target'
s feet. If the character fails, then the target may make an attempt to disarm the character as
an immediate, free action.
Note: A target wearing spiked gauntlets can'
t be relieved of the gauntlets by a disarm action. A
target using a weapon attached to a locked gauntlet gets a +10 bonus to any disarm attempt made by
an opponent.
This action substitutes for a melee attack, not an action. As melee attacks, it can be used once in an
attack or charge action, one or more times in a full attack action, or even as an attack of opportunity.
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Tripping
This help topic is Open Game Content, and is licensed for public use under the terms of the Open Gaming License
v1.0a.

Trip Attack
Make the melee touch attack roll for a trip attack. The Str check is also made, although if the
attack has failed you may disregard it.

Trip Defense
Defend a trip attack. Makes a Str or Dex check (whichever has the higher modifier),
modified for size. If this beats the attackers Str check, the trip fails.
A character can try to trip an opponent as a melee attack. A character can only trip an
opponent who is one size category larger than a character, the same size, or smaller.
Making a Trip Attack: Make a melee attack as a melee touch attack. If the attack succeeds, make
a Strength check opposed by the defender'
s Dexterity or Strength check (whichever ability score has
the higher modifier). A character gets a +4 bonus for every size category he is larger than Mediumsize or a -4 penalty for every size category he is smaller. The defender gets a +4 stability bonus on
his check if he has more than two legs or is otherwise more stable than a normal humanoid. If a
character win, a character trip the defender. If a character lose, the defender may immediately react
and make a Strength check opposed by a character'
s Dexterity or Strength check to try to trip a
character.
A tripped character is prone. Standing up from prone is a move-equivalent action. A character may
make a trip attack against a mounted opponent. The defender may use his Ride skill in place of his
Dexterity or Strength check. If a character succeed, a character pull the rider from his mount.
This attack form substitutes for a melee attack, not an action. As a melee attack, it can be used once
in an attack or charge action, one or more times in a full attack action, or even as an attack of
opportunity.
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Class Abilities Frame
(Go back to Main Window) This help topic is Open Game Content, and is licensed for public use under the terms
of the Open Gaming License v1.0a.

This frame holds a number of buttons to facilitate the use of character’s class abilities. These
buttons can be edited, and new ones added, by Customizing Game Rules.

Uncanny Dodge
Check this if your character has the Uncanny Dodge class ability. The character will not lose
its Dex bonus to AC when flat-footed.

Uncanny Dodge, Can’t be flanked
When you check this box, your character will ignore the “Flanked” condition.

Barbarian Rage, Greater Rage, Defensive Stance
Sets the character to have the “Rage”, “Greater Rage” or “Defensive Stance” condition for 3
rounds + the character’s new Constitution modifier.

Defensive Roll
On a single blow that would reduce the character to 0 hp or less, click this button to make a
Reflex save for 1/2 damage.
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Classes Frame
(Go back to Main Window) This help topic is Open Game Content, and is licensed for public use under the terms
of the Open Gaming License v1.0a.

Level Up: To help you in adding levels or classes to a PC or NPC, use the PC Leveling
Wizard, which you can open by clicking the '
Level Up'button. It is highly recommended that you
use the wizard to set classes and levels – however, you may also use this frame to set the classes and
levels manually.
Improve Monster: this button is used to advance a monster as per the creature advancement
rules in the Monster Manual. This uses the PC Leveling Wizard as well, only you select a Creature
Advancement Class instead of a regular PC Class.
Template: This opens the Templates wizard to allow you to give a template to a monster or
PC. The process is usually entirely automatic, and creates a copy of your PC, with the template
applied.
To change classes manually:
Add button: Manually add a new class to the list. Asks for the abbreviation for the class. A
reminder of some of the common abbreviations is displayed.
Delete button (trash can): Removes the currently selected class from the list.
View button: Opens the Class Editor with the currently selected class.

Adds Levels To:
Some prestige classes like Loremaster add levels to another spellcasting class. The levels are
added to the total spellcasting class level in calculations for determining caster level, spell slots per
day, and spells known. Normally the class that gets the extra levels is set when adding levels to the
prestige class. You can manually change it by double-clicking the '
Adds Levels To'label.

The Classes List
Displays three pieces of information for each class a character has: Class Name, Level, and
Base Level.
Name: The 3-letter abbreviation for this class. Use the standard abbreviations to ensure that
DM Genie functions properly.
Level: The character’s current level for this class.
Base Level: The character’s base level for this class. This could be higher than his current
level if the character has gained negative levels, for example. In the case of level drain, both the
current and base level drops.
Notes: Write down any useful reminders for this class for this character. This can be edited
using the Word Processor Commands.
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Stat Block Frame
(Go back to Main Window) This help topic is Open Game Content, and is licensed for public use under the terms
of the Open Gaming License v1.0a.

This frame simply holds the stat block for the current creature. This is automatically updated
every time the tab is opened (click the tab again if you modify the creature). You can copy this text
to a word processor or e-mail program to share the creature with others. You can also import a stat
block to create a creature (see New Creature: Import Stat Block). If you plan to share creatures with
someone who has DM Genie also, use the Exporting a Creature function instead of stat blocks – not
all information that DM Genie holds can be represented in stat blocks.

You can select what items to display by checking the appropriate boxes. You can also edit
the text manually – but it is reset each time you click the tab strip or when the creature changes.
Check the “d20 SSB” box to use a format very close to the d20 Standard Stat Block
Foundation’s stat block format. You can get more info about this stat block format at
http://www.d20statblock.org/. The New Creature: Import Stat Block function can also read this stat
block format.
Avoid creating a stat block when the creature is under a condition (unless that condition is
intended to be permanent, like permanent blindness for example). This is because only the
creature’s current ability scores, attack bonuses, etc. are recorded – and someone reading the stat
block or importing it into DM Genie will assume those are the real stats.
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Group Manager
(Feature not available in Player Genie)
The group manager allows you to create and edit groups. This means you can create new
creatures, add them to one or more groups, move them around or delete them. Keep in mind that
until you delete it, a creature is always in the “All Creatures” group. You can remove it from a
specific group but get it again from “All Creatures”. Deleting a creature is permanent. Also, the
same creature can be in two different groups – changing something in ‘Krugg the Orc’ in one group
will change it for ‘Krugg the Orc’ in all groups.
Many of the functions of the group manager are available from the Main Window or the
Campaign Manager, but some, like the Group Manager Menus are only available here.

Special Groups
Three groups are “special” and cannot be renamed or removed. They are at the top of the
group selection lists, and are:
- All Creatures: A complete list of all the creatures in the current campaign. Even if a
creature is in no other group, if it is still on file, then it can be found in this group.
- PC’s Party: This group should hold your players’ characters, as well as any NPCs that
accompany them and fight on their side during a battle. All the people in this group should
be friends. You can add or remove PCs or NPCs to this group as they join the game or as
they die or leave.
- Current Encounter: This is a placeholder group for creating a battle. You can add monsters
from another group here, then add the PCs. You can then run the battle, and clear the list
when you are done.

The Source Group
On the left is the list of all the groups in this campaign. Select one and the grid in the middle
displays the name of all creatures in that group, along with some useful info like hit points, armor
class and challenge rating. You can Select Multiple Creatures.

The Destination Group
A list box allows you to select which group is the destination group. This is the group that is
being edited. You can add, remove or delete creatures, rename the group or delete it.

Editing the Groups
Below the list of creatures in the source group you’ll find the Add All and Add Selected
buttons. These buttons add creatures from the source group to the current destination group. There
can only be one of the same creature in any group. A particular creature can be in two or more
groups at the same time, and its stats are the same for both groups.
For example, you’ve added “Marcus” to both groups “PC’s Party” and “Battle on Mount
Doom”. If Marcus receives damage while in “Battle on Mount Doom”, then when you select “PC’s
Party”, Marcus will have the same damage.
If you were to create a new creature and name it Marcus as well, then that creature’s
statistics would be independent from the first Marcus. Copies of a creature work the same way.
Adding Creatures to Ongoing Combat: in this frame you can specify on which round the
new monsters will start to act (for example, you could plan for the orcs to get reinforcements after
10 rounds). You can also specify whether their initiative should be re-rolled (if not, their old
initiative will be used). Finally, by checking the Are Aware box, the new monsters will come in
first in the next round (that is, their initiative will be 1 higher than the rest of the group).
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You can remove creatures from the current group using the Remove All and Remove
Selected buttons. The creatures removed will no longer be in the current group, but you can add
them again by going to the “All Creatures” group.
To permanently remove a creature from all groups, select it and click Delete Selected. The
file containing the creatures’ information will be permanently deleted, and it will be removed from
all groups.

Adding Creatures
The New Creature button opens the New Creature Screen that allows you to create a new
creature. The creature is added to the current group, in both the main window and the group
manager window.
The Add PC’s Party button adds all the creatures from the group “PC’s Party” to the
current group. If the group contained only monsters before, it now contains all the creatures in a
battle, and returning to the main window will allow you to start a battle. See Steps for Running a
Battle.

Create New Group
Asks for a name for the new group and creates an empty group with that name. You can then
add creatures to it.

Rename Group
Asks for a new name for the current group. Press Cancel or enter nothing to keep the
previous name.

Delete Group
This will delete the group and, if you choose it, the creatures in the group as well.

Group Manager Menus
From the File menu you will find a couple of useful tools for reducing the list of creatures:
Delete All Creatures from Random Encounters: Whenever you use an adventure’s Random
Encounters to automatically generate monsters, these creatures are marked as being from a random
encounter. Use this menu to delete them all. This is useful if you’ve had a lot of random encounters
but haven’t deleted each creature as they were killed.
Delete Ungrouped Creatures: During the course of using DM Genie, you may end up with a lot of
creatures in the ‘All Creatures’ group that aren’t in any other group. Usually, this occurs when you
remove the creature from a group without deleting it. Use this menu to reduce loading time by
deleting all these creatures.
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Select Multiple Creatures
In the group manager and the roll window, you may select more than one creature at a time.
To do this, simply click on each creature you wish to select. If you click on a selected creature, you
un-select it. To select a lot of creatures at once, click and drag along a selected block. Release the
mouse button (the pointer must still be over the grid). Creatures that weren’t selected become
selected, and vice-versa.
The Select All button, as the name says, selects all creatures in the list.
The Select None button clears the selection.
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Condition Setter
The condition setter allows you to set any condition in DM Genie for a single creature or for
several at once. It also allows you to set the round and initiative of the expiration of each condition.
The conditions frame in the main window can also be used to set conditions but only the most
common ones. Click here to learn more About Conditions. To change the effect of a condition, use
the Conditions Editor.

The List of Creatures
Select one or several creatures here. All settings for conditions you make will apply to all
the select creatures.

Currently Active Conditions
This shows all the conditions that are active for the selected creatures. Click on a condition
to select it and to view its expiration. Double-click on a condition to remove it. If you see “(3 of 4)”
after the name of the condition, this means that not all the creatures selected have the condition (in
this case, 3 of the 4 selected creatures do).

List of Conditions
This holds all the conditions in DM Genie. You can select whether or not to display
conditions that are for spells, powers, items or locked only by checking or unchecking the boxes
above. When you use the ‘Cast Spell’ or ‘Use Power’ button, only the conditions that apply for that
spell or power are displayed. Often there is only one condition, but spells that increase in power
with higher caster level (like Barkskin) or have different version (like Emotion) have several. A line
of text below the checkboxes serves as a reminder of what is the source for the conditions in the list.
Double-click on a condition to set it (if no creature has the condition) or remove it, for all creatures
selected.

Creatures currently have this condition
If this checkbox is gray, then some of the creatures have the condition and some don’t.
Check this box to set the condition for all selected creatures. Clear it to remove the condition.

Setting Expiration
You can either set the number of rounds until expiration (in which case the initiative of
expiration is the current initiative), or the round number and initiative directly. For longer times you
can use the format '
2h30m4'
, where 2 is the number of hours, 30 is the number of minutes and 4 is
the number of rounds (10 rounds per minute). This format only works for the text box right next to
the ‘Set Expiration’ button.
Press the ‘Set Expiration’ button to apply. The maximum expiration time is 32000 rounds,
or about 53 hours. For longer times, you can use the Reminders in the Timekeeping Window.
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About Conditions
(Go back to Conditions Editor) This help topic is Open Game Content, and is licensed for public use under the
terms of the Open Gaming License v1.0a.

Conditions are what make DM Genie great for helping run battles in-game. There are
several general conditions, and numerous conditions that apply for spell effects or psionic powers.
To set a condition for one or more creatures, use the Condition Setter.
You can also create new conditions or customize those that already exist, using the
Conditions Editor. This document explains the various modifiers that a condition can have. If the
condition has no effect, the default value is 0 – neither a bonus nor a penalty. Self-explanatory
entries are not listed.
Keep in mind when creating conditions that they each condition can have only a single
effect, which is the same for all creatures who have the condition. If a spell gives 1d4 points of
Strength, you must create 4 different conditions, each giving from one to 4 points of Strength.
-

-

-

-

Def. Melee: The Melee Attack Bonus for an attacker if the creature is the defender. This
affects the creature’s ACM and ACR, the effective AC versus Melee attacks and the
effective AC versus Ranged attacks. These are displayed in the Creature List. For example,
according to the official rules, someone attacking a prone character gets +4 to his attack roll
when in Melee. In DM Genie, the attack rolls are made without a need to specify the target.
Hence, the effective AC versus Melee allows you to know whether an attacker has hit the
prone creature, without having to specify the target on every attack. This makes it much
easier to track attack bonuses, because they are always the same no matter who the target is.
Def. Ranged: Same as Def. Melee but for ranged attacks.
Att. Melee: The melee attack bonus for this creature with this condition.
Att. Ranged: The ranged attack bonus for this creature with this condition.
Save Bonuses: These stack.
Ability Bonus: Applies to ability checks only. Stacks.
Mod. Ability Score: Modifier to each ability score. Stacks.
New Ability Score: The score indicated here replaces the previous score. Modifiers to
ability scores from other conditions are ignored. A value of –1 means keep the previous
score. Never apply two conditions that give different values for “New [Abil]” because the
one applied will be chosen basically at random.
Skill Bonus: Bonus to all skill checks
Spec. Skill Bonus: Bonus or penalty that applies to only specific skills (see below).
Spec. Skill Name: Skill list for Spec. Skill Bonus. There can be more than one, separated by
commas. Use '
ARMORCHECK'to mean all skills with an armor check penalty. Use '
CHA'
for example to mean all charisma-based skills.
Detailed Skill: A detailed list of skill bonuses or penalties, of the format: "Spot +1, Listen –
2, Climb +4". Make sure the skills are spelled correctly.
AC Bonuses: There are several different types of AC bonuses that can be applied. Except
for General and Dodge, bonuses within a same type do not stack – only the best one applies.
Bonuses from each different type stack together.
AC Natural Armor: This bonus stacks with regular or magical armor bonuses. It does not
stack, however, with the character’s permanent natural armor bonus as recorded in the
Armor, Shield box of the AC frame in the Combat Statistics Frame. Note that the Armor,
Shield box shows the total of shield, armor and permanent natural armor.
AC Armor: Magical armor bonus to AC. Does not stack with the character’s Armor and
Shield – but it does stack with all natural armor bonuses. For example, Mage Armor and a
breastplate do not stack, but Mage Armor and Barkskin do stack.
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AC General: Use this for any peculiar or unnamed type of AC bonus that does not fit with
the other categories. It thus stacks with all others due to its uniqueness.
Max Dex: Reduces a player'
s dex bonus to AC.
Check Penalty: Reduces certain skills'bonus.
Damage Bonus: Bonus or penalty to all attacks’ damage rolls. Stacks.
Damage Melee: Applies only to melee attacks.
Damage Ranged: Applies only to ranged attacks.
DR and DR Amount: Amount of hp absorbed; and the type of weapon that overcomes the
DR. For example, DR 5/magic is DR "magic" and DR Amount "5".
Resistance Amount: Resistance from an environmental or other kind of damage, in hp of
damage absorbed per round.
Resistance Type: Type of damage the Resistance Amount applies to (like acid, cold, etc.).
Spell Fail.: Spell failure incurred. Spell failure from armor and shield is cumulative, so it is
assumed that spell failure from conditions is cumulative as well (and thus could exceed
100%, but it is clipped to 100%).
Init Modifier: Modifier to initiative rolls.
Temp. hp: Temporary hit points. Can be a dice string like “1d8”. This is ignored for this
version of DM Genie, but is included as a reminder and for future compatibility.
Level Loss: Number of negative levels gained (so the number is positive). This is ignored
for this version of DM Genie, but is included as a reminder and for future compatibility.
Save vs. Fear: Bonus to all saves that apply only when avoiding a fear-type effect.
Notes: These are various notes that the DM should know when the condition is active. This
can explain additional effects that are not calculated, or specific circumstances in which the
condition does not apply. These are displayed in the Conditions Frame.
Lose Dex: The creature loses its Dex bonus to AC, as well as any dodge bonuses.
Can Act Partial: Can do partial actions.
Can Act Full: Can make full actions or double-move actions.
Only Move: The creature’s only possible action is movement.
Spell, Power and Item Cond: The condition is used for a spell, a psionic power or and
item. General conditions such as prone should not be in any of these categories, even if a
spell can give the condition of prone. This is used by the “Show Spell/Power/Item
Conditions” checkboxes in the Condition Setter and the Conditions Editor.
Locked: This condition is needed internally by DM Genie and cannot be deleted. These
include all the common conditions described in the DMG. You may however change the
effect of a condition, for example you may give a blinded creature a –4 penalty to AC
instead of –2. You cannot change the name of any these conditions. You cannot change the
Locked property of any condition.
Hidden: This condition will not be listed in the Notes column of the combat log, or in the
condition list in the Combat Statistics Frame and the Conditions Frame. However, it will be
displayed in the Condition Setter. This is useful for semi-permanent conditions, which you
don’t need to see in the conditions list all the time.
Replace Abil Only If Higher: If the New Str (dex, etc.) property is set, the old Str score
will be replaced by the new one. However, if this box is checked, the old score will only be
replaced if it results in an improvement (e.g. Divine Power gives 18 str, but if you already
have 20 str you keep 20)
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Conditions Editor
This help topic is Open Game Content, and is licensed for public use under the terms of the Open Gaming License
v1.0a.

The conditions editor allows you to change the effect a condition has on a creature. Click on
a condition in the list at right to select it. If you cannot see the condition you wish to edit, check the
“Show Spell/Power/Item Conditions” checkboxes. To learn how to change a spell or power’s
conditions, see Editing Spells’ and Powers’ Associated Conditions.
The Create New button creates a new, empty condition. You can edit its effects as described
above. You can also create a condition with just a name – this becomes in effect just a reminder that
a spell/power/item is active.
The Delete button deletes the selected condition. You cannot delete locked conditions.

Editing a condition
Starting in version 2.15, the condition editor has been expanded and made much more
powerful.
A condition can have one or more modifiers. A modifier has a certain game effect. See About
Conditions for a description of the game effect of each modifier. Each modifier has 6 fields that can
be filled in. These are represented by each column of the grid:
1. Name: The name of the modifier. The name of the modifier identifies what game effect the
modifier will have. You can define new modifier names – but the names that are used
internally by DM Genie are in RULES.TXT. Any custom names would have to be used in
your own scripting code.
2. Subname: The "subname" is a specialization of the name. For instance, for skill bonuses in
general Name is "Skill", but you need to specify Subname to the name of the skill, like
Listen, Spot, etc... This also applies to DR and energy resistances.
3. Type: the type of the modifier – this can be Luck, Circumstance, Enhancement, etc. or any
of the standard modifier types. You can also define new modifier types – just type in a
different value than those in the combo box.
4. Value: The value of this modifier. For example, a bonus of 2 to strength would be +2 here.
For most modifiers, this should be an integer, but it can also be a single (decimal) number.
You can represent Booleans with 1 for true, and 0 for false. These will always operate as
"OR" operations, that is if a single condition is true, then the result is true (>0) for that
modifier.
5. String: This is an extra string of information that, in this version, has no game effect.
6. Variable: This is a string, and is normally empty.
a. If you specify a string here, then the bonus applied will be taken from a custom
variable (see Scripting – Creature Functions). Custom variables are set with
cr.SetVariable and retrieved with cr.GetVariable. This custom variable must be set
via scripting – so it will normally be a non-zero value only if the condition was set
and the variable set in a feat'
s script code. Unlike the Value field, which is the same
for all creatures, the Variable field allows a condition to have a different effect for
each creature.
b. If the string is a number from 0 to 15, then instead of a named custom variable, one
of the numbered custom variables is used. Those are accessible in scripting via
cr.CustomVar(#), and can also be modified in the Custom tab of the main window.
c. Anything in Value is ignored if a variable is specified (even if the variable has not
been initialized for a particular creature).
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Stacking and types of modifiers
The rules for stacking are described in the DMG and further clarified here:
http://www.wizards.com/default.asp?x=dnd/rg/20040120a . The basics are that when confronted
with two modifiers on the same thing, they can either stack, that is, are added together; or they can
overlap, that is, only the largest one is considered.
•

•

The standard stacking rules are that:
o Modifiers of different types always stack together. So an Enhancement bonus and a
Luck bonus add up together.
o Modifiers of the same type overlap. So if one item gives a +3 Luck bonus to Saves
and another gives a +5 Luck bonus to the same thing, then the highest value (+5)
only is applied.
There are special cases which override the general rule:
o Certain types of modifiers always stack. This includes Dodge and Circumstance. So
any modifier (of any name) with this type will stack with the others.
o Certain modifiers always overlap. This includes values which are not really bonuses
but quantities used in a different way: Miss Chance, Resistance, Spell and Power
Resistance.
o Certain modifiers overlap in reverse – that is, the lowest value becomes the one that
is applied. This usually applies to penalties, like the Max Dex limitation to AC, and
Check Penalty to skills.

These are the default rules. You can customize the exceptions by editing your campaign'
s
RULES.TXT file.

Setting modifiers in Scripting
You can also use scripting to define modifiers that will act just like those in a condition. For
this, you will use the cr. AddModifier command. The fields Name, Subname, Type, Value,
VariableName are as described above. This allows full control on how the bonus will be applied, as
per the rules above.
Sub AddModifier(BonusName As String, ByVal Value As Single, Optional ModType As String, Optional
Subname As String = "", Optional VariableName As String, Optional nSource As String, Optional ExtraString
As String, Optional SemiPermanent As Boolean = False)
' ExtraString: Optional. This is an extra string of information that, in this version, has no game effect.
' nSource: Optional. String indicating what the source of the modifier is. This is set automatically in scripting
to say '
Feat X'
, but can be overriden.
' SemiPermanent:
' Set to TRUE to put the modifier in the '
DM Modifiers'condition - that is, the modifiers that can be
modified on the fly by the user in the '
Condition Modifiers Editor'(Ctrl+F6, see Detailed Modifier Viewer). So
use a call like this:
cr.AddModifier "Att Melee", 2, "Morale",,,,,true
To give a semi-permanent bonus.

Importing/Exporting
To import or export conditions, see the Importing Other Files and the Exporting Other Files
help topics.
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A Note About Backwards Compatibility
Conditions and item'
s magical effect from version 2.14 and earlier use the old condition
system, where except for AC, there was no "type" of bonus and so all bonuses were assumed to
stack. When loading such a condition, it will be automatically converted to the new format, and the
type will be an empty string – that is, an unnamed bonus. So these old conditions will automatically
stack with everything else. You may want to edit the conditions to give the type if you want the
stacking rules to apply to it as well.
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Detailed Modifier Viewer
This detailed view of modifiers is accessible from the "Current Character->Detailed
Information->Condition Modifiers Viewer and Editor" menu, or by pressing Ctrl+F6. It is divided
into two sections:

Viewer of Current Modifiers
This is a list of all the modifiers currently affecting the PC. It is sorted alphabetically by
name and subname. You will be able to see what are the different types of bonuses (and how they
stack); for a single type that does not stack (i.e. anything other than dodge or unnamed types), you
will see only the highest value of all received modifiers. The Source column indicates what feat,
condition, or item is providing this particular modifier. There may be more than one source,
especially if they stack. In parentheses, the contribution of this source to the total is indicated.
This list cannot be edited directly – edit the condition, item or feat in question if needed.

Custom (Semi-Permanent) Modifiers
You will recognize here the interface for setting modifiers to a condition or magic item. It is
functionally identical, except that these modifiers are, in effect, a condition that is never removed,
and that can be different for each individual. You enter modifier names, types and values in the
usual way. If there is any modifier here, you will see the term "DM Modifiers" show up in the short
condition list in the creature list; this reminds you that some values include custom modifiers.
Hint: It is possible to use a feat to add a semi permanent modifier, using the SemiPermanent
parameter of the cr.AddModifier call. See About Conditions and Scripting – Creature Functions for
more details.
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Editing Spells’ and Powers’ Associated Conditions
(Go back to Conditions Editor) This help topic is Open Game Content, and is licensed for public use under the
terms of the Open Gaming License v1.0a.

To change a spell or a psionic power’s list of associated conditions, open the Conditions
Editor (Shift-F8) and click either the “Spell Conditions” or the “Psionic Power Conditions” tab. The
conditions associated with a spell/power will be displayed in the Condition Setter after you click
“Cast Spell” or “Use Power” from the main window.
Select the spell to edit in the list at right. Underneath “Condition Name” you will find a list
of the conditions for that spell. If the first condition is (None), then no conditions are set. Click the
(None) box and select a condition to add it to a list. If you wish to remove a condition, click it’s box
and select (None) – this will remove it and shift the list upwards. Click the “Edit” button to change
the selected condition. Click the “Create New Condition” to add a new, blank condition you can
then edit.
To copy the list of conditions from a spell or a psionic power, click one of the “Copy from
a...” buttons. You will then be prompted to select a spell or power from which to copy, then click
Ok. It is best to create a specific condition for each spell rather than reuse those from other spells
just because they have similar effects. For example, say you create a spell called Minor Cat’s Grace
that gives +2 Str. You are better off creating a condition called Minor Cat’s Grace rather than using
the Cat’s Grace +2 condition. This makes it easier to remember what spell was cast, and simplifies
exporting spells (see Exporting Other Files).
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New Creature Screen
This help topic is Open Game Content, and is licensed for public use under the terms of the Open Gaming License
v1.0a.

This window allows you to quickly and easily generate new creatures, whether PCs, NPCs
or monsters. See:
New Creature: PC or NPC
New Creature: Monster
New Creature: Import Stat Block
New Creature: Other Sources
Another way to add a creature is to import it from someone else who has DM Genie. It is the
fastest way to get a very detailed creature. See Importing a Creature for more details.
You should know the terminology used in DM Genie: in 3rd edition rules, a race is basically
a typical creature – a template from which each creature is made. You can create a PC or a monster
from basically any race. For example, '
Goblins'is a general type of monster - thus '
Goblin'is a race.
But if you create one goblin and call him '
Zorg'
, then that is a creature. Try to keep the difference in
mind while you read the manual and use the program.

Adding Creature to Group...
Select which group to add the next creature to. If you choose “All Creatures”, then the
creature will not be a member of a specific group, although you can move it later to a group of your
choice. (This is not visible in Player Genie)

Edit Latest Creature
The creature that was last created is select in the main window and is opened for manual
editing of its characteristics. See the Creature Tab Strip and the Actions Tab Strip for more
information about editing a creature'
s characteristics.

Close
Closes the window without creating the creature described.
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New Creature: PC or NPC
(Go back to New Creature Screen) This help topic is Open Game Content, and is licensed for public use under
the terms of the Open Gaming License v1.0a.

This frame allows you to select your character'
s race, and roll its ability points.

List of Races
All the races listed here can be edited with the Race Editor. Check the PC Races Only box
to only show the standard PC Races. It is best to create a PC from one of the standard races to
ensure correct skill totals, etc.

Edit Races
This button opens the Race Editor, with the currently selected race open. You can then edit
the race before creating the creature. If you change the race’s ability scores, hit points or hit die,
click on the race in the list of races again to update the New Creature window.

Character'
s Name
Enter the desired name for the character. If the name of the character ends with a number,
like “Skeleton 1”, the name changes automatically to the next number (“Skeleton 2”) whenever you
add a character, allowing you to add several identical characters with different names by simply
pressing Ctrl+D repeatedly.

Generating Ability Scores
-

In the Ability Scores frame you have five columns for each of the six ability scores:
Final: The final ability score your new PC or NPC will have.
(mod): The ability modifier that corresponds to the final score.
Rolled: The value you rolled (or chose, in the case of the Point Buy system) for this score
(see below).
Race: The racial adjustment to the ability score. This is the race'
s standard ability score
minus 10.
User: Enter any modifications to the total score, either positive or negative.

Rolling Ability Scores
First, choose what Roll Method you will use to roll the scores: straight 3d6; best 3d6 of
4d6; best 3d6 of 5d6; or one of the Point Buy methods. Click the Roll button to roll the scores. Each
line in the right-most Rolled column holds the rolled value. For each score, select what ability will
get that score by choosing in the Assign to drop-down list. As you make your selection lines from
the score to the assigned ability graphically display your choice.
Point Buy: Instead of rolling you can manually assign the scores. As they change the total
point value is reflected in a text box below. The maximum point value depends on the method
chosen.

Hit Points
For PC'
s you do not need to change the value here because the hp value will depend on the
class you choose.

Levels
This frame gives the equivalent level for the selected race. Keep the "Add a class to this
character" box checked if you want to give a class to the PC/NPC
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Creating the PC
Click the "Add PC or NPC" to create the PC based on the ability scores you'
ve selected.
This then opens the PC Leveling Wizard to give a class and levels to the PC.

97

New Creature: Monster
(Go back to New Creature Screen) This help topic is Open Game Content, and is licensed for public use under
the terms of the Open Gaming License v1.0a.

To create a monster you won'
t need to roll ability score

Choose a Race
Click on the type of monster you want in the list at left. When you select a race you will see
it'
s stat block displayed on the right.

Filter by CR

DM Genie has a large number of races available, and if your PCs are 1st level, you may not
want to pit them against a great wyrm. With this, you can select what races to display by entering
the minimum and maximum challenge rating of the creatures you want to show on the list. Check
the “Filter by CR” box to filter the list. Uncheck it to show all races. If you are looking for a
specific CR, say 3, enter the same number in both boxes.

Other Filters
You can search for a piece of text in the races'Type/Size string, or the races'Terrain string.
Check the box to activate the filter.
To view only the races that are typically used for Player Characters, check the '
PC Races
Only'box. You do not need to make any adjustments to the PCs created using PC Races before
using the PC Leveling Wizard.

Creature’s Name
Enter the desired name for the creature. If the name of the creature ends with a number, like
“Skeleton 1”, the name changes automatically to the next number (“Skeleton 2”) whenever you add
a creature, allowing you to add several identical creatures with different names by simply pressing
Ctrl+D repeatedly.

Hit Points
Enter the number of hit points, or click the "Roll from hit dice" to roll it.

Creating the monster
Click the "Add Monster" button to create the monster and add it to the selected group.
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New Creature: Import Stat Block
(Go back to New Creature Screen) This help topic is Open Game Content, and is licensed for public use under
the terms of the Open Gaming License v1.0a.

Creating a creature this way is very simple: simply type in the information, or copy and
paste a stat block from any electronic file – for example, from an adventure in .PDF format. Click
the “Add Creature” button to generate a creature using the stat block provided. You can also make
more than one creature at once – see below for details.
As you enter the stat block above you will see a copy of the stat block below. This holds the
stat block of the creature DM Genie read. You can use this to ensure that the stat block was read
correctly.
DM Genie is flexible in reading stat blocks, but to ensure that the creature is created
properly, use the same format of stat block as described in the DMG. A small difference is that it is
best if the creature’s name and race should be separated by a semi-colon rather than a comma, but
not obligatory. For example, “Phillip, King of England; male human” will be easier for the
computer to read than “Phillip, King of England, male human” (which looks like “King of England,
male human” is the race). Both “Dragon, Red, Great wyrm” and “Great wyrm red dragon” are
recognized as the same race.
The “Name; Race Cls1/Cls2” string must be followed by a colon, and then the rest of the
stats such as challenge rating, etc. The import function can also use the format defined by the d20
Standard Stat Block Foundation. You can get more info about this stat block format at
http://www.d20statblock.org/.
Avoid spelling mistakes, especially in the race name and headers (like Spd, Size, etc.).
Unknown headers will be ignored. The function that reads the block of text and extracts the
information is able to handle varied and incomplete input – so you may omit any piece of
information you wish (except the name). If you do not type something in, ability scores for example,
DM Genie will automatically set them to the default value for the race. You may also enter the
information in any order (after the ‘Name; Race:’ string). You must, however, keep the basic stats
in one paragraph, followed by the enter key before entering the more detailed data such as
languages and spells.
Commas should separate the items in the list of equipment. When reading an item from the
list, DM Genie tries to find that item in the list of the standard items, and copies the standard item’s
data (description, magic properties, etc.) if it finds it. If not, just the name of the item will be set.
Add a "(12 gp, 3 lb)" after the item’s name to also set the weight and price of the item. To change or
create standard items, use the Items Editor.
For spell lists using spells with NPC names (like Oti’s Freezing Sphere), see Note: Spells
With Names of NPCs.
A note about AC: If the stat block has an AC string like this: "AC 15 (12 touch)", DM
Genie will assume that the +3 armor bonus comes from permanent natural armor. If it comes from
worn armor, first remove the natural armor bonus by clearing the "Armor, Natural" box in the
Combat Statistics Frame. Then, add and equip the armor and shields the creature is using in the
Items Frame. The final touch AC should be the same as specified by the stat block.
Here are some examples of perfectly valid stat blocks.

Short and Sweet
Beholder: hp 75.
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Simplified NPC
Vladimir; Human Ftr1/Clr1: CR 2; hp 12; Init +1; Spd 30 ft.; AC 15 (12 Touch);
BAB +2; Atk: +4 melee (1d8 + 2, Morningstar), +3 ranged (1d6 - 1, Javelin); AL NE;
SV Fort +2, Ref +1, Will +2; Str 15, Dex 13, Con 11, Int 10, Wis 15, Cha 8.

Disordered but Valid
Vladimir; Human Ftr1/Clr1: Str 15, Dex 13, Con 11, Int 10, Wis 15, Cha 8; hp 12;
Init +1; Spd 30 ft.; AL NE; BAB +2; Atk: +4 melee (1d8 + 2, Morningstar), +3 ranged
(1d6 - 1, Javelin); SV Fort +2, Ref +1, Will +2; CR 2; AC 15 (12 Touch).

Jamis Buck’s NPC Generator output
Hroald, male human Sor6: CR 6; Size M (5 ft., 7 in. tall); HD 6d4+12; hp 35; Init +2
(+2 Dex); Spd 30 ft.; AC 12 (+2 Dex); Attack +4 melee, or +5 ranged; SV Fort +4,
Ref +4, Will +5; AL CE; Str 13, Dex 15, Con 14, Int 14, Wis 11, Cha 17.
Languages Spoken: Common, Goblin, Sylvan.
Skill points: Sor 45
Skills and feats: Alchemy +11, Craft +11, Hide +2, Innuendo +0.5, Knowledge
(arcana) +3, Knowledge (religion) +4, Listen +0, Move silently +2, Profession +8,
Scry +11, Spot +0, Use rope +4; Craft wand, Heighten spell, Scribe scroll, Spell
penetration.
Possessions: 5,600 gp in gear.
Sorcerer Spells Known (6/7/6/4): 0th -- Dancing Lights, Detect Magic, Ghost Sound,
Light, Mage Hand, Open/Close, Read Magic. 1st -- Change Self, Feather Fall, Magic
Missile, Sleep. 2nd -- Blindness/Deafness, Obscure Object. 3rd -- Lightning Bolt.

Complete PC or NPC
Vladimir; Human Ftr1/Clr1: CR 2; ECL 2; Size M; HD 2; hp 12; Init +1; Spd 30 ft.;
AC 15 (12 Touch); BAB +2; Atk: +4 melee (1d8 + 2, Morningstar), +3 ranged (1d6 1, Javelin); AL NE; SV Fort +2, Ref +1, Will +2; Str 15, Dex 13, Con 11, Int 10, Wis
15, Cha 8.
Languages spoken: Common, Dwarven
Skills and Feats: Hide +6, Listen +5, Move Silently +4, Spot +5; Alertness, Weapon
Focus.
Clr Spells Per Day: 4/2.
Spells Known: Bane, Bless, Bless Water, Cause Fear, Command, Comprehend
Languages, Create Water, Cure Light Wounds, Cure Minor Wounds, Curse Water,
Deathwatch, Detect Chaos, Detect Evil, Detect Good, Detect Law, Detect Magic,
Detect Poison, Detect Undead, Divine Favor, Doom, Endure Elements, Entropic
Shield, Guidance, Inflict Light Wounds, Inflict Minor Wounds, Invisibility to Undead,
Light, Magic Stone, Magic Weapon, Mending, Obscuring Mist, Protection from
Chaos, Protection from Evil, Protection from Good, Protection from Law, Purify Food
and Drink, Random Action, Read Magic, Remove Fear, Resistance, Sanctuary, Shield
of Faith, Summon Monster I, Virtue.
Possessions: 105 gp, Firewood (.01 gp, 20 lb), Hammer (.5 gp, 2 lb), Tent (10 gp, 20
lb).

100

Multiple Creatures
You may enter a list of stat block separated by at least 4 dashes (----) followed by a carriage
return (press the Enter key). Each stat block will be used for a new creature. For example:
Markif; male half-elf Ftr3/Clr3: CR 6; .....
---Julia; female human Wiz8: CR 8; hp ...
----Dragon, Black (Very Young).
will create 3 different creatures.
Another method is to put a number in parentheses after the name of the creatures. You can
then specify hit points for each creature, or the same hit points for all creatures. Note: Keep the
name of the race in singular form, or the computer will not recognize it. For example:
Goblin (3): hp 5, 4, 2.
creates 3 goblins (Goblin 1, Goblin 2, Goblin 3), all identical except for their hit points, which
are 5, 4 and 2 respectively.
Elves (4): hp 10.
will not work because “Elves” is plural, and the computer will only recognize “Elf” as the
name of a race.
You can also specify a dice string for the number of creatures. For instance:
Elf (1d6): hp 10.
would create 1 to 6 elves, each with 10 hit points.
You can also specify a dice for the hit points:
Elf (5): hp 1d8+3.
will make 5 elves with hit points ranging from 4 to 11.
"hp".

You can have the hp rolled according to the hit dice string by putting "RANDOM" after
Orc (5): hp random.

will make 5 orcs, and roll the orc'
s hit dice (1d8+1) for each hp.
You can combine all of these techniques:
Orc (2d6): hp random, 1d4, 5, 6.
will create 2d6 orcs. The first one will get 1d8+1 hp; the second will get 1d4 hp only. The third will
get 5 hp, the fourth 6 hp. Finally, all the remaining creatures will use the first entry – "random" – so
they will get hp according to the HD string. Phew!
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above:

You can specify more details than just hp but you don'
t need to put everything as seen
Merchant (4); Human Com3: CR 3; hp 18, 15, 19, 19; AC 17 (+2 Dex, +5 Breastplate); Atk
+4 melee (1d8+2, Long Sword); Str 15, Dex 14, Con 11, Int 10, Wis 6, Cha 15.

creates 4 human fighters (Merchant 1, ...) with the stats shown.
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New Creature: Other Sources
(Go back to New Creature Screen) This help topic is Open Game Content, and is licensed for public use under
the terms of the Open Gaming License v1.0a.

As of this version this frame holds only the "Create a Blank Creature" button that will
make a completely empty creature (10 in all ability scores, no attacks, etc.). In future versions this
frame will also hold the interface for importing from other programs, etc.
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Appraisals Window
This help topic is Open Game Content, and is licensed for public use under the terms of the Open Gaming License
v1.0a.

The Appraisals Window is designed to save time when your PCs go to the market to sell
their newfound treasures. You can add items to the list from the Items Frame in the main window,
or from the Adventure Items, as well as from within this window.

Items'Appraise Check DCs
This allows you to set a default DC when rolling an Appraise skill check for items
depending on their type (magical, psionic or mundane). Note that when rolling to evaluate the value
of a particular item, it is assumed to be “Exotic” if its DC is 15 or more – this means that it will be
more difficult to appraise. Click the “Set” button to set the DC for all items.

Seller and Buyer’s Bonuses
Set the bonus for the “Appraise” skill for the seller and the buyer. Check the trained box if
the character has ranks in the skill.

Adding Items
There are two lists:
Type of items: Select the type of items to display in the list underneath.
List of items to add: Displays all the items of the specified type.
Add button: Adds the selected item to the list of items to appraise.

List of Items
For each item, the name, weight, value, DC to appraise, as well as who found the item is
indicated. Click on a cell to edit the value.
When you click “Roll Appraise Checks”, both the seller and the buyer roll every item for
appraisal. The success of each roll is indicated. The value that the seller and buyer believe the item
to be worth is calculated randomly using the rules in PHB. Exotic items (DC of 15 or more) are
more difficult to appraise and the value varies more. A ? indicates that the seller or buyer cannot
give an estimate of the value – he has no idea what the value is. Once you have the values, it is time
to role-play the sale – tell the player what he believes the value of the item is, without telling him or
her what the buyer thinks it’s worth.
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Dice Roller
This little utility can be used to roll any dice you wish.

Custom Rolls
Enter in the text boxes what dice to roll, and any modifiers. Use the format “#d# + #”. For
example, “2d6+3” rolls 6-sided die twice, adds 3 and returns the number. Click the Roll button to
make the roll.

Standard Dice
On the right are simple dice, which are rolled once when you click on the button.

Always on Top
Check this to make the window stay always on top of the other windows.

Roll Again
Makes the last clicked roll again, with the same dice and modifiers.
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Campaign Manager
(Feature not available in Player Genie)
A campaign is like an entire world – continents and towns, rulers, monsters and townsfolk,
intrigue and adventure. For DM Genie, a campaign is a set of rules, custom items and adventures.
Each campaign you create is independent from any other, and so it is useful to create a campaign for
each gaming world you use. If you are the DM for two games set in the same world, it can be useful
to separate them into two campaigns as well.
The campaign manager is where you can create a set of adventures and use them during play
(see Writing Adventures). This is also where you can create new campaigns (see Creating a
Campaign).
To navigate between adventures you can click on the tree at left or use Adventure
Hyperlinks. The “Back” and “Forward” buttons work just like in Internet Explorer. Alt+Left Arrow
and Alt+Right Arrow also work the same way.
You can also skip to one of the adventure tabs:
Adventure Description
Adventure Items
Adventure Creatures
Random Encounters
Adventure Map
Adventure Campaign Notes
You can use the Searching Adventures for Text function (in the Adventure menu and the
button above the adventure tree) to find specific text in your adventures'descriptions, notes,
creatures, random encounters and/or items.
To output your adventures to a RTF file, see Printing an Adventure.
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Adventure Hyperlinks
(Go back to Campaign Manager)
Every description or note in an adventure can include hyperlinks. These work much like
links on a web site – except that they link to another adventure in your campaign. Hyperlinks have
the following format: {Adventure Name@Optional Tab}. The curly brackets {} mark it as a
hyperlink – so avoid using them in the rest of the text.
When you click on a hyperlink, DM Genie searches for another adventure whose name is
the same as between the brackets (the search is not case sensitive). If two adventures have the same
name, the computer may get confused and pick the wrong one. DM Genie starts with the adventures
that have the same parent – for example, if you have two parent adventures, “Evil Temple” and
“Wizards’ Tower”, and each have a sub-adventure called “Room 1”, a link to {Room 1} from
within Evil Temple will stay in Evil Temple. It is thus important to keep adventure names unique, at
least within the children of each root adventure, and preferably for all adventures. Hyperlinks are
also used in hotspots on the Adventure Map .

Creating Hyperlinks
The easiest way to create a hyperlink is to drag an adventure from the adventure tree and
drop it in the text. This automatically creates a link like {Room 24}. When clicked, this link will
take you to the description tab of Room 24.
You can also create a link to a specific tab. Right-click an adventure on the adventure tree
and drag it to the text box. You may then select from a list of tabs to link to:
- Description: {Room 24}.
- Items: {Room 24@Items}.
- Creatures: {Room 24@Creatures}.
- Random Encounters: {Room 24@Random}.
- Map: {Room 24@Map}.
- Notes: {Room 24@Notes}.
@

When you click on one of these links, you will be taken directly to the tab indicated after the

Manual Hyperlinks
You can create a hyperlink manually, if you wish. Simply type the adventure’s name in
curly brackets. Add a @ and the name of tab after the adventure’s name if you wish. The names are
not case-sensitive. For example, {ROOM 24@map} will work. You can also put in blue and
underline it – simply select the link and press Ctrl+L and Ctrl+U. This is not necessary however,
but it helps in recognizing links as such.

Links to the Internet
You can link to a webpage by entering the full URL between curly brackets. For example,
{http://www.dmgenie.com} . For clarity, it is best to make the text underlined and blue. The
HTTP:// is required. Clicking on the link opens the default web browser at that location.

107

Searching Adventures for Text
(Go back to Campaign Manager)
The Search Text window is useful in locating a specific piece of information from a large
campaign with numerous adventures. Enter the text to search for in the “Find What” text box.
Check the “Case Sensitive” box if you want to return only results where the case is identical. The
“Search In...” checkboxes allow you to limit your search to specific elements. Click “Find Next”
and DM Genie will highlight the next place the text is found. Whenever you change the text in
“Find What”, the search will restart from the beginning.

Adventures to Search
The adventure you selected when you opened the Search Text window is the first adventure
that will be searched. What other adventures will be searched depends on your selection in the list
box:
- This adventure: Only the selected adventure (it’s name is written beneath the list box).
- All below...: The selected adventure and all child adventures below it in the adventure tree.
The search begins with all the first children, then the children of children, etc.
- Entire Campaign: Every adventure in the campaign is searched.

Searching the Adventures
DM Genie will search the full text of each adventure, the campaign notes, and the
description of each item.

Searching Creatures
You may search for a creature’s name, for some text in a creature’s description or for both.
If the text is found in a description, (which is not visible from the Campaign Manager), DM Genie
will warn you. Double-click the creature to open it in the main window, where you can read the
description.
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Writing Adventures
(Go back to Campaign Manager) (Feature not available in Player Genie)
With DM Genie, you can put an entire adventure – in fact, an entire campaign – in an
electronic format that is fully incorporated with the rest of the program. You can either create the
adventure from scratch, or convert a module you bought. It is even easier if you purchase a .PDF
adventure from the Internet, since you can copy/paste the text directly into DM Genie. Warning: do
not copy or distribute an adventure if that would be a copyright violation. See Exporting an
Adventure for help on creating DM Genie-readable adventure files.
In DM Genie, the term “adventure” means a single page of description, creatures and items.
For example, a trek through a dungeon to kill a dragon is, as a whole, an adventure, but you can
make a page for “The Dragon’s Lair” and for “Trap-Filled Hallway”. Each of these separate pages
is referred to as an “adventure”.

The Adventure Tree
The adventures are organized as a tree, which is very similar to directories on a hard drive.
A root or parent adventure (e.g. The Goblin’s Dungeon) can have several child adventures within it
(e.g. Entrance Room, Evil Altar Room, and Deep Tunnel). Each child can have children as well. For
example, you could make a parent adventure for each level of a dungeon, and child adventures for
each room on each level. Click on the “+” to expand an adventure. Press the “*” key to expand all
the adventures below it.
You can move adventures around the tree by clicking one and dragging the mouse to its new
location, and then releasing the mouse button. You can put an adventure at the top of its parent’s
children by dragging it onto its parent.

Adding/Deleting Adventures
Select an adventure in the Adventure Tree. Two buttons allow you to create new adventure.
The first one will create a child of the selected adventure (one level below). The second one will
create an adventure next to the selected one (on the same level). You can then set the name of the
adventure. To ensure that Adventure Hyperlinks work properly, keep all adventure names unique.
Click the “Delete” button to remove an adventure. If a group is associated with it, you will
be asked whether or not to delete it. Map/Picture files are not deleted.

Adventure Tabs
Each adventure can have a description, a group of monsters, a set of items (usually treasure),
a map or picture, a random encounter table and some campaign notes. Select one of the following
items to learn more.
Adventure Description
Adventure Items
Adventure Creatures
Random Encounters
Adventure Map
Adventure Campaign Notes
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Adventure Description
(Go back to Campaign Manager)
At the top of the Campaign Manager a text box allows you to set the name of your
adventure. It’s a good idea to keep this name simple – if you have a map with numbered rooms, the
name “Room 24” will be easier to use than “Square Room With Black Pudding”. To ensure that
Adventure Hyperlinks work properly, keep all adventure names unique.
In the Description frame, you find two text boxes: the short description and the full
description boxes. The short description holds a one-line summary of the room or adventure. The
full description should contain the physical appearance of the room, the description of any traps or
secret doors. You can also include text that is meant to be spoken to the players. In printed modules
this is usually in a shaded box, but the rich text box doesn’t allow shading, so you may want to use
a different color, or underline it, or put it in bold. See the Word Processor Commands to learn more
about changing the text’s font properties. As with nearly all text in an adventure, you can include
Adventure Hyperlinks.
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Adventure Items
(Go back to Campaign Manager)
Here you can put a list of items your characters can find during this adventure. This could be
a monster’s treasure, or an item hidden in the room, or something a NPC will give to the PCs. See
also the Items Popup Menu.

Coins as Treasure
You can set a number of each type of coins the PC may find in the current room or part of
the adventure. The “Share Between” button makes a calculation to automatically come up with a
fair way to divide coins equally between any number of people. In some cases, someone may have
to take coins out of their own supply in order to get a more even amount – this is indicated with a
negative number (e.g. “-2 gp” means that character must take 2 of his gp, put them with the other
gold pieces to share with the remaining characters). Any pieces that could not be divided are also
indicated (usually 1 cp or none).

Adding Items
To add items to the list, click on the first dropdown list box and select the type of item.
When you select a type, only items that match it will be displayed in the second list box underneath
it. You can select “All Items” or “All Magical Items” if you are unsure of the exact type. Then,
select the item to add from the list. As you move from item to item, the description of the selected
item is displayed in the textbox below, although you cannot edit it until you add it to the list, by
clicking the “Add” button.
The "Read Item String" button reads a comma-separated string of items, much like those
accepted by the Stat Block importer (see New Creature: Import Stat Block).

Editing Items
You can view and edit each item'
s description in the box at the bottom. To edit other
characteristics, right-click the item and select Edit.

Dragging and Dropping
As with other items in the program, you can drag/drop items from the adventure to other
inventory lists (in the Main Window or Treasure Window) or to characters in the Main Window'
s
Creature List.

Appraising Items
When the PCs return to the village, loaded with goodies, they might want to sell some of
them for extra cash. The Appraise buttons add the items from the list to the Appraisals Window.
You can add either all items, or only those found by someone. You can add items for only this
adventure, or for this one and all below it. See the Appraisals Window for more details on rolling
appraisals.
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Items Popup Menu
Right-click an object from the list in the Items tab from the Campaign Manager to display
this menu. You can also edit the items with the Items Editor. The menu is nearly identical to that
displayed in the Main Window'
s Items Pop-up Menu.

Giving Items to Creatures
Your PCs bravely fight the dragon and now can haul the treasure home. Right-click on each
item and select “Give Item To”, then click on the PC who takes that item. It will be added to his list
(see the Items List), and a note in the “Found By” column will remind you of who got what. This is
most useful for magic items that are not yet identified – you will need to keep track of their effects
for the PC.
If you want to give the item to someone other than a PC, select him/her in the Main Window
first. Then, when you right-click the item in the Campaign Manager, the first name will be that of
the selected creatures – allowing you to give items to anyone.
From this menu you can also put items in the Random Treasure window.

Mundane/Magical/Psionic Item
Select the correct menu to set the item as magical, psionic or mundane (neither psionic nor
magical). The color of the item in the list will adjust accordingly.
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Adventure Creatures
(Go back to Campaign Manager) This help topic is Open Game Content, and is licensed for public use under the
terms of the Open Gaming License v1.0a.

This is the meat and drink of many adventures – nasty monsters to kill! Each adventure can
have a group of creatures associated with it. You can create the group in the Group Manager or right
in this frame (“Create New” button). Your group can have any name you want, but something like
“Room 24 Goblins” will make it easier to remember where that group should be.
From this frame, you can open the New Creature Screen to add new creatures, or delete or
remove creatures with the “Delete/Remove Selected” buttons.

Quick-Start Combat
This button is a time saver – click it and instantly the creatures in the group are added to the
“Current Encounter” group, as are the PCs. Initiative is rolled for everyone. You can then either
input the PC’s initiative rolls or start combat immediately. See Steps for Running a Battle for more
info.

Encounter Difficulty
The Encounter Level for the current group is calculated from the challenge ratings of each
creature in it. The mathematical formula used reproduces the table in the DMG, but can calculate
the encounter level even for multiple creatures with many different CR. Be warned that mixing very
different CRs can reduce the accuracy of the calculation. See below for more details.
The Average Party Level is the sum of all levels for all PCs divided by the number of PCs.
The “Challenging” encounter level takes into account the number of PCs. An adventuring
party of 4 will have balanced encounters with creatures whose EL is the same as the average party
level. If the adventuring party has 8 PCs in it, and EL higher by 2 is needed for it to be a challenge.
The difficulty of the encounter (Challenging, Overwhelming, etc.) is displayed at the bottom
of the frame.

Experience Points
This frame helps hand out XP when your PCs defeat the monsters. The first box calculates
the total XP for all creatures in the group, based on CR and average party level (for the original 3rd
edition) or based on each PC'
s level and the CR of each monster (for revision 3.5). You can adjust
this up or down by a certain percentage, and you can add or remove a straight amount of XP for
special circumstances, or as story awards.
Award button: click this to give the amount of XP in the “XP per PC” box to every PC.
Warning label: if your monster’s CR is unbalanced with the PC’s level (CR is different by
more than 7), a warning tells you that one or several of the monsters are either too strong or too
weak to calculate XP conventionally (there is no entry on the XP tables). Use ad-hoc awards in
these cases.
To change the XP table: edit the XP.TXT file in DM Genie’s program path. The lines that
start with a * are the header of the party level. The next 20 lines are XP for a CR from 1 to 20. Do
not add or remove any line. DM Genie must be restarted for the changes to have an effect.

Encounter Level Calculation
ways:

Calculating the encounter level is difficult because challenge ratings operate in two different

Above 1, the CR is exponential – a CR 2 higher is a creature twice as difficult. So putting
two CR 3 creatures together gives EL 5. Four creatures give EL 7 and so on. The formula used for
these is EL = Logarithm (base 1.4142) of the sum of ( 1.4142 ^ CR ).
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Below 1, the CR is linear – just adding the CRs gives the total CR. So ten CR 0.1 creatures
is a EL 1.
For creatures below CR 1 and above CR 1 in the same group, the program counts the sum of
the CR < 1 creatures together as a single creature with CR 1.5, for example. It is then calculated
with the formula above.
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Random Encounters
(Go back to Campaign Manager) This help topic is Open Game Content, and is licensed for public use under the
terms of the Open Gaming License v1.0a.

The DMG describes how to create a random encounter table – in this frame, you can enter
the entire table or create your own and instantly roll and generate an encounter. See Rolling a
Random Encounter.

Adding Entries to the Table
-

Click the “Add Row” to add a row to the grid. Each row has several columns
Chance: The relative chance of rolling this random encounter. This is a single number – if
you are converting a table that says “11-15”, enter 5. The value of the dice rolled is the total
of the chance column. It does not need to add up to 100 – any number above 0 is all right.
Friend: An “X” in this box signifies that the creatures are friendly – or at least, won’t attack
the PCs. Click to toggle.
Creature Race: Click on this to select the race to edit in the frame below (see Stat Block for
Row#, Race# below).

There can be up to 4 different races for each row of the encounter table. There is no limit to the
number of creatures from each race.

Stat Block for Row #, Race #
Click on the correct row and column of the table above to select the race to edit. This is the
description of this part of the encounter. Many times, only the first column is used – for example, an
encounter might be 1 dragon, or 1d6+1 kobolds. However, if there are two types of monsters, use
the first and second column – for example, a level 10 NPC fighter and his 1d4 level 3 henchmen.
- Stat Block: The large text box holds the stat block for this part of the encounter. This can be
either a complete stat block or just a really simple line such as just the name of the race
(“Goblin” or “Great Wyrm Red Dragon”). See New Creature: Import Stat Block to learn
how to write a valid stat block. Note however than only one stat block may be entered. Do
not forget to set the Number box.
- Other uses of the stat block: You don'
t have to put a real creature in an entry of the random
encounter table - you type in a meteorological event (like '
Windstorm'
), a special effect (like
'
A random magical item malfunctions'
), something impeding the PC'
s progress (like '
The
road is blocked by a fallen tree'
), or anything else you may desire. If this comes up when
rolling the random encounter, click “Cancel” to stop (DM Genie does create a creature
named “Windstorm” for example, but all its stats are empty because that is not a valid race).
Make sure to set the Number to one or more or else the event will not come up.
- List of Races: The dropdown list box gives you all the races (or the filtered races, see
below).
- Set button: Generate a simple stat block using the selected race only.
- Filter By CR: Much like the New Creature Screen, you can filter the list of races to display
by CR, from a minimum to a maximum value. A level-1 dungeon might use creatures with
CRs from 0 to 1 for example.
- Number: The dice to roll to calculate the number of creatures. Formats accepted are: 1d8+5,
or 1d4, or simply 1. If the HP of the creature is not indicated in the stat block, all HP are
rolled using the creature’s HD.
- Treasure: Enter the percent chance of the creatures carrying treasure. This is used as a
reminder – unless included in the stat block, random encounter creatures do not carry any
inventory.
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Use Table from Higher Level
Check this to use the same random encounter table as the parent adventure. Be warned that
this will overwrite any changes made to your table. When the parent adventure’s random encounter
table is changed, this one follows suit as well.

Notes Textbox
Enter any miscellaneous notes about the encounters in the table, like details of treasure or
magical items some might carry. This is also a good place to note the frequency of checks (e.g.
Once per hour and every time the PCs make noise.)

Rolling a Random Encounter
Click the “Roll a Random Encounter” button. A box tells you what races were rolled and
how many creatures for each race. If you put something else then a race, “Unknown Race: ...”
appears. In addition, the Encounter Level, the Party’s Level and the Challenging Encounter level are
displayed. See Encounter Difficulty for more details.
You can either accept this roll by pressing Yes, or roll again by pressing No, or press
Cancel.

Changing the Number of Creatures
To adjust the difficulty of a random encounter, you can multiply the number of creatures
rolled - from x1/3 to x4. For example, 1d6+1 x ½ will roll 1d3. For multiples of x2 or higher, you
can choose to roll more than once on the table instead of multiplying the number of creatures.
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Adventure Map
(Go back to Campaign Manager)
Most adventures use a map – of the dungeon, the town, the forest... But in the Map frame
you can display any graphics file (.jpg, .gif or .bmp) that you want. So, instead of a map, you could
put the picture of: an interesting NPC, a special puzzle, writing in a strange language, an important
item, etc. During play, you could turn the laptop around and show the players – “This is what the
writing on the door looks like.”
Type in the filename or use the “Browse” button to find it. You can use relative path names:
e.g. just "Maps\MyMap.jpg" will look in your current campaign path + "Maps\MyMap.jpg", for
instance "D:\MyCampaign\Maps\MyMap.jpg". This way you can move campaigns around and still
have valid references to your maps, as long as the directory structure is intact.
You can check the “Use Image from higher level” box to show the same picture as the
parent adventure – for example, “Room 24” could be a child of “Level 2”, and use the same map.
The same hotspots are used as well – this means you only need to define the hotspots for the top
level rather than each adventure.
You can zoom in or out or use the “Fit to Screen” button to view the whole image. Use the
“Edit Picture” to open your default picture editor.
Maps can also have Map Counters (movable pieces).

Hotspots
You can make clickable maps – simply define a '
Hotspot'by clicking in one corner and
dragging a rectangle. You can then link the hotspot to the description of the room it corresponds to.
See Adventure Hyperlinks for more information on creating links. Another method of linking is to
simply drag an adventure from the adventure tree onto the hotspot after its creation. Then, press
enter to link to the description tab or add a @ and the name of the tab.
You can also make oval or round hotspots – just check the “New: Oval” checkbox. To clear
a hotspot, right-click on it and select “Delete Hotspot”. You can also use this menu to change the
hotspot link.
Note: you cannot make new hotspots from an adventure which has the '
Use Image from
Higher Level'box checked. You must go to the parent adventure to change the hotspots. Any other
changes to hotspots (deleting or renaming them) will not stick because they will be replaced by the
parent adventure'
s (unchanged) version.
Move your mouse over one of the hotspots to see what it links to in the box above. Click on
it to open that link.
If you check the “Show Hotspots” box, hotspots are shown as diagonal lines (choose the
color in the Options Dialog). This is most useful when drawing new hotspots (to remember where
the old ones are), but once you’re finished it’s best to stop displaying them to see the map clearly.
Select “Clear All” to delete all the hotspots.
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Map Counters
(Go back to Campaign Manager)
A counter on a map is like a checker on a checkerboard – it is a movable piece that
represents something. In DM Genie, counters can be round or square, have any color or size, and
have labels and descriptions.
All maps have independent counters, even if they use the same map image. You can thus
include only the counters relevant to that part of the adventure. You can also copy the counters from
the parent adventure, if you wish for all the maps to have the same counters.

Moving a Counter
Simply click on the circle or square of the counter, hold down the mouse button and drag the
counter along. Release the button at the new position.

Counters Linked to a Creature/Item
Double-click the counter or click the "View Obj" button to view/edit the item or creature.
Only counters added using "Auto-Add" are linked to a creature or item.

Counter Control
This frame holds commands that affect all counters in a map, as well as commands for
adding counters.
-

-

-

Show Counters: Check the boxes to select what kind of counters to show. Creatures are
either friends or enemies, Items are either magical or not, and Misc is everything else.
Resize w/Zoom: Check this to change the size of the counters to match the zoom of the
image. For example, a counter of size 16 will be 32 pixels wide in a zoom of 200%.
Uncheck it in order to keep the counter size always constant. This way, zooming will still
show the counter, but less of the map will be obscured by it.
Add: Select the type of new counter to add. The new counter will be in the upper left corner
of the map. You will need to drag it to its location.
Auto Add: Will automatically add counters based on other data. All new counters are in the
upper left corner of the map.
o By Group: Select a group: PC'
s Party, Current Encounter, or another group. All the
creatures from that group will be added. The creatures are also linked to the counter
– that is, double-click the counter to open the creature.
o Adventure Items: Adds all the items in this adventure.
o Copy from higher level: Will automatically copy the counters that are in the parent
adventure'
s map. All locations will stay the same. You just have to select the type of
items to copy.
Remove Counters: You can either delete a single counter (the selected counter), or all
counters of a specific type, or all counters.

Counter Editor
First, you must select a counter either by clicking it, or by selecting it in the dropdown box.
-

Delete: Removes the counter.
Short Name: is the name displayed beneath the counter. It is automatically generated from
the long name, but you can edit it.
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-

-

Type: The type of counter. Each counter type has a distinctive color and shape, although
you can override the default. The type of counter is used in removing/copying multiple
counters.
Settings: Opens a menu with these options:
o Rename: Enter the new name for this counter.
o Use Picture: Select a graphics file. That image will be used instead of the square or
circle. Note that the image will not be resized – it will always stay at the same size as
the source image.
o Fill Color, Border Color: The color of the border of the counter, and the fill (inside
the shape).
Size: Size in pixels.
Circle: Check this if the counter is a circle. It is a square otherwise.
View Obj: Opens the linked item or creature, if one is linked to this counter.
Description: Detailed description of the counter. For linked Creatures, this cannot be edited
– it displays a summary of the creature instead. Linked items display the item'
s description,
which cannot be edited from the counter – use the Items Editor or the above
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Adventure Campaign Notes
(Go back to Campaign Manager)
The Campaign Notes frame is used to keep a record of what happened to your players when
they played the adventure. Using it is optional. There are four boxes in which you can take notes:
- Timeline: When did the PC’s get here? When did they leave?
- Secret doors/Traps: What was triggered or discovered (the next time the PCs enter the
room, you can say: “You see the remains of the trapped door you destroyed.”)
- XP awarded: To avoid giving XP twice.
- Other Notes: Anything else you wish to remember.
Each box can have Adventure Hyperlinks and can be edited with the Word Processor
Commands.
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Creating a Campaign
(Go back to Campaign Manager)
The default campaign for DM Genie is called the ‘Core Rules Campaign’. When you first
start the program, this is the campaign you are in. It includes all the skills, feats, spells from the 3
Core Rulebooks, as well as psionics.
It is a good idea to create a new campaign when you start a game, instead of using the Core
Rules Campaign. This is because all new campaigns are created from the Core Rules. If you alter
the core rules by deleting spells for example, you will not be able to restore these spells without reinstalling DM Genie.
To create a campaign, select ‘Create New Campaign’ from the File Menu. You will then be
prompted to enter the name of the campaign. You can also see Importing a Campaign.
To edit the data in your new campaign (like skills, feats, etc.), see the Main Window Menus
under “Customize”.

New Campaigns
Each campaign must have its own directory. Double-click the directory to select it, or click
the “Create New Directory” button to create one if needed. When creating the new campaign, the
data from the Core Rules Campaign is copied there. The two copies are completely separate, so you
may edit the new campaign any way you like, and not affect any other campaign. When creating a
campaign, DM Genie adds a shortcut to the current campaign in your \Start Menu\Programs\DM
Genie\ directory. Click the shortcut to go to your campaign (or use the File->Select menu, see
below). The shortcut does not work with all versions of Windows, however.

Old Campaigns
You may have a campaign directory but DM Genie might not have it in its list – this could
happen if you made a backup of the directory and copied it somewhere else, or if a friend copies his
campaign directory to you. In this case, select “Yes” when prompted whether or not to keep the data
already there. Selecting “No” will overwrite all your campaign data.

Selecting a New Campaign
Use the File->Select Campaign menu to open a different campaign. After creating your
campaign, or when switching from one campaign to another, DM Genie will close immediately.
You must restart the program, and it will load all the separate skills, spells, etc. in that campaign.
To avoid having to start the program, then click select, and then restart again, you can use
the shortcuts generated by DM Genie during campaign creation. They are in your \Start
Menu\Programs\DM Genie\ directory.

Clearing/Editing the Campaign List
If you have created several campaigns but deleted their directories, click this to delete the
list from DM Genie’s file. No files are deleted – just the entries in the list. You can also step
through the list to remove individual entries in the list.
If you removed entries for some active campaigns, don’t worry! None of your campaigns are
deleted! You can add them to the list again by clicking ‘Create New Campaign’ and selecting the
old directory (and telling DM Genie NOT to overwrite the old data).
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Campaign Statistics
The File->Campaign Statistics menu will give you some information about how many items,
creatures, etc. are in your campaign.
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Printing an Adventure
(Feature not available in Player Genie)
Using this feature, you can create a .RTF file for each adventure you have entered in DM
Genie. You can edit and print out the .RTF file using Microsoft Word or Microsoft WordPad
(which is bundled with Windows). You can also send the .RTF file to a friend who does not have
DM Genie.
To print an adventure, select it in the Campaign Manager and select "Adventure->Print
Adventure" menu or right-click the adventure and select the "Print" menu.

Things to Know
-

Adventure Hyperlinks will not work in Word, but they will still be blue and underlined.
If the font used is too small, you can change it in the Options Dialog (Main window'
s File>Options menu).
Keep in mind that you can edit the file if there is an adventure that doesn'
t look the way you
want.
If your descriptions are very long or contain some images, the RTF file generation process
may take a long time or hang the computer.
From Word, you can try making the text into two columns, to look more like published
adventure modules.
You can also use the Character Sheet Output to create ready-to-play PCs or to get more
detailed data from an important NPC.

Quick Settings
Click one of the buttons to use one of the pre-set choices. You can change specific settings
(see below) after you click it. The "Only" buttons have several uses:
- Items Only: Use it to give a list of items a merchant has to sell.
- Creatures only: For easy use during a game without the computer
- Random Encounter only: Because the same table is often used for all the adventures in a
module, it can be useful to keep in an appendix for example.
- Campaign Notes only: To get a printed record of the progress of your players.

General Settings
Selecting both "New Page" and "Horizontal Line" is not recommended, as there will be a
line at the top of each page. Selecting "Remove Brackets" is recommended as it improves the look
of the text.

Adventure Header
It'
s usually not necessary if you display the description (which normally has the name of the
adventure as the first line). It is useful if you'
re displaying a specific part of the data, for example,
just the random encounter table.

Items
Select the amount of detail to show. Note that if you choose to display all descriptions, your
text will be much larger. Layout is not always perfect with some item descriptions. A couple of
options allow you to give more detail for "non-standard" items – those are items that aren'
t part of
the standard items list, and so are most likely only in that particular adventure.
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Random Encounters
A table of the creatures you might meet. The table suggests a dice to roll if the total of
chances (see Random Encounters) is much lower than 100. For example, to roll a number from 1 to
60, it is suggested to roll 1d6, subtract one, multiply by ten and add 1d10 to get the total.

Creatures
The one-paragraph and one-line summaries display only the name, CR and hp of the
creature. You can also display the creature'
s stat block, either in compact form or by choosing what
to display. These are the same options as in the Stat Block Frame.
When checked, the "PCs and NPCs always use the stat block format above." box will
use the format defined instead of the compact stat block or one-line format for any creature with one
or more class levels.

Map
You can choose to add a hyperlink to the map image (if any). You can print the image
separately, using any image-editing program such as paint. The image cannot be included directly in
the .RTF file because its size would quickly get unmanageable.
You can display a list of the counters, and, optionally, their descriptions also. Note that
counters for creatures and items aren'
t listed, since they are already included in the categories
above. This leaves Traps, Locations and Specials.

Campaign Notes
Select which of the campaign notes to add to the text.
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Race Editor
This help topic is Open Game Content, and is licensed for public use under the terms of the Open Gaming License
v1.0a.

First, a bit of the terminology used in DM Genie: in 3rd edition rules, a race is basically a
typical creature – a template from which each creature is made. You can create a PC or a monster
from basically any race. For example, '
Goblins'is a general type of monster - thus '
Goblin'is a race.
But if you create one goblin and call him '
Zorg'
, then that is a creature. Try to keep the difference in
mind while you read the manual and use the program. We decided to use this terminology instead of
“monsters” vs “character” because the line is blurred – is a friendly Kobold a monster or a
character? If you allow a PC to play an orc character, should you call it a monster? But they are
both creatures, one whose race is Kobold, the other Yuan-Ti.
See the New Creature Screen for more information on making creatures. The Race Editor
allows you to edit or create your own races.
Click on one of the following items for more info:
Basic Race Info
Race Attacks Frame
Skills and Misc. Information
Race Description
PC Races
Automatic Race Creation
Note about missing monsters: Some monsters (beholder, gauth, carrion crawler, tanar’ri,
baatezu, displacer beast, githyanki, githzerai, mind flayer, illithid, umber hulk, yuan-ti) are not
included in the DM Genie release because they have not been released by Wizards of the Coast as
Open Game Content. Thus, they cannot be legally redistributed. You can however enter these
monsters'data in the Race Editor for your personal use. Thank you.
If you've created a campaign in versions 1.16 or earlier: Starting from version 1.17, races
are no longer shared between the Core Rules and custom campaigns. When you start your custom
campaign, you will find that you are missing most or all of the races - from the Race Editor use the
"Race->Copy Core Races into Campaign" menu, and you will once again have a copy of the core
races in your custom campaign. This change was made to eliminate the doubled races bug.
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Basic Race Info
(Go back to Race Editor) This help topic is Open Game Content, and is licensed for public use under the terms of
the Open Gaming License v1.0a.
Several textboxes hold information about the race. See the MM (Core Rulebook 3) to learn
more about each item. Here are some specific notes about how to use them in DM Genie:
- Hit Dice: Does not support ½ dice. To indicate ½ d8 for example, use 1d4 instead (this
gives nearly the same result).
- AC: You can note specific contributions in this box – these are ignored. Use the boxes
below.
- Total AC: Normal AC for this race.
- Natural armor: Natural contribution that goes away in touch attacks.
- Shield or Armor: Name and AC bonus of these items (regular bonuses only – enter magical
bonuses as a total is the Misc AC box).
- Misc: Magic, size, etc.
- Base Attack Bonuses: This is an important item that is missing from the MM stats. This
includes the size modifier for the race. The BAB is re-calculated when you use the
“Generate Attacks from Strings” button in the Race Attacks Frame.
- Damage Reduction: Enter the type of weapon damage that bypasses damage reduction, as a
string.
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Race Attacks Frame
(Go back to Race Editor) This help topic is Open Game Content, and is licensed for public use under the terms of
the Open Gaming License v1.0a.
The attacks frame for a race works in nearly the same way as the attack frame for a creature.
Refer to Attacks Frame from the main window for information on each control.

Attack/Damage Strings
These are the attack and damage strings as displayed in the MM. The “Generate Attacks
from Strings” button automatically generates the attacks. There are a few rules to obey though:
- Each attack should be separated by a comma or semi-colon. Do not use commas in the name
of the attack.
- For multiple attacks at the same BAB, start with the number of attacks (2 claws +12).
- For magical weapons, put a +. (+3 greatsword).
- After the name of the attack, use “+6/+1” to give the total attack bonuses.
- Put one item in the damage string for each item in the attack string, and in the same order.
- If an attack deals no damage put a special effect, put 0 and ..., e.g. “tentacles 0 and poison)",
instead of just "tentacles poison" (which will make the program think the name of the attack
is "tentacles poison").

Feats
This is the list of feats the race has. When creating the monster or PC, those feats will be
automatically selected. Be sure to spell them correctly or the computer will not recognize them. You
may also add class/special abilities here, since they work pretty much like feats.
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Skills and Misc. Information
(Go back to Race Editor) This help topic is Open Game Content, and is licensed for public use under the terms of
the Open Gaming License v1.0a.
The first boxes are miscellaneous information about the race. See the MM. The languages
box is not a part of the standard MM stat block but has been extracted from the description for your
convenience.

Skills
Each skill must spelled correctly, then followed by the total skill bonus. When generating a
creature, the skill ranks will be calculated automatically. You do not need to include skills with 0
ranks – their bonuses are calculated automatically. Put the specialization of the skill in parentheses.
If unknown, the computer will select Skill (Other). For a PC race, it is best to keep this empty to
avoid giving ranks at 0 level.
You can also indicate misc. bonuses to skills, for example an elf’s racial bonus to Spot.
Follow the total bonus with a pipe character (|) and the racial bonus. For example, Spot +3|+2 will
give 1 rank (for an ability modifier of 0) and a misc. bonus of 2.

Known Psionic Powers
This is a comma-separated list of psionic powers or combat modes that the race knows.
These will be added to the creature’s list automatically upon creation.

Known Spells or Spell-Like Abilities
This is a comma-separated list of spells that the race knows. These will be added to the
creature’s list automatically upon creation. Spell-like abilities that can be used at will are set as
being memorized 0 times, while abilities limited to a certain number per day are set to that number.
List the “At will” abilities first. The syntax is:
“At will- spell1, spell2; 3/day- spell3, spell4, etc.”
You can thus keep track of how often the monster can use that ability during an encounter
(as long as the encounter lasts less than a day).
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Race Description
(Go back to Race Editor) This help topic is Open Game Content, and is licensed for public use under the terms of
the Open Gaming License v1.0a.
This is simply a rich text box with the description of the creature. You may include any text
you wish, even small images. Use the Word Processor Commands to edit the font sizes and styles.
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PC Races
(Go back to Race Editor) This help topic is Open Game Content, and is licensed for public use under the terms of
the Open Gaming License v1.0a.
-

In this frame you can enter info relating to PC/NPC races, like Human, Gnome, etc.
PC Race: Check this if the race is designed for PCs.
Level Equivalent: Powerful monsters used as PC'
s get this number of levels added to their
actual class levels when calculating XP needed to level up and average party level.
Favored Classes: Just a note about what classes don'
t incur multiclassing XP penalties.
Bonus Skill Points: At first and each level.
Extra Feats: At first level and one every nth level
Psionics: Extra PP at 1st level and at every level after that.
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Automatic Race Creation
(Go back to Race Editor) This help topic is Open Game Content, and is licensed for public use under the terms of
the Open Gaming License v1.0a.

Create from this text
This powerful feature allows you to instantly create a race from a MM statistics block. This
is a standard format, and you can obtain races in this format from various websites. Simply copy
and paste the text into the text box. It even works if the text has up to 3 columns – you must
however ensure that the header column is from characters 0 to 24, the first race column is from 25
to 64, the second from 65 to 104, the third from 105 on. There are no such restrictions when loading
a single race.
You must include each line in the MM stat block in the same order as in the book. Be sure
not to misspell the header or to forget the colon (like Face/Reach:) – unknown headers will cause
the program to think the description has started. You may however skip any line except the name
and type/size line. Everything after the last line will be considered to be part of the description.
You can also load several races one after another. Separate each creature with a “###” at the
beginning of a line, to ensure that the next race isn’t considered to be part of the description of the
previous race.
Warning: while some races are open game content, descriptions often aren’t and you should
check with the author before copying or distributing a race. See Exporting Other Files and
Importing Other Files for instructions on how to share races using DM Genie’s file format.
Import/Export is faster and easier than using this function and saves more data not necessarily
displayed in the MM statistics block.

Make Text from current
You can also create the race using DM Genie and then click this button to get a standard
MM statistics block. Copy and paste this text to another document, like a Word text file or a html
page.
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Roll Window
This help topic is Open Game Content, and is licensed for public use under the terms of the Open Gaming License
v1.0a.

(Feature not available in Player Genie)
The roll window is useful for making many rolls of the same kind for multiple creatures. For
example, you can roll a Reflex save for all the monsters that were hit by a Potion of Fire Breathing,
or you could make a secret spot check for all the PCs, to find out if they see the goblins hiding in
the bushes.

Choosing a Type of Roll
From the main window, select the type of roll to make in the list box under the creature list.
You can choose to roll initiative, saving throws or skill rolls. Click “Make Roll” to put all the
creatures in the current group into the Roll Window. Another way to choose the roll to make is to
use the list box at the top of the Roll Window.

Making Rolls
When the window is first opened, and when the type of roll is changed, a roll is already
made for each creature. You can click “Reroll” to roll again.
For Initiative rolls, clicking “Apply Initiative” will set the initiative for all creatures visible
in the list.

Roll Success/Failure
You can enter a DC for the roll in the text box marked “DC”. The success or failure of each
creature versus this DC is marked in the “Success” column. Successful creatures are in green,
whereas unsuccessful creatures are in red (these colors can be changed in the Options Dialog).
Note that if a creature is untrained in a skill that requires training, its skill bonus is reported
as –99.

Manual Entry
You can enter the players or the monster'
s rolls manually (Click the “Manually” button).
You can enter either just the d20 roll, or the total amount rolled. Click next or press Enter to go to
the next creature. Don'
t enter anything if you do not wish to change the value. You will only be
prompted to enter the creatures that are visible in the list. If you wish to keep the computer-rolled
values for the monsters, uncheck 'Enemies'at right.

Effects of the Rolls
You can apply damage automatically. First, enter an amount of damage in the textbox. You
can also click the dice icon to open the Dice Roller and roll the damage. Then, select the creatures
that were hit by the effect causing the damage. Then click one of the “Apply damages” buttons.
You can apply full damage or half damage to all creatures; or apply full damage to those who failed
the throw, and half damage to those who succeeded; or none to those who succeeded.
Clicking “Done” closes the Roll Window without applying any more damage.

Reporting Rolls
Check the Report in combat log checkbox to have a report of what was rolled added at the
end of the combat log. If the Shorten box is checked, a summary giving who succeeded and who
failed at the roll is given. If Shorten is unchecked, the result and success/failure for each creature is
displayed.
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Timekeeping Window
The Timekeeping Window helps in calculating traveling time and keeping track of the
current date and time, as well as give the current weather.

Current Date and Time
The top line is the current time, in hours, minutes and seconds. The second line is the current
date. A row of buttons beneath the date is used to increment the time or date by the marked
duration: 1 round, 20 rounds, 20 minutes, or 1 week.
Below the Daylight label the position of the sun in the sky is displayed. Night means it is
dark and the sun provides no light. Twilight means the sun is below the horizon but it is near
enough to provide some light. Sunrise/Sunset is when the sun is above the horizon, but still close
to it. Day is when the sun is fairly high in the sky.

Adjust Rounds in Current Encounter When Adding Time
When this box is checked, clicking one of the buttons to add time (1 round, Take 20, 1
hour, etc.) will also add the appropriate number of rounds to all the creatures in '
Current
Encounter'
.
For example, you run a battle for a few rounds, and on round 10 (which is also 10:15 AM),
Marcus casts Barkskin, which ends in 2 hours (round 1210). The battle ends on round 20. The PCs
keep moving in the dungeon, so you add to the current time using the 1 Round or 1 min buttons for
example. As you do so, the round number is adjusted to match (adding 1 minute will add 10 rounds,
1 hour is 600 rounds). Let'
s say that one hour and 57 minutes pass between the end of the first battle
and the beginning of a new one. When you click '
Start Combat'
, Marcus finds that his Barkskin
spell ends in two minutes (20 rounds). If a condition expires while you add time, there will be a line
added in the Combat Log.
The maximum round number possible is 32000, or about 53 hours. If you use the
Timekeeping window to add more than 53 hours, the round number will say "53h+", meaning that it
has been more than 53 hours since the last combat started. Click Start Combat to reset the round #
to 1.
Note: changing time directly in the display above the checkbox (clicking the up/down
arrows or editing the values) will not adjust the rounds. This feature was in versions prior to 2.06
but as it caused bugs was removed and will not be put back.

Events Log
The textbox holds any notes about what happened to the characters during their adventures.
You can use the Word Processor Commands to edit the fonts and also insert Adventure Hyperlinks.
The Add Date, Add Time and Add Weather buttons add, at the current cursor position, the current
date, time and weather conditions respectively.

Custom Calendar and Time
When you first start DM Genie, it uses the normal Earth calendar, but you can customize
both the calendar and time. Use the File->Customize Calendar/Time menu to open the
Calendar.TXT file that is saved in your campaign’s \Data\ directory. Follow the instructions in it to
customize the calendar and time. You must restart DM Genie for the changes to have an effect. You
can:
- Change the number of months, their name and number of days.
- Change the days of the week
- Set the date that winter starts (important for weather, see Weather Generator)
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Set the number of seconds per round, seconds per minute, minutes per hour and hours per
day.
Set the planet’s rotation axis angle (affects the sunrise/sunset times)
Set the moon’s period and name. This is not displayed in this version of DM Genie
Set the winter solstice date.

Current Weather
(Feature not available in Player Genie)
This displays the weather that was generated for the current date and time. Nothing is
displayed if you have not generated weather, or if the date set is before or after the year that was last
generated. To create weather for one year see the Weather Generator.
Report Changes: Check this box if you wish to add a line to the Events Log when the
weather changes because you have incremented the time or date. Only changes in precipitation are
reported, such as: “Light rain starts at 8:00 AM, stops at 10:30 AM”. When increasing the time by a
day or more, the daily weather summary is displayed instead of the hourly changes in weather.
Severe Only: Check this to only report heavy rains, thunderstorms, tornadoes or other
severe weather.
Rules Effect: Descriptive text giving the effect on rules – note that these aren'
t
automatically applied.
See also Movement Speed and Distance Traveled
and Reminders.
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Movement Speed and Distance Traveled
(Go back toTimekeeping Window) This help topic is Open Game Content, and is licensed for public use under
the terms of the Open Gaming License v1.0a.

Entering the Base Speed
Select an item from the Mount/Vehicle dropdown list box to set the speed automatically.
You can also enter it manually, either in feet per round or miles per hour. Note that the official
speeds given in the PHB don’t quite add up (5000 feet per mile / 30 feet per round = 3.6 mph, not 3
mph), so the formula used assumes 6000 feet per mile. This could account for resting, meals, etc...
during cross-country movement.

Movement Mode
This simply multiplies the base movement speed. Not all movement modes are possible for
long distances.

Distance
Enter a distance that your PCs (or the NPCs tracking the PCs) wish to travel, either in feet or
in miles. As you change it, the time needed to travel it is displayed below.

Time to Travel
Enter the number of days, hours, minutes and seconds the PCs will travel. Set the number of
hours per day that will be spent in actual movement (usually 8 or 10 hours). As you change the
time, the distance that can be traveled is displayed above. Press the Add button to add that amount
of time to the current date and time. Press Clear to set it to 0.

Terrain/Road
Select what terrain and what type or road/trail the PCs are traveling on. Their real speed is
adjusted accordingly.

Hampered Movement
Check all the boxes that apply. Each condition reduces the speed by a certain factor, and it is
cumulative. Note that these are normally used for tactical movement (i.e. within combat), and that
the terrain/road speed modifiers already take bad surfaces or obstruction into account.

135

Reminders
You can use the Reminders tab, in the Timekeeping Window, to keep track of events or
long-lasting spells. For example, you can record long-lasting spells; how much time the PC'
s have
until the King'
s guards catch up to them; how long until their light goes out; or anything else you
desire.
If you check the "Popup a warning when a reminder has expired" box, a dialog box
telling you that your reminder has expired will come up, whether you either add time directly in the
timekeeping window, or when the round number of Current Encounter increases, and that causes
time to increase.

Commands
'
Add Reminder'opens a new window where you can enter how much time until the
reminder expires. This can be as little as one second or as much as several years. The Quick-Set
reminders are useful for common events, and can be customized in RULES.TXT
'
Clear Expired‘ removes all expired reminders.
'
Clear All'removes all the reminders.

Pop-Up Menu
Right-click a reminder to view the pop-up menu
'
Edit Reminder'allows you to change the name/expiration of the reminder.
'
Remove Reminder'does just that.
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Weather Generator
(Feature not available in Player Genie)
Use this window to create realistic weather for your campaign. You can generate an infinite
variety of weather for various locations. When you generate weather, it is automatically saved so
that the next time you run DM Genie, the weather will remain consistent. Weather is always
generated for an entire year at a time, starting at the current date.

Principles of Generation
The Weather Generator utilizes a set of algorithms designed to simulate real weather and
real weather systems. First, the average temperature for a type of climate is taken from climate data
of various locations on Earth. This is adjusted for terrain (inland regions have greater daily and
yearly variations of temperature, coastal regions have less). Then, each climate has its specific
weather patterns – which are generated randomly. The frequency and intensity of events is adjusted
for the type of terrain – the coast will be rainier, inland regions will have more variable weather.
Each weather system generates its own type of weather for a certain amount of time. Fronts
are short-period events, while in a monsoon a depression system can remain for many days or even
weeks. Temperature, cloud types, winds and precipitation is determined on an hour-per-hour basis.
Severe weather such as thunderstorms or tornadoes is also generated. The frequency of such events
can be adjusted (see below)

Choosing a Climate and Terrain
If your campaign world is similar to earth, try to draw comparisons to locations you know.
Most of North America is temperate – the center states are inland, while the western states (past the
Rockies) are coastal. The east coast is more average, because the wind blows eastward, so the coast
does not regulate temperature. High hills, average mountains are Mountain, while tall mountains
are High mountain. Rainforests, like in Brazil, and tropical islands are usually Equatorial. Areas
with summer monsoons like India are Tropical (summer monsoon). The Mediterranean is
Subtropical winter rain. Dry and hot areas are Subtropical deserts (like the Sahara). Cold areas
with sparse vegetation, like Siberia, are Subpolar. Finally, the North Pole or Antarctica are High
polar.

Latitude
Enter a latitude that corresponds to the player’s current location. If you do not know, the
value automatically entered when you selected the climate will work fine. This affects the length of
a day. (See the Timekeeping Window).
North/South: If you select south, winter will come in June and July while summer will be
in January. The weather is not affected otherwise.

Weather Adjustment
Change the values in the text boxes. Press “Generate Weather” again to see the changes.
-

Temperature: you can increase or decrease the overall temperature by a certain number of
degrees.
Precipitation: affects the number and intensity of rainy weather systems.
Variability: this modifies the daily and yearly temperature variations.
Severe Weather: thunderstorms, tornadoes, hail and hurricanes will come more frequently
if you increase this number. This is a sure way to add some excitement to a dull ocean
voyage!
Windiness: Simply multiplies the speed of wind by the value specified.
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The time of year at which winter starts is given by the date of the winter solstice. To change it,
edit the CALENDAR.TXT file. See the Timekeeping Window for more information about the
calendar.

Weather Summary Graphic
This shows temperatures (the line is drawn from the daily minimum to the maximum) and
precipitation (red lines) during the year. Click on it to zoom to a day.

Daily Weather
A summary of weather for each day is displayed, including min/max temperatures,
cloudiness, the worst precipitation received during the day and average wind speed. Some days may
receive only light rain for one hour, but that is still what is displayed in the daily weather summary.

Hourly Weather
For each hour of the day, the temperature, cloud cover, precipitation and wind speed are
displayed. The weather system that is affecting the weather is also displayed.

Saving Your Weather
You can save the weather data generated to a .Weather file with the File->Save As menu
item. The File->Save menu item will save to the campaign’s default weather file. You can open an
old weather file with the File->Open menu item. This way, if your PCs travel from one region to
another, you can create 2 weather files and open the correct one depending on the PCs’ current
location.
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Importing and Exporting
This help topic is Open Game Content, and is licensed for public use under the terms of the Open Gaming License
v1.0a.

DM Genie makes it easy to share with your friends. Practically everything in DM Genie can
be exported: campaigns, creatures, groups, adventures, races, skills, feats, spells, psionic powers,
items, weapons and conditions. For example, say that you have written an adventure, complete with
descriptions, maps, enemies and treasure. You can use the Exporting an Adventure function to
create a single file that you can then give to your friends, or sell on the Internet, so that other DMs
can also play your adventure with very little preparation time. Learn more by selecting below what
you wish to export or import:
Exporting a Creature, Importing a Creature
Exporting a Group, Importing a Group
Exporting Other Files, Importing Other Files
Exporting an Adventure, Importing Adventures
Unknowns Found During Import
Exporting a Campaign, Importing a Campaign
Saving Your Weather
In addition to using the File->Import menus of various windows in DM Genie, you can also
simply double click the file from the windows file explorer; or, select one or more files and drag
them onto the DM Genie link on your desktop. All DM Genie files use the DM Genie icon.

Sharing between Player Genie and DM Genie
DM Genie files are fully compatible with Player Genie and vice-versa (as long as both
programs are of the same version). For example, your DM can make a campaign in DM Genie,
export it, and give it to his/her players who will import it into Player Genie. A player can create his
PC in Player Genie, and export it to a .Creature file, giving it to the DM for use during the game.
Importing a campaign created in Player Genie to DM Genie will require you to copy the
following files: Treasure.TXT, Weather_Desc.TXT, and Weather.DAT. These files aren'
t included
in Player Genie because it doesn'
t have any random treasure generator or Weather Generator.
Player Genie cannot read weather files.

Sharing Files
You are encouraged to share your creations on the Internet. The more people contribute, the
easier it will be for everyone to create a customized campaign. Visit the DM Genie website at:
http://www.dmgenie.com/
to upload your exported files and download those that others have uploaded. DM Genie compresses
the files so there is no need to use compressors such as Winzip. You can also distribute them any
other way you wish – e-mail, CD-ROMs, on your own website, etc.
Copyright notices should be included when applicable. It is a good idea to include a note of
what is Open Game Content, either as a separate text file or within the descriptions themselves.
Explain clearly what people can and cannot redistribute. Also, be careful when converting
something that was originally published by someone else. Not everything, even if you get it for free
on the Internet, can be legally reproduced. Check what part of the publication is Open Game
Content. The Open Gaming concept is great, but it will fail if people abuse publishers’ rights to
intellectual property.
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Selling your Creations
You are fully authorized to sell anything you made using DM Genie in any way you wish.
This includes over the Internet, on CD, in printed form, etc. You are not authorized to sell DM
Genie! You cannot charge any money for someone to download or copy the shareware version of
DM Genie, and you are forbidden from distributing the registration codes, in any way, to
anyone, for any price, including free.
To distribute the shareware version of DM Genie, you need to obtain our authorization at
info@dmgenie.com. You must distribute the shareware version for free, or for the price of the
media. You may also sell a CD or package containing the shareware version of DM Genie, but only
if you are selling a DM Genie file with it. That is, it must be clear to the customer that he or she is
purchasing your files, not the DM Genie shareware version.
You may also link to the DM Genie website, http://www.dmgenie.com/, to let users
download their own copies – this has the advantage that the program they download will always be
up to date.
A note about Open Game Content: The skills, feats, spells, powers, items, races, items
and weapons that come with DM Genie, and their descriptions, are Open Game Content. This
means you can reproduce the text, or export DM Genie files containing them and distribute the files,
even for money. See the Open Gaming License v1.0a. DM Genie itself, the program code, layout,
artwork, design, interface are all Copyright  2002 Mad Scientist Studios and may not be
redistributed except as explained above. Additional content downloaded from the Internet may or
may not be OGC.
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Exporting a Creature
Exporting a creature is quite simple. Go to the main window and select the creature you
wish to export. Then, go to the File->Export->Current Creature... menu. You will be prompted to
choose a filename. The default extension is .Creature, and it is recommended that you use this for
creatures.
A good use for exporting/importing of creatures is for players to edit or create their
characters with their copy of DM Genie, and then send the DM the .Creature file so he or she can
import it into the campaign.

Importing a Creature
If DM Genie is not running, double-click the file and it will start up and import the creature.
If DM Genie is already running, from the main window go to the File->Import menu. You will be
asked to select a file and then click “Open”. You will then be asked for the name to give the new
creature. You can keep the default (which is the name that the person who exported it gave the
creature) or rename it as you like. The creature is added to the currently selected group. If the
creature came from a different campaign, you may have some Unknowns Found During Import.
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Exporting a Group
From the main window, select the group you wish to export. Then, go to the File->Export>Current Group... menu. You will be prompted to choose a filename. The default extension is
.Group, and it is recommended that you use this for all groups. Each creature in the group will be
exported into the single .Group file.

Importing a Group
If DM Genie is not running, double-click the file and it will start up and import the group. If
DM Genie is already running, from the main window go to the File->Import menu. You will be
asked to select a file and then click “Open”. You will then be asked for the name to give the new
group. You can keep the default or rename it as you like. If the group came from a different
campaign, you may have some Unknowns Found During Import.
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Exporting Other Files
To export races, skills, feats, spells, psionic powers, weapons, items or conditions, use the
Export Campaign Data window. You can open it from the File->Export->Other... menu item from
the main window. When your exported files will be redistributed, it is a good idea to include a
copyright notice and a mention of what part of the text is open game content. Click here to learn
more about Sharing Files.

Exporting Spells, Psionic Powers and Items
Each of these three things can have conditions associated with them. To learn how to
associate conditions, see Editing Spells’ and Powers’ Associated Conditions and Items Editor.
When exporting a spell, power or item that has a condition associated with it, the condition is
exported as part of the same file. Locked conditions are not exported because it is certain that every
DM Genie user has them. If more than one spell exported at the same time use the same condition,
it is only exported once.

Exporting Conditions
You can export condition(s) alone using the Conditions tab of this window. If you are
exporting a spell, power or item, you do not need to export the condition separately, because it is
always included.

Selecting Items to Export
Select the tab that corresponds to what you want to export. Each tab works in the same way,
and has these components:

Items Available
This is a list of every item in the current campaign. You can select multiple items by CtrlClicking and Shift-Clicking. Click the “Add” button to add the selected items to the list at right.

Items Selected for Export
All the items in the list will be exported once you save the file. You can remove items from
this list by selecting them and clicking “Remove Selected”, and you can clear the list by clicking
“Clear”.

Filename
Type in the path and filename to which you want to save. You may also click the button at
right to choose a filename. The default extensions are .Race, .Skill, .Feat, .Spell, .PsionicPower,
.Item, .Weapon and .Condition.

Export Button
Click this to save the file in the currently opened tab.

Done Button
Closes the window. This does not save any changes made since you last clicked “Export”.
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Importing Other Files
The files that were exported using the Exporting Other Files window can be imported from
the main window. Select the File->Import menu. You will then be asked to select a file to import.
Any new items will be automatically added to your campaign. If one of the imported items has the
same name as an old item currently in your campaign, you will be presented with this choice:
- Replace: The old item is replaced with the new
- Rename: Enter the name of the new (imported) item. It will be added alongside the other
item. No characteristics other than the name will be changed (so the description will still
give the old name).
- Skip: Do not import this item.
- Replace All: All items imported will replace the old.
- Skip All: Any item of the same name will be skipped. New items will still be added.
- Stop and ask if descriptions are different: Used with Skip All and Replace All: if items
have the same name but their descriptions are different it will stop skipping/replacing all to
ask what to do for that specific item (Replace/Rename/Skip).
After importing a message box will tell you the number and the names of the items that were
imported as well as those that were skipped, if any.

Importing Spells, Psionic Powers and Items
Each of these three things can have conditions associated with them. To learn how to
associate conditions, see Editing Spells’ and Powers’ Associated Conditions and the conditions
section of the Items Editor. When importing a spell, power or item that has a condition associated
with it, the condition(s) will be imported first. If any conditions are already in the campaign and
have the same name, they will not be overwritten.

144

Unknowns Found During Import
When you export a creature, its list of skills, feats, spells and psionic powers is saved, along
with the other statistics. However, each person’s database of these items can be different. For
example, someone might run a campaign without psionics – all psionic skills, feats and powers
would have been deleted. If that person tries to import a creature that has a psionic feat for example,
DM Genie will be unable to assign it to any of the known feats.
This window gives you a list of all the unknowns found. If you are importing a group or
adventure, then these are all the unknowns for all the creatures imported. You can choose to
“Ignore” and the creatures will not have any of the unknown skills and feats – although every other
stat for this creature will still be correct, so this is a safe option. When importing a group or
creature, you can “Cancel Import” which will remove the imported creatures. You may try
importing again after you have added or imported the missing items.
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Exporting an Adventure
To export an adventure, go to the Campaign Manager and open the File->Export menu. You
can export either a single adventure or multiple adventures at once, depending on what menu item
you select:
This Adventure: Only the selected adventure
All Adventures Below This One: The selected adventure and every child adventure below it. For
example, you could create an adventure called “Evil Temple” and have child adventures below it
like “Entrance Hall” and “Altar of Death”. All these will be saved as a single file.
All Adventures: Every adventure in the campaign will be saved as a single file.
You will then be taken to the Export Adventure Data window:

Exporting Adventure Data
You may wish to include special races, skills, feats, spells, psionic powers, items or weapons
that are needed to run the adventure. For example, an evil sorcerer could have created a spell called
“Finger of Death”. With this window, you can export it along with the rest of the adventure. There
is no need to include any of the items (skills, etc.) that came with DM Genie – since everyone has
them. Select only the original items to reduce the size of the .Adventure file. If your adventure runs
in a campaign that can be downloaded separately from, for example, the DM Genie website, you
won’t need to include any of the skills, feats, etc. from that campaign – just tell people to download
and install the campaign first.
To export races, skills, feats, spells, psionic powers or items, use the Export with
Adventure Data window. You can open it from the File->Export->Other... menu item from the
main window. Select the tab that corresponds to what you want to export. Each tab works in the
same way, and has these components:

Items Available
This is a list of every item in the current campaign. You can select multiple items by CtrlClicking and Shift-Clicking. Click the “Add” button to add the selected items to the list at right.

Items Selected for Export
All the items in the list will be exported once you save the file. You can remove items from
this list by selecting them and clicking “Remove Selected”, and you can clear the list by clicking
“Clear”.

Continue Button
Click this button to accept the selection you have made. The selected items are then
exported with the adventure.

Cancel Button
Cancels the adventure export.
When exporting an adventure DM Genie automatically saves every associated group and the
creatures in them. The descriptions, notes, random encounter table and items list (with descriptions)
are also saved. The map/picture files linked to the adventures are also saved in the same file. Avoid
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having two different maps with the same filename but in different directories, because when the
adventure is exported, directory information is lost, and one of the maps will be missing.
See Sharing Files for more tips on giving or selling your DM Genie files.
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Importing Adventures
Importing adventures is a real time-saver: you can download an adventure from the Internet,
import it into DM Genie and be ready to run a new game in just a few minutes! The story, monsters,
treasure and random encounters are all instantly ready to use. You can import a complete module,
with numerous adventures and storylines, or you can import just a single mini-encounter or side trek
that will add flavor to your existing adventure.
To import an adventure, open the Campaign Manager. Select an adventure by clicking on it
on the adventure tree. Go to the File->Import menu. Here, you have a choice between two menu
items.
Import as Root Adventure: Creates an adventure at the highest level possible in the adventure tree
(the root level). This is most useful for large adventures or entire modules.
Import Below this Adventure: Imports the adventure as a child (sub-adventure) of the selected
adventure. This is most useful for add-ons, side treks or mini-encounters that can be added to an
existing adventure.
When importing an adventure with maps, a \Maps\ directory is added to your campaign’s
root directory and the map files are placed there. Any customized items such as spells (see
Exporting Adventure Data) are added to the current campaign. DM Genie will not overwrite
existing items. Normally, the person who exported the adventure should have included any custom
items that aren’t in DM Genie’s core rules campaign. However, if some items are missing when
importing the creatures, you will see the Unknowns Found During Import window that will warn
you of the missing items.
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Exporting a Campaign
So you’ve created your own campaign world, with it’s own interesting races, original spells,
strange locations – congratulations! Now you can share your hard work with the rest of the gaming
community by exporting an entire campaign. For more information on creating campaigns, go to
Creating a Campaign. You can also use entries in the adventure tree to describe your world, perhaps
with separate entries for culture, deities, governments, important towns, etc.
Open the Campaign Manager. From the File->Export menu select “Entire Campaign”. You
will then be asked to enter a filename. Use the .Campaign extension to avoid confusion. You will
then be asked what parts of the campaign you wish to export:
Export the Adventures?: If you’ve created custom spells, feats, etc. and want to share these
but don’t want to include the storyline, select No. Numerous adventures, especially with large maps,
will make the campaign file very large, so file size issues is another reason to say No.
Export the Creatures and Groups?: You may want to create a few creatures – for
important NPCs or villains, for example, and include them with the campaign.
Export the Races?: If you’ve created custom races, click Yes. If not, you can click No to
save on the file size – but that will force your users to use the "Race->Copy Core Races" menu, so it
is recommended to keep the races.
The entire campaign is exported as a single file. This includes all skills, feats, spells, powers
and items. You may now give or sell the campaign file (see Sharing Files).
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Importing a Campaign
Importing a campaign is a very quick way to input a complete gaming world. Depending on
what was exported with the campaign data, the .Campaign file you have may include adventures,
groups, creatures and/or races. All exported campaigns will have lists of skills, feats, spells, psionic
powers, items and weapons – although some may simply be a copy of the core rules’ data.
To import a campaign, open the Campaign Manager. Go to the File->Import->Import
Campaign menu item. You will then be asked to select the .Campaign file you wish to import.
Then, you need to give a name for you campaign. Finally, you must select a directory where the
campaign files will be stored. If the directory already holds a campaign, all previous data will be
overwritten. From the directory window you can also create a new directory, if needed.
After DM Genie closes, you must restart the program. DM Genie will then load the new
campaign’s data. When creating a campaign, DM Genie adds a shortcut to the current campaign in
your \Start Menu\Programs\DM Genie\ directory. You can click the shortcut to go to your campaign
(or use the File->Select menu, see below). In addition, you can switch to another campaign using
the File->Select Campaign menu from the Campaign Manager.
If you're importing a campaign from version 1.16 or earlier: Starting from version 1.17,
races are no longer shared between the Core Rules and custom campaigns. When you start your
custom campaign, you will find that you are missing most or all of the races - from the Race Editor
use the "Race->Copy Core Races into Campaign" menu, and you will once again have a copy of the
core races in your custom campaign. This change was made to eliminate the doubled races bug.
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Standard Weapons Editor
This help topic is Open Game Content, and is licensed for public use under the terms of the Open Gaming License
v1.0a.

The standard weapons editor is a way for you to quickly add a weapon to a creature’s list of
attacks. Select a weapon from the list at right, or click the Create New to add a blank weapon
(named New Weapon, temporarily). Click Remove to delete one of the weapons from the list.
Each weapon has data similar to what you find in the Attacks Frame of the main window:
name, damage string, type, weapon’s attack and magical bonuses, critical, size and range increment.
Is Natural Attack: When checked, all attacks are performed using the full Base Attack
Bonus – that is, the base attack bonus for the first attack the creature has. This is normally used for
creatures with several natural attacks, like a 8-headed hydra making 8 bite attacks, all at the same
bonus. Set the number of natural attacks in the box next to it.
Weapon Finesse, Off Hand, Primary Hand: these are the default used when adding an
attack to a creature, but can be changed afterwards.
The Damage Type is either S for slashing, P for piercing or B for bludgeoning, or a
combination of the three letters. The Weapon Proficiency is what feat is needed for a character to
use the weapon. Special and siege weapons are also indicated here.
In the Notes and Description you can use the Word Processor Commands.

Adding a Weapon
Click the Add This Standard Weapon to add the selected weapon to the current creature. If
you wish to add a custom weapon without having to create a standard weapon (which would stay in
the list), click the Add a Blank Weapon to add an empty attack named “Weapon” to the creature’s
list. Note that, if you wish, you can add an attack to a character without adding the related item to its
inventory. See the Items Frame for instructions on adding items.
When adding a weapon to a creature, the same weapon is added in the creature'
s inventory.
See Items Frame.

Magical or Masterwork Weapons
Click the Make Magical or MW button to make a magical or MW version of this weapon.
The weapons'price is adjusted according to it'
s bonus. More sophisticated magical enhancements
(flaming, etc...) can be done by editing the weapon'
s dice of damage (like "1d8 + 1d6" for a flaming
longsword).

Importing/Exporting
To import or export weapons, see the Importing Other Files and the Exporting Other Files
help topics.
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Items Editor
This help topic is Open Game Content, and is licensed for public use under the terms of the Open Gaming License
v1.0a.

The main window’s Items Frame and the Campaign Manager’s Adventure Items give you a
summary of each item in a creature or adventure’s list. The Items Editor (Shift+F5) allows you to
edit every aspect of an item. This is also where you can edit the Standard Items (items that are saved
with the campaign and you can easily add to any creature or adventure).

Choosing an Item
The list box at the top left (Items Taken From:) allows you to choose the source of the
items in the list – either from the Standard Items, the current creature or the current adventure.
Below, the Show Items of Type: list box allows you to limit the items shown. When you
select a type, only items that match it will be displayed in the list box underneath it. You can select
“All Items” or “All Magical Items” if you are unsure of the exact type.
Select an item by clicking it in the list. Create New will make a new item in the selected
source, whereas Remove will delete the item. Note that if you delete an item from the Standard
Items, you will not be able to restore it unless you import it, type it back in, or reinstall DM Genie.

General Information
Item’s Type: You can select from the list or create a new type of item – which will require
confirmation.
Check the Magical and Psionic boxes depending on the item’s type. Check the Identified
box if it is an item the PCs have magically identified (thus they know their effect and factor them in
their rolls, so you don’t have to). This applies only to items from a creature'
s inventory. See also the
Unidentified Name/Price boxes, that are in the Magical Items tab.
Check the “Equipped or worn” box to activate that item'
s permanent magical effect.
The Price and Weight can be decimals. The Auto-generated box is checked if the standard
item was auto-generated when DM Genie loaded. Any changes will be reset the next time you load
DM Genie. This does not apply to a creature’s and an adventure’s items list.
The Count box is the number of identical items owned. This applies to a creature'
s or an
adventure'
s items only. Check the Disposable box if you want the count to be reduced by one every
time a creature uses it (for example, arrows).
The Random Treasure Chance boxes give the chance (usually in %) that this item will be
rolled by the Random Treasure Generator. There are 3 boxes, for Minor, Medium and Major
magical items. The value can be a fraction, and does not need to total up to 100 for any given type –
the chance is relative.
The Description box can be edited with rich text using the Word Processor Commands. It
can also contain Adventure Hyperlinks.

Magical Items
Here, extra information can be written for magical or psionic objects. The Unidentified
Name and Unidentified Price boxes are there to allow you to hide magical items'names from your
players if they have not been identified. To use these, turn on the option (File->Options menu of the
Main Window). Character sheets printed when this option is on will show no sign that the item is
magical (except for equipped weapons/armor). Note that the default names are very simple, and the
default price is often rather arbitrarily chosen. You can customize this displayed name/price to give
more flavor to your game.
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The Charges text boxes hold the maximum number of charges and the number left. This
applies to wands, staffs, and some wondrous items. When creating a magical item, the Cost to
Create is the price of materials in gp, and the XP Cost is the number of XP that must be expended.
The Caster Level is the level at which the item was created, and is the level used when evaluating
spell effects or save DCs.
For intelligent items, check the Item is intelligent box. You can then enter the item’s ability
and ego scores, it’s alignment, languages spoken, and its special abilities or powers. Use the
"Random Intelligence" button to roll the intelligence stats as described in the DMG. Intelligence
usually adds to the price – but for this button the change is not automatic, allowing you to click
several times to get the intelligence you want. Adjust the price once you have chosen.

Permanent Magical Effect
Some magical items, like rings, give bonuses to the wearer whenever they are equipped.
You can record these bonuses in this tab. The magical effect of the item will be applied whenever it
is equipped (bold). The text boxes are the same as in the Conditions Editor and will have the same
effect when the item is equipped. See also About Conditions to learn more about conditions. The
"Item Has a Condition" box must be checked in order for the effect to be applied.

Spell-Like Effect
Many items simply reproduce a spell effect, for example, wands or potions. For these, check
the "Using this item reproduces a spell" box. Then, enter the name of the spell, the abbreviation of
the class that casts it as well as the caster level. The Metamagic Feats box holds a list of the feats
applied when casting. You can add a number after a feat to indicate it is applied more than once, for
example "Empower 2" will apply Empowered twice.
Every item can have one or more conditions associated with it. For example, a ring of
invisibility would have the invisible condition. Whenever a character wears the ring, his invisible
condition is active. Underneath “Condition Name” you will find a list of the conditions for that
spell. If the first condition is (None), then no conditions are set. Click the (None) box and select a
condition to add it to a list. If you wish to remove a condition, click it’s box and select (None) – this
will remove it and shift the list upwards. Click the “Edit” button to change the selected condition.
Click the “Create New Condition” to add open the Conditions Editor and create a new one. When
creating a condition specifically for an item, set that condition as being an “Item Cond”. From the
Options Dialog you can choose to hide all item conditions from the main window if they are
numerous and clutter up the display.
You can set each condition’s expiration – the time in rounds that the condition will be active
starting when the item is activated (in this version of DM Genie, this is not automatically set when
using an item, but it acts as a reminder and future versions will set it automatically). Set it to –1 or
check the “Always On” box to signify that the condition is active as long as the item is equipped
(worn, in hand, or otherwise activated). Check the “Equipped or worn” box in the General tab to
equip an item. It will appear in bold in the creature’s list. In most cases, you should use the
"Magical Effect" tab instead of creating a new condition that is always on.
To copy the list of conditions from a spell or a psionic power, click one of the “Copy from
a...” buttons. You will then be prompted to select a spell or power from which to copy, then click
Ok. For example, if you create a '
Staff of Barkskin'
, you may want to copy the conditions from the
Barkskin spell.
Because of the very large number of magical items that come with DM Genie, not all of
them have conditions associated with them – only those that directly reproduce a spell effect
(scrolls, wands) do. In future versions we may add more conditions.
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Armor/Shield
To set an item to be a suit of armor or a shield, check the “Is Armor” or the “Is Shield”
box. Select the type of armor (light, medium, heavy) in the proficiency list. You can then set the
armor’s characteristics – normal bonus to AC, magical bonus, maximum dexterity bonus to AC (set
to 99 for no maximum), arcane spell failure incurred, whether or not the armor/shield has spikes,
and the check penalty for certain skills. You can also record as a reminder what the character’s
speed is when wearing this armor (depending on his base speed of either 20, 30 or 40 feet per
round).
The editable boxes in this frame are:
-

Check Penalty: This is the modifier that applies to certain skill rolls while wearing this
armor.
Normal Bonus: This is the non-magical bonus to AC that the armor provides.
Magic Bonus: This is the bonus to AC that comes from magical enhancement. The standard
armors in the list have no magical enhancement.
Max Dex: This is the maximum Dexterity bonus to AC that can be applied while wearing
this armor. This does not apply to shields (set to 99).
Spell Fail: This is the percent chance of arcane spell failure when casting with this armor.

Physical Characteristics
Containers: A checkbox allows you to specify if this item can contain other objects.
Another checkbox allows you to ignore the weight of any items inside the container – effectively
keeping the weight at a fixed value. For example, a Bag of Holding 1 weighs 15 pounds no matter
what is in it.
Physical Characteristics: You can specify the item'
s hardness, hit points, break DC, AC,
etc.
Attacking an Object: Some buttons ease attacking objects and use the AC/Hardness
specified for the calculations.

Copying Items
You can take an item from the Standard Items, a creature’s list or from the adventure’s list
and put a copy of it in either the current creature or the current adventure. The Buy button will both
add the item and subtract the correct amount of gold from the PC'
s cash. Finally, you can copy the
item as another standard item; presumably for further modifications.
If you modify a standard item after having copied it to your adventure or creature, the
changes will not be reflected in them – they have the copy of the old item.

Importing/Exporting
topics.

To import or export items, see the Importing Other Files and the Exporting Other Files help
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Random Treasure Generator
This help topic is Open Game Content, and is licensed for public use under the terms of the Open Gaming License
v1.0a.

(Feature not available in Player Genie)
The random treasure generator rolls magical items and coins based on the tables in the
DMG. Click Shift-F6 to open it. See Editing Treasure Tables if you wish to change the chances for
a particular item or type of item or add new items to the random treasure tables.

Random By Level
-

-

Encounter Level: Choose the encounter level for the treasure (1 to 30).
Clear List upon generation: Automatically remove all items when you generate a new
item. Uncheck this to give several treasures at once.
Make # of coins less even: Puts extra randomization in the number of coins. For example,
1d6x10000 cp would always give a number like 20000 or 60000, but if this is checked, the
values is adjusted by a random number up to +- 5000, giving a more realistic 23113 cp or
58298 cp. The average number of coins given out over many treasures remains the same.
Generate Treasure: Makes the treasure with the settings described.
Adjust the amount of treasure: For each type, you can adjust how much is given. This
does not affect the probability of a particular type of item occurring, but changes the number
given when a type of item does occur. The values go from 0% to 400%

Random By Type
Here, items are rolled randomly, according to the correct table for each item type.
-

Magnitude: Choose what magnitudes of the magic items to include (does not affect
art/gems/mundane).
Item Type: Check each item type to include in the generation. Each type has an equal
chance of being picked. If you uncheck them all, the type will be chosen at random just like
when you create the treasure by level.
Count: Number of items to generate.
Generate Items: Adds the items to the list (replaces the list if clear list is checked).

Popup Menu (Right-Click an Item)
By left-clicking on the item'
s name, weight, value or quantity, you can edit these values.
More options are available by right-clicking the item, see the Items Pop-up Menu for more details.

Dragging and Dropping
As with other items in the program, you can drag/drop items from the treasure to other
inventory lists (in the Main Window or Campaign Manager) or to characters in the Main Window'
s
Creature List.

Top Buttons
-

Clear Treasure: Removes all items and coins.
Give All To...: Puts all items in the treasure in the inventory of the creature you select. The
first choice is the current creature, then the current adventure; all the others are the PC'
s
Party.
Leave all in Adventure: Puts all the items and coins in the current adventure selected in the
Campaign Manager.
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-

Get from Enemies: Takes all the items and coins from all enemies in the current group and
puts them in the treasure list.

About the Generated Items
Some magical items have additional qualities – these are indicated in the item'
s description.
For example: "Something provides a clue to its function." and "This weapon sheds light."
Some items are intelligent (usually 5% of weapons and 1% of other items). The intelligence
characteristics, primary and extraordinary abilities are all rolled automatically. The price of an
intelligent item is increased to reflect its new powers. There are a couple of things to look out for:
alignment may be incompatible with a power the weapon has (a chaotic sword shouldn'
t be lawful),
simply choose a new alignment in that case; ego is not yet automatically calculated; extra
languages thanks to high Int scores are not automatically assigned – choose languages that match
the weapon (a dwarven waraxe would speak dwarf).
When you use a scroll with several spells, edit the name (and description, if you wish) to
remove the used spell. If one of the spells has a condition associated with it, the Condition Setter
will pop up with the conditions for ALL the spells on the scroll. Select the appropriate one.
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Editing Treasure Tables
This help topic is Open Game Content, and is licensed for public use under the terms of the Open Gaming License
v1.0a.

(Feature not available in Player Genie)
A good part of the random treasure tables are in TREASURE.TXT, in the \Data\ directory of
your campaign. To learn how to edit it, open the file and read the comments included. Each
TREASURE.TXT file has a version number; you will get a warning if you try to use the wrong
version.
There are a few different ways the items are rolled, depending one what type they are:
1. Gems and art: They are generated from the name and value in TREASURE.TXT. They do
not need to be in the Standard Items. Weight is always 0 (for this version at least).
2. Mundane Items: DM Genie reads the name in TREASURE.TXT and finds the
corresponding Standard Item.
3. Weapons: DM Genie finds a matching standard weapon (see the Standard Weapons Editor),
and then will adjust magical bonuses, abilities, etc.
4. Scrolls: DM Genie looks for items named "Scroll: Spellname", and assembles them together
to create multiple-spell scrolls. For example: Scroll: Cure Light Wounds (1), Prayer (3). The
number in parentheses is the level of the spell.
5. Other Magical Items: DM Genie looks at each item of the type required (for example,
'
Ring'
). Each item has a chance for Minor, Medium and Major items (see Items Editor). The
chance for a specific item is value for that item, divided by the total of the values for all
items of the same type. Say for example you want the '
Ring of Counterspells'to come up
twice as often (right now it is 5% for minor/medium items), simply change the value to 10.
The dice rolled will be 1-105, with 10 chances out of 105 to be a '
Ring of Counterspells'
.
As mentioned above, to edit chances item-by-item, use the Items Editor in the General tab. If
you create a new standard item, like a new ring, it will never come up as a random treasure unless
you adjust its chance to above 0. For scrolls, mundane items, weapons and armor, editing the
chance in the Items Editor has no effect – you must edit TREASURE.TXT.
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Class Editor
This help topic is Open Game Content, and is licensed for public use under the terms of the Open Gaming License
v1.0a.

The Class Editor (Shift-F2) is where you can enter all the data related to your PC, NPC and
prestige classes.

Creating Classes
You can create a new, blank class (Create Blank), or you can copy an existing class (Select
the class, then click Copy Current). To delete a class, select it and click Delete.
Starting with Version 1.11, DM Genie includes a PC Leveling Wizard that uses the data
entered in the Class Editor.
Class General Information
Class BAB/Saves
Class Requirements
Class Skills
Class Bonus Feats
Class Features
Class Spellcasting Information
Class Spell Slots
Class Psionics Information
Class Starting Packages
Class Scripting
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Class General Information
(Go back to Class Editor) This help topic is Open Game Content, and is licensed for public use under the terms of
the Open Gaming License v1.0a.

Name and Abbreviation
The abbreviation of your class should be unique. 3-letter abbreviations are best, but not
always possible.

Type
Choose between PC Class, Prestige Class, NPC Class and Creature Advancement. There is
no functional difference (in the program) between a PC, NPC or prestige class; but a Creature
Advancement class works slightly differently – it is used to add hit die to a monster. The difference
is that the total number of hit die is used to determine progression in the base attack, saves, etc.,
rather than the number of hit die gained. Also, a monster advancing in HD can gain one or more
size categories – changing ability scores and increasing natural attack'
s damage.

Max Level
This is the maximum level that can be attained in this class. Data such as BAB, Saves and
spell slots will only be entered from level 1 to the max level. This cannot be higher than 80.

Hit Die
This is the number of hit points gained at each level. You can use a format like “1d8” or
even “2d6+3”.

Description
Enter any notes about the class and its features. You can edit this text using the Word
Processor Commands.
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Class BAB/Saves
(Go back to Class Editor) This help topic is Open Game Content, and is licensed for public use under the terms of
the Open Gaming License v1.0a.

BAB
The base attack bonus. A character may have up to 5 attacks. You can set the BAB for each
level manually by clicking in the grid, or by using the Quick Set button. This button will ask you
for the initial BAB and progression by level. For example, a cleric gains +0.75 per level. The BAB
is rounded down, so you get a progression that gains +1 three quarters of the time. You will also be
asked for the minimum BAB for the first attack in order to gain a second attack (and a third, and so
on). The default value is 6, which means the second attack is always = the first attack minus 5.

Saves
The base saves can be edited manually (click on the grid), or use the Quick Set button. You
will be asked which saves are good (higher bonus) or bad (lower bonus). Set the values for these
defaults by editing RULES.TXT (see Customizing Game Rules).
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Class Requirements
(Go back to Class Editor) This help topic is Open Game Content, and is licensed for public use under the terms of
the Open Gaming License v1.0a.

Most of the requirements listed in this tab are self-explanatory. Here are some clarifications for the
others:
-

Minimum BAB: Of the first attack.
Minimum Base Save: Does not count the relevant ability modifier.
Races: Separate with semi-colons.
Alignments: Check the alignments allowed for this class.
At Least Level XX in one of these classes: The character must be at least of the specified
level in any one of the classes in the second box. Separate classes by commas, and use the
class abbreviations only.
Skill Ranks: Format: Hide +8, Knowledge (Arcana) +4. Only the ranks are counted, not the
misc. or ability modifiers.
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Class Skills
(Go back to Class Editor) This help topic is Open Game Content, and is licensed for public use under the terms of
the Open Gaming License v1.0a.

Class/Cross-Class/Restricted Skills
You can record what skills are class skills (1 skill point per rank) or restricted (cannot be
bought). All other skills are considered to be cross-class if they are neither restricted nor class.
Note: We have chosen to use “Restricted” skills rather than specify “Exclusive” skills for each class
because “Exclusive” skills are often shared by several classes – making them not exclusive at all.
In revision 3.5 of the most popular RPG there are no more "Exclusive" skills. The ability to
add restricted skills has been retained however for compatibility with previous data sets and for
users who aren'
t updating to revision 3.5.

Adding from the List
Select the skills in the list at left, and click “Add as Class Skill” or “Add as Restricted Skill”
to add it to the other list. Doubles are ignored.

Read String
Instead of selecting and adding, you can copy/paste the text from, for example, a description
you found on a website. Any ability scores in parentheses are ignored. For example: “Swim (Str),
Scry (Int)” reads as simple Swim and Scry.

Skill Points
You get a certain number of skill points per level. Enter the base amount, the ability that
modifies this amount for this class (usually Int), and the multiplier. You enter this for both the first
level and each additional level.
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Class Bonus Feats
(Go back to Class Editor) This help topic is Open Game Content, and is licensed for public use under the terms of
the Open Gaming License v1.0a.

Adding Feats
Select the feats at left and click the “Add Bonus Feat” button to add them. Select them on
the right and press “Remove” to remove them from the list.

Adding Feats by Type
Enter the type of feat to add, for example, General or Metamagic. Feats are added if their
description contains the word between square brackets, for example, [General].

Read String
Enter or copy/paste a comma-separated list of feats. Any parentheses are ignored, as are *.
For example, “Dodge (Mobility, Spring Attack), Exotic Weapon Proficiency*” reads as “Dodge,
Mobility, Spring Attack, Exotic Weapon Proficiency”.

Number of Bonus Feats per Level
For each level, enter the number of bonus feats gained by the character. The character must
choose this feat from the list available.
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Class Features
(Go back to Class Editor) This help topic is Open Game Content, and is licensed for public use under the terms of
the Open Gaming License v1.0a.

Features
A feature can be a feat, a special ability, a class ability, or neither. Features are automatically
awarded when the specified level is reached. Make sure you spell the feats/abilities correctly. The
class abbreviation in parentheses is optional if the class is the same. For example, “Sneak Attack
(Rog)” will work if its only “Sneak Attack”, for the Rogue class. If you are creating a prestige class
called “Ninja” (abbreviation “Nja”), specify “Sneak Attack (Rog)” if you wish to use the same
special ability as the rogue.

Sorting Features
Click the “Sort by Level” button to sort by class level, and alphabetically within each level.

Deleting a Feature
Right-Click a row to delete it.
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Class Spellcasting Information
(Go back to Class Editor) This help topic is Open Game Content, and is licensed for public use under the terms of
the Open Gaming License v1.0a.

You can enter the following information:
-

-

Can Cast Spells: The class can cast spells (or manifest psionic powers).
Arcane/Divine: Type of spells cast.
Use Same Spell Levels as: When casting a spell, DM Genie searches the description for a
string like “Clr 1” (for a level 1 cleric spell) or “Sor/Wiz 8”. If your class isn’t listed in the
Level: portion of the spell description, you must enter a class that is. For example, arcane
spells usually use “Sor/Wiz”. You can also enter a second string to search for if the first one
is not found.
Relevant Ability: For calculating bonus spells, and, usually, spell DC.
Spell DC: The spell DC is calculated using the base (usually 10), plus the ability modifier
(or None for no ability mod), plus the spell level if that box is checked.
Must Memorize: Spells need to be prepared/memorized ahead of use. Use the “Memorized
XXX times” box in the Spells Frame to memorize a spell.
Spells Known is Limited: Like Sorcerers for example.
Deities, Domains: Enter any miscellaneous information about the deities, domain,
specializations, etc. that pertain to the class.

Number of Levels added to Previous Spellcasting Class
This grid allows you to create prestige classes that increase the number of levels you have in
a previous spellcasting class. For example, each level in Arcane Trickster adds a level to a previous
class. The progression should always increase, so there are no zeroes when the class doesn'
t add a
level. For example, a class adding a level on every other level has this progression: '1, 1, 2, 2, 3, 3,
4, 4, 5, 5'
.
Important: Do NOT check "Class can cast spells" for such a class. Since this class only
adds levels to another class, you cannot directly cast spells from the prestige class.
A prestige class can also add levels to a previous psionic class. When more than one class
can be the object of a prestige class, the user will get a prompt. You can change this also from the
Classes Frame in the main window.
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Class Spell Slots
(Go back to Class Editor) This help topic is Open Game Content, and is licensed for public use under the terms of
the Open Gaming License v1.0a.

Spells Per Day
For each level and spell level (from 0 to 9), enter the number of spells a character of this
class can cast per day. Click on the grid and enter a number.
Add “+1” after the class to signify that the character gets one extra domain/specialization
spell. Add “+2”, “+3”, etc. if the character gets for than one extra spell per day. The “Append +1”
and “Remove +1” buttons make it faster if you wish to add +1 to each entry.
Enter '
0'if the class will only get bonus spells (if any). If the PC'
s ability score isn'
t high
enough, he/she will not be able to cast spells of that level.

Spells Known
This is the maximum number of spells a character of this class and level can know. This grid
is ignored if the Class Spellcasting Information states that the class doesn’t have a limited number
of spells.
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Class Psionics Information
(Go back to Class Editor) This help topic is Open Game Content, and is licensed for public use under the terms of
the Open Gaming License v1.0a.

General Information
Information here is the same as that specified in the Class Spellcasting Information tab. In
fact, the values are shared. Starting with version 2.09, psionics and spellcasting classes share the
same structure. Checking the Class can use Psionics box automatically checks the Class can Cast
Spells box for internal program reasons. You cannot make a class that can both cast spells and
manifest powers.

Power Points per Level
For each level, enter the total number of power points obtained. If several psionic classes are
present for a single character, each total PP are added together.

Max Power Level
In Revised Psionics, a maximum power level is specified for each level a PC acquires.

Psionic Powers Discovered
For 3.0 psionics, this works exactly like “Spells Known” in Class Spell Slots. Psionic
characters are always assumed to have a limited number of known powers. Enter large numbers
(like 999) if there is no limit.
For the Revised psionics, only the total number of known powers is limited – there is no
limit for each power level. Enter the total number in column 0 only.

Bonus Power Points from ability score
This table is used only for the 3.0 version of psionics. For each ability score listed, and for
each class level, you get this many bonus power points. The bonus PP are cumulative at each level.
The Revised Psionics instead uses a calculation based on the relevant ability modifier and
the manifester level.
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Class Starting Packages
(Go back to Class Editor) This help topic is Open Game Content, and is licensed for public use under the terms of
the Open Gaming License v1.0a.

Starting Gold
Number of gold pieces at first level of a new PC/NPC. Format: “2d4 x 4”.

Bonus Languages
If a class gets bonus languages, the character can choose between these.

Starting Packages

You may enter pre-defined stat blocks of 1st level characters of the class. You can include
their equipment, chosen feats/skill points, etc. You can also note anything else of interest about
creating a character of this class. You can edit this text using the Word Processor Commands.

168

Class Scripting
(Go back to Class Editor) This help topic is Open Game Content, and is licensed for public use under the terms of
the Open Gaming License v1.0a.

In this tab you can enter custom VBScript code that will change the way your class will be
applied. For general information about using VBScript in DM Genie, see the following sections:
•

Scripting
o Scripting for Feats
o Scripting – General Functions Available
o Scripting – Debugging
o Scripting – func Object
o Scripting – Creature
o Scripting – Creature Functions
o Scripting – Race
o Scripting – Attacks

Class script code is executed after all other regular class leveling effects have been
calculated. This includes added hit die, changes to size due to monster advancement, etc.

Accessible Objects
Much as in feats, several objects are accessible when executing the class script. Cr is the PC
as it will be returned. OldCr is the PC before leveling (the saved backup copy which is used when
selecting Undo). cRace is the PC'
s race object. And as always, func is used for general functions
(see Scripting – func Object).

Parameters
PrevLevel is the level the PC had before leveling. AddedLevel is the number of levels
added. Automatic indicates whether the leveling was manually done or done automatically (for
now, automatic is usually False, though later versions might have it set True). If Automatic is true,
do not prompt the user, use Msgbox, or add information to the combat log.

What can I do with class scripting?
could:
-

There is a huge variety of effects you can automate using class scripting. For example, you
Make a class which doesn'
t gain a hit die on each level (by removing previously given HD).
Handle a different way to calculate spell slots.
Give special abilities or feats to the PC but based on certain conditions (minimum ability
scores, etc.)
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PC Leveling Wizard
(Go back to PC Leveling Wizard) This help topic is Open Game Content, and is licensed for public use under the

terms of the Open Gaming License v1.0a.

The PC Leveling Wizard will guide you step by step in adding a class or level to a PC or
NPC (the process of leveling, sometime spelled '
levelling'
). You can open it by clicking the '
Level
Up'button in the Classes Frame.
Using the wizard, you can add hp, ability points, set BAB and saves, spend skill points,
select feats, spells, and psionic powers. Throughout the wizard, red and green labels will warn you
whether or not you have completed that part of the leveling process.
When the 'Next'button is blinking, you have fulfilled all needed steps for this part of
leveling. Clicking Next goes to the next tab. Click '
Prev'to go back.
In all cases, the warning labels are only warnings – you may choose a class whose
prerequisites you don'
t meet, spend more skill points than you have, select more feats than
available, add more hit points than you were supposed to. DM Genie will not stop you from doing
these things, but it will warn you to prevent it from happening accidentally.
It is strongly recommended that your PC not be under any conditions before leveling. Rightclick the PC and select '
Clear All Conditions'
. If conditions change the ability scores, you may have
incorrect skill point totals, and bonus spells.

Steps in Leveling:
Leveling – Class Selection
Leveling – HP, Abilities, BAB and Saves
Leveling – Skills
Leveling – Feats
Leveling – Features
Leveling – Spells
Leveling – Psionics
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Leveling – Class Selection
(Go back to PC Leveling Wizard) This help topic is Open Game Content, and is licensed for public use under the

terms of the Open Gaming License v1.0a.

-

-

Select a Class: Click on a class in the list to select what class to add to your PC.
Alignment: Enter your PC'
s alignment here if you have not set it already. Use the
abbreviations (Lawful Good = LG, Neutral = N, etc.)
Are the class's requirements met? This box indicates if any of the requirements for the
class aren'
t met. Prestige classes often have several requirements. '
Special'requirements
usually aren'
t related to game stats, so you must determine if they are met before adding a
level. Click '
Refresh'to check the requirements again without having to re-click the list of
classes.
XP: The amount of XP needed to add the selected number of levels is displayed. You can
change the amount of XP the PC has. This number includes the race'
s equivalent level, if
any. See PC Races.
Add One Level in this Class: You can add levels to a PC one at a time, or several all at
once. If you add more than one level, you'
ll have more feats/skill points/etc. to spend. The
totals are automatically calculated
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Leveling – HP, Abilities, BAB and Saves
(Go back to PC Leveling Wizard) This help topic is Open Game Content, and is licensed for public use under the

terms of the Open Gaming License v1.0a.

Hit Points and Hit Die
-

Hit Die to Add: This is the number of levels you are adding.
# Added: How many times you have added HP using the Add HP buttons.
HD Size: What dice is rolled when adding a new hit die.
Modif: Modifier to the hit die roll. This is usually the Constitution modifier, but can be
changed by Customizing Game Rules.
Roll: Use the HD and modifier to roll the hit points. At first level, the maximum value is
used.
HP to Add: Use the Roll button to set this or enter it manually.
Add HP: Adds the number of hit points indicated to the character'
s total. If this is the PC'
s
very first class, you will be asked if you wish to replace the previous HP total with the new
value. This is useful if you were creating a human for example, with the standard 4 hit
points, which shouldn'
t be added when you make that human into a PC.

Ability Points
-

Ability Points to Assign: At 4th, 8th, 12th and 20th level a PC gets extra ability points. This is
the total of new ability points.
Reset Abils: Put the ability scores back to the original value
Ability Buttons: Click this to add one point to the score.
Ability Values: This displays the ability score. You can edit this manually, but to add one of
the allowed points, use the button instead (as the button will decrement the number of ability
points left to assign).

Base Attack Bonus
Adding the old BAB with the increase from adding level(s) gives the PC'
s new BAB. If the
BAB is higher than +5, the PC will get extra attacks (this can be changed by Customizing Game
Rules). You can edit the scores manually also.

Base Saving Throws
The base saving throws do not include any of the ability modifiers. The new values for the
saves are the old values plus the increase from the new level(s).
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Leveling – Skills
(Go back to PC Leveling Wizard) This help topic is Open Game Content, and is licensed for public use under the

terms of the Open Gaming License v1.0a.

List of Skills
All skills are displayed in the grid. Green indicates class skills; red indicates restricted
(prohibited) skills, while white entries are cross-class skills. There are six columns:
- Name: The skill'
s name.
- Abil: The relevant ability modifier.
- Tot.: The total skill bonus for this PC. Skills that cannot be used because the PC is untrained
have a total of –99.
- Rnk: The number of ranks the PC has in this skill.
- Max: The maximum number of ranks that can go into this skill. This depends on whether or
not the skill is cross-class or class in every one of the PC'
s classes. If the skill is a class skill
in any of the classes, than the maximum ranks are calculated from the PC'
s total level. If the
skill is restricted in one of the classes, but cross-class in the rest, the levels from the
restricted classes do not count.
- Misc: The total of temporary and permanent misc. modifiers.

Total Skill Points Earned
This is the total of skill points earned by using the PC Leveling Wizard for all the classes
and levels of the PC. If the PC has gained classes in another way, for example manually in the
Classes Frame, or when importing a stat block, this value will be incorrect.

Skill Points Left
This is the number of skill points for the level(s) to be added, minus the number of skill
points you have spent. If you exceed the number of SP you have earned, the number of SP left will
be negative and the warning label will be red.

Spend One Skill Point
Select a skill in the grid and click the button to spend one skill point. You can also doubleclick the name of the skill in the grid to spend a skill point.

Buy Back One Skill Point
If you have added too many ranks to a skill, you can remove them using this button. You
will be warned if you try to remove more SP than you had spent.
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Leveling – Feats
(Go back to PC Leveling Wizard) This help topic is Open Game Content, and is licensed for public use under the

terms of the Open Gaming License v1.0a.

List of Feats
This is the list of all feats (but no special/class abilities). Green means the feat is available as
a bonus feat for this class, while bold feats have already been selected by the character. Click the
grid to view the feat'
s description.

Feat Prerequisites
DM Genie reads the description of the feat to determine what are the prerequisites for taking
the feat. If a prerequisite is not understood, (for example, '
Ability to fly'
), it will be displayed as
Unknown prereq: and you should manually determine if the PC satisfies the requirement.
Prerequisites that are understood are of type: Str 13+, Spellcaster level 5, Base Attack Bonus
+3 or better, FeatName, Weapon Focus (longsword), Fighter level 8th, Character Level 10, Ride 1
rank.

Choosing a Feat
Usually, you can choose a feat by clicking the'Choose as Regular Feat'button. Some
classes give you bonus feats (in green), use the 'Choose as Bonus Feat'button on them.
You can also double-click the grid to choose the feat. If a feat could be either regular or
bonus, you will be asked to choose.
Some feats, like Weapon Focus, will require you to choose on what weapon/spell the feat
applies.
Use the '
Unselect Feat'button to undo your selection. You will be asked to confirm if you
attempt to unselect a feat which you hadn'
t selected using the wizard.

Total Feats Earned
This is from all the levels in all the classes the PC has.

Total Feats Chosen
This is the total of all the feats chosen using the wizard. If the PC has gained classes in
another way, for example manually in the Classes Frame, or when importing a stat block, this value
will be incorrect.
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Leveling – Features
(Go back to PC Leveling Wizard) This help topic is Open Game Content, and is licensed for public use under the

terms of the Open Gaming License v1.0a.

All the features this PC has obtained from its class(es) are displayed here. New features are
in bold. If any of the features'names corresponded with a special ability, a class ability or a feat,
those were selected automatically (for example, Simple Weapon Proficiency). Features whose
names do not correspond with any feat or ability are not added.

Special Attacks/Qualities
You can edit the PC'
s special attacks and qualities strings here. Click the grid, then one of
the '
Add'buttons to add the selected feature to the list. Any notes will be added in parentheses. You
can also edit the strings manually.
The special attacks and qualities strings do not affect game stats but are used as reminders in
the Class Abilities Frame.
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Leveling – Spells
(Go back to PC Leveling Wizard) This help topic is Open Game Content, and is licensed for public use under the

terms of the Open Gaming License v1.0a.

Spell Levels and Ability
The class uses a certain string to specify what level a spell is (see Class Spellcasting
Information). For example, a wizard casting a spell will use the '
Sor/Wiz'level.
The ability modifier indicated will be used to calculate the bonus spells.

Grid for this Class Level

The spell slots (1st row) and spells known (if there is a limit, 3rd row) for this class level are
displayed here. If the PC has a high enough relevant ability score, then he/she will get additional
Bonus Spells (2nd row). The spell slots for the PC automatically add the bonus spells, the regular
spell slots, and the specialization/domain spell slots, if the specialization box is checked.

Grid for this PC
a level.

You can manually edit the spell slots here, although they are automatically set when you add

The number of spells known is calculated from all the spells with the appropriate level (like
'
Sor/Wiz'for a wizard) in the description. This number may be higher than the real number if in
another class (Cleric for example) you have selected a spell that is also available for wizards.

Prestige Classes that Add Levels
Some prestige classes like Loremaster add levels to another spellcasting class. The levels are
added to the total spellcasting class level in calculations for determining caster level, spell slots per
day, and spells known. The extra levels do not give the PC the class features he/she would get by
adding levels in the original class.

Reporting Class Added
A label above the grid tells you if any prestige class is adding levels. If no prestige classes are
adding levels, the label will say:
Setting Spell Slots for Class: Wizard
If you are adding levels to a prestige class that adds levels to another class, the label will say:
Class adds 3 level(s) to existing spellcasting class: Wizard.
The spell slots/known displayed are those of the Wizard class, not the Loremaster class.
If you are adding levels to a spellcasting class which is already being increased by a prestige class,
the label will say:
Class 'Loremaster'adds 3 level(s) to this class, Wizard, for a total of: 9.
(where 9 is the number of previous levels in Wiz + the levels you are adding to Wiz + the levels
Loremaster is adding).
If you are adding levels to a prestige class that has not been set to adding another class (for
example, you have no spellcasting classes and you are adding a Loremaster level, normally
impossible), you will get this error message:
Class adds 3 level(s) to existing spellcasting class, NOT FOUND!
No spell slots will be set.
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Making a Spell List
Two lists are displayed: on the left, you see all available spells. You can filter the spells by a
piece of text in the description. For example, you could show only level 8 cleric spells with '
Clr 8'
.
Click a spell to view its description. Double-click a spell to add it to the list of known spells. You
can select several spells at once by Ctrl-Clicking or Shift-Clicking. Hold Ctrl when double-clicking
to keep the selection.
The list on the right is the spells the PC has selected (knows). Double-click a spell to remove
it from the list of known spells.

Auto-Spell List
This command allows you to automatically give a creature all spells for several classes, up
to a specified spell level for each class. Enter the class abbreviation (Brd, Clr, Drd, Pal, Sor/Wiz,
Rgr) or the domain of the spell (Fire, Knowledge, etc.), a space, then the maximum level, separated
by semi-colons for each class. Use Sor/Wiz instead of just Sor or Wiz - for example '
Sor/Wiz 3; Brd
2; Fire 3'
. This function is particularly useful for divine casters, who usually have access to all spells
up to their level limit. For arcane casters, remove spells that aren’t in the character’s spell list.
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Leveling – Psionics
(Go back to PC Leveling Wizard) This help topic is Open Game Content, and is licensed for public use under the

terms of the Open Gaming License v1.0a.

Psionic Powers Known
-

The grid displays the number of psionic powers that a PC has:
For This Class: What a PC of this class level gets. Sometimes includes a "+1", which
means that the PC gets an extra spell from its specialization (if the specialization box is
checked).
All Classes Combined: The sum of the psionic powers the PC should have discovered from
all classes, including this one.
PC Knows: Number of powers of each level that the PC knows. For Revised psionics, only
the total number known (independent of level) counts.
Left to Learn: Number of powers the PC has left to discover. This is in red when the PC
exceeds his number of allowed powers.

Psionic Power Points
-

Previous PP Total: The number of PP the PC had before leveling.
Increase from Level(s): How many PP obtained from gaining the levels in this class.
Racial Bonus Power Points: Some races can give bonus PP on first and additional levels in
a class.
Bonus PP: For 3.0 Psionics, bonus PP are added every 2nd level if the PC has a sufficient
ability score in the relevant ability. For Revised psionics, Bonus PP are re-calculated on the
fly.
New PP Total: This is automatically set to the correct value, but you may edit it manually.

Discovering Powers
Two lists are displayed: on the left, you see all available powers. You can filter the powers
by a piece of text in the description. For example, you could show only level 8 powers with
'
Psion/Wilder 8'
. Click a power to view its description. Double-click a power to add it to the list of
known powers.
The list on the right holds the powers the PC has discovered (knows). Double-click a power
to remove it from the list of known powers.
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Hit Dice Detail
This form allows you to view and edit each hit die rolled when creating or leveling up your
character. The Hit Die string displays the hit dice gained (as displayed in the stat block). Use the
Add or Remove buttons to change the number of hit die manually – though it is recommended to
use the leveling wizard to add hit die.
Click on the grid to change one of the following:
- Die: the hit die value; for example, a wizard gets 1d4 per level so this is a value of 4
- Roll: the hp rolled for that hit die.
- Con?: whether or not to add the Con bonus for that hit die.
- Source: the source of the HD, either the race, class or a creature advancement class.
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Templates
Certain creatures are created by adding a template to an existing creature. A templated
creature can represent a freak of nature, the individual creation of a single experimenter, or the first
generation of offspring from parents of different species.
To give a template to a character or monster, see Templates – Applying to a Character.
To create a new template or change an existing one, see Templates – Editing
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Templates – Applying to a Character
First, select your character in the main window. Then, open the template editor from either
the Windows menu or the Classes tab.
Select the template you want to apply on the left. See the General Template Settings tab to
read the template'
s description.
Click the Preview button, which will apply the template. The original creature'
s stat block is
displayed on the left, whereas the templated creature'
s stat block is on the right. Note that some
changes might not be visible in the stat block.
Some templates require user input – for example, for the Lycanthrope template you must
choose the template'
s base animal. This will be asked whenever the template is applied.
Click the Add as New Creature button to apply the template again, but this time add the
templated creature to the same group as the current creature. The new character'
s name is usually
different, for example, Orc becomes Orc, Half-Fiend.
General hints on applying templates
- Some templates (half-celestial, half-fiend and half-dragon for example) may change the
number of skill points gained from racial hit die. If this is the case you need to change your
skill ranks manually.
- It is best to apply the template after advancing a monster or giving class levels if possible.
You will need to adjust the creature'
s challenge rating if you add levels after applying the
template
- Applying more than one template to a creature is possible but may have some unintended
effects or result in contradictory abilities.
See Templates – Editing to learn how to create a new template.
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Templates – Editing
To create a new template, use the Create Blank button (lower left). An empty template is
added, with some default code to serve as a guide. You can then change the name. Use the Copy
Current button to instead copy another template. The Delete button, obviously, deletes the
template.
Templates are programmed in VBScript. VBScript code is extremely versatile and can
handle nearly any template situation possible. See the following help topics for more info on
scripting:
o
o
o
o
o
o
o

Scripting – General Functions Available
Scripting – Debugging
Scripting – func Object
Scripting – Creature
Scripting – Creature Functions
Scripting – Race
Scripting – Attacks

The template prerequisite code checks the character to make sure it meets the prerequisites
(for example alignment). For a valid character, do nothing. If it is invalid, code like this to signal it
and give the reason:
Prereq = False
Reason = Reason & "Must be good or neutral; "

The template code is the heart of the template – as in feats, the Cr object is the target
creature. The cRace object is the target'
s race. The func object is a general-purpose object for
common functions.
Given the variety of possible situations it is impossible to give hints in advance of all
possible things you may want a template to do. Try looking at other templates or at feats to get
some tricks. You can also ask your question in the DM Genie forums at http://www.dmgenie.com/
Some feat effects are better handled by a feat (or special ability); for example, see the
Alternate Form ability that lycanthropes have. You can design a template to work with a feat, by
saving custom variables from the template code that the feat will read when used, for example.
Here follows example code for a template:
Public Sub TemplateApply()
'This is an example default template
'Modify this to match your template
'Consult the code of other templates for more code examples.
'Change the name of the creature
cr.Name = cr.Name & ", template"
'Abilities: This increases each ability by +2
cr.StrBase = cr.StrBase + 2
cr.DexBase = cr.DexBase + 2
cr.ConBase = cr.ConBase + 2
cr.IntBase = cr.IntBase + 2
cr.WisBase = cr.WisBase + 2
cr.ChaBase = cr.ChaBase + 2
cr.AbilityCalc
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cr.CalcAbilityMods
'--- Special Attacks --'This adds "daylight, Smite Evil" to the Special Attacks text box
s = cr.SpecialAttacks
s = s & ", daylight, Smite Evil"
if mid(s,1,2) = ", " then s = mid(s,3)
cr.SpecialAttacks = s
'--- Special Qualities --'This adds a string at the end of the Special Qualities string
s = cr.SpecialQualities
s = s & ", darkvision 60 ft, immunity to disease, resistance to acid, cold and
electricity 10"
if mid(s,1,2) = ", " then s = mid(s,3)
cr.SpecialQualities = s
'--- Giving Feats or Special Abilities --'For a feat/special ability to show up in the Feats tab use code like this:
cr.GiveFeatName "Darkvision", "", True
cr.GiveFeatName "Resistance to energy", "", True
cr.GiveFeatName "Spell Resistance", "", True
'You can also create a new feat specifically for this template and put in script
code to automate tasks.
'Give a +8 racial (misc) bonus to a skill (Hide in this case)
n = func.GetSkillNum("Hide")
cr.SkillMisc(n) = cr.SkillMisc(n) + 8
'Challenge Rating: Same as the base creature + 2.
cr.ChallengeRating = cr.ChallengeRating + 2
'Level Adjustment: Same as the base creature +4.
cr.TemplateLevelAdjust = cr.TemplateLevelAdjust + 4
End Sub
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Custom Data Editor
The Custom Data Editor, accessible by pressing Shift-F9 or from the Windows menu, is a
way to ease entering and manipulating your custom data, and specifying the source book for each
item.
See also Bulk Data Entry for a powerful feature allowing the automatic entry of large
amounts of data.

Type of Data Tabstrip
Click on the tab corresponding to the type of data you want to edit. Races, skills, feats,
spells, psionic powers, standard items, standard weapons, conditions, classes and templates can all
be edited within this consistent interface.

List of Items and Filtering
The list of items is displayed on the left. If both checkboxes are cleared, all items in your
campaign are displayed.
Filter by text: Check this box to filter all the data based on a full-text search of both the
name of the item and it'
s description. Enter the text to search in the box on the right (case is
ignored). You can perform more complicated searches by combining strings, separated by
semicolons. For example, psionic; evil will display only items with both psionic and evil in the
name or description. To exclude items based on string, precede the text with a minus sign "-". For
example, -amulet will not show any items with the word amulet. You can combine these techniques,
psionic; -amulet; good; -evil will search for text with both psionic and good, but neither evil nor
amulet.
Filter by source: Check the box to filter according to the sourcebook displayed in the list at
right. You can also enter custom text to search for. The drop-down list includes all sources from the
items of the selected type. An option in the drop-down list is empty – that is, you can filter to show
only items where no source is specified. This is useful when importing data from a version of DM
Genie before sources could be specified.
You can select multiple items in the list by shift-clicking and ctrl-clicking, as in other
Windows interfaces. Select All will select all items automatically, whereas Invert Selection will
unselect all selected items and select all unselected items.

Items' Sources
The Source of a book can be any string – usually, the source string should be the item'
s
sourcebook. For example, the core data that ships with DM Genie comes from the following
sources: Player'
s Handbook 3.5, DMG 3.5, MM 3.5, and Psionics Handbook.
Sources of Selected Items: When you select one or more items in the list, this is updated to
show which sources those items have.
Set source to: Type in some text or select a choice from the drop-down list to set the source
for all displayed items. If you have some data already entered, you can use the filter by text function
to help make selection easier (for example, if you'
ve noted "Source: BookX" in all your custom
items'description, simply filter for that string and select all filtered items).

Editing Individual Items
The currently selected item'
s name and description is displayed on the right. You can edit
both of these directly. Other, more specific data (like a class'
s data or a condition'
s modifiers) must
be edited in their respective windows. Click the Edit... button to open the correct window for
editing.
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The description area is a rich text box – you can use Word Processor Commands like
keyboard shortcuts, the right-click menu or the font bar to change the text formatting. The box has
multiple levels of Undo.
See also Bulk Data Entry for a powerful feature allowing the automatic entry of large
amounts of data.

Adding, Removing Items
The Create New button will prompt your for the name of your new item. A blank item is
created – only the name and a simple description is added. Edit the description and/or use the Edit
button to enter more data.
Copy will make a copy of all selected items. The name of the copied item is the same as the
original but with " copy" added. All other values are identical.
Delete will remove the selected items from the current campaign.
Export... will open the export window (see Exporting Other Files) with the same selection
of items as in the Custom Data Editor. Click Add to add them to the list to export, and then you can
save the file. For example, you could filter Feats by source to select BookX, then select all items
and export them into a file named BookX.Feats.
Save will save the current type of data to disk.
Undo will re-load the current type of data from disk, essentially undoing all changes since
the last save (note that DM Genie saves data automatically when windows are closed).
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Character Sheet Output
After you have created your PC (using the PC Leveling Wizard), you can create a HTML
character sheet which you can then printout for use during a game without a laptop.
The character sheets are HTML and use Cascading Style Sheets to display properly. You
need a browser that supports CSS properly (like IE 5.0, 6 is better) in order to display the character
sheets correctly. You may want to adjust the margins before printing in order to use the maximum
available space of the page. Netscape 4 has very poor CSS support and can cause problems with the
layout. Later versions of Netscape are better at CSS support.
You can change the look of the character sheet by editing or creating Character Sheet
Templates.

AC Breakdown
The character sheet displays AC broken down into these fields. Several of these are also in
the Combat Statistics Frame:
- AC: Total AC
- Base: Always 10
- Armor: Total of armor, shield and their magical bonuses if any. Does not contribute in
touch attacks.
- Dex: Dex modifier to AC
- Natural: Permanent natural armor and contribution from conditions (magical items or
spells). Does not contribute in touch attacks.
- Misc: Any other bonus, like size.
- Conds (Armor): Armor bonus from conditions (spells or magic items). Does not contribute
in touch attacks.
- Conds (Other): Other contributions to AC from conditions. For example, dodge or
deflection bonuses.

Temporary Boxes
Some boxes marked "Temp" and with grey borders are intentionally left empty. Use these
boxes while playing to note the effect of spells, etc.

Char Sheets and Conditions
All condition effects are kept when printing out a character sheet. This means that should
use the "Clear All Conditions" menu to start out with a rested, fresh character. Magical item
conditions will still be active, though. If a spell or other condition will be active always, keep it on
before printing out the sheet.

Fun Uses for Char Sheet Exports
For Barbarians, you can print out two sheets: one normal page, and another with the
condition "Barbarian Rage" enabled. That way, all stats, attack bonuses, skill bonuses, etc. are precalculated for when you rage.
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Character Sheet Templates
You can edit the templates used to create the character sheets in order to customize your
character sheet. The template sheets are HTML and use Cascading Style Sheets to display properly.
You need a browser that supports CSS properly (like IE 6.0) in order to display the character sheets
correctly.

Tags
The templates use special tags that work like this pipe character, name of tag, then pipe
character. DM Genie will replace the text of the tag with the appropriate data. They should contain
no spaces, and be entirely in uppercase. For example:
|TAGNAME|
|TAG.SUBTAG|
|STAT2|
|STAT3.MOD|

Tags Available
There are many tags you can use in your own character sheet. We will not list them all here
– refer to one of the templates that come with DM Genie to learn what tags you can use. The name
of each tag is fairly self-explanatory. More complicated tags are displayed below:

Pictures
You can include a picture (choose the file in the Desc Frame) of your PC on the character
sheet. The format is |PICTURE#| where the number # means:
0: No resizing
1: Width fixed at 400 pixels.
2: Width fixed at 300 pixels.
3: Width fixed at 200 pixels.
4: Width fixed at 100 pixels.
5: Width fixed at 50 pixels.
6: Height fixed at 400 pixels.
7: Height fixed at 300 pixels.
8: Height fixed at 200 pixels.
9: Height fixed at 160 pixels. Default Value
10: Height fixed at 100 pixels.
11: Height fixed at 50 pixels.
12: 200% of original size
13: 150% of original size
14: 100% of original size
15: 75% of original size
16: 50% of original size
17: 25% of original size

FOR Loops
The FOR tag is a special tag with this format:
|FOR,%var,min,max,step|
<HTML CODE>
|ENDFOR%var|
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%var can be any string following a % character. The loop will replace the string "%var"
with the value of the index at that loop, starting with min and ending with max, stepping by step.
Do not nest FOR variables.

Double FOR Loops
The FOR2 tag is a for loop for 2 columns:
|FOR2,%var,%secondvar,min,max,step|
<HTML CODE>
|ENDFOR%var|
%var will be replaced normally, but %secondvar will be replaced by %var + 1. Usually step
= 2 for these loops.

Maximums in FOR Loops
Some special recognized values for the max parameter of FOR loops:
COUNT[SKILLS]: the number of skills. Unusable skills will be skipped.
COUNT[FEATS]: only those feats the PC has.
COUNT[ATTACKS]: each attack the PC has.
COUNT[ITEMS]: each item the PC has.

Special Tags for Spell Information
-

Each block of text is delimited by the tags below and another tag, |END.PREVIOUSTAG|.
SPELLCLASS.HEADER: Displayed for each spellcasting class. %t is the variable to mean
the class number of the spell class.
SPELLCLASS.USED.HEADER: Displayed for each spellcasting class that does not need
to memorize spells (includes a line of "spell slots used".
SPELL.PRELEVEL: Displayed before each group of spells of one level. The %l variable
is the spell level
SPELL.LINE: Each line in the list of spells. Should have three columns with the variables
%a, %b and %c for each column.
SPELL.POSTLEVEL: Displayed after each group of spells of one level.

Filters
Anything between a |FILTER:NAME| and |ENDFILTER:NAME| will be ignored if that
particular filter is turned on (from the options when generating the sheet). Filters can be nested (that
is, put inside one another).
You can create customized filters using custom variables for creatures (see Scripting –
Creature Functions). You can filter HTML in the character sheet using the following format:
|FILTER:CUSTOMVAR:TheNameOfMyVariable|
<b>This html code will only be displayed if the variable is not empty ("" or an empty string). Any
value returned (even "0") will cause the filtered text to be included.</b>
|ENDFILTER:CUSTOMVAR:TheNameOfMyVariable|

Custom Variables
Custom variables that are accessed by some feats (see Scripting – Creature Functions) can
be displayed in the character sheet using the tag |CUSTOMVAR:TheNameOfMyVariable|. So, in
conjunction with the custom filter you can make optional output like this one, which will only show
up for bards, and indicate how many uses per day of Bardic Music are left:
|FILTER:CUSTOMVAR:BardicMusicQty|
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Bardic Music uses left today: <b>|CUSTOMVAR:BardicMusicQty|</b>.
|ENDFILTER:CUSTOMVAR:BardicMusicQty|
The default character sheet only includes examples related to feats/abilities like Bardic
Music, but using Class Scripting to set variables for example it would be possible to greatly
customize the character sheet to fit the needs of each PC.
There are also numbered custom variables (those displayed in the Custom tab). The tag for it
is for example |CUSTOMVARNUM2|, where you replace 2 with the number of your variable. The
first custom variable is # 0.

Full List of Tags
Here follows the full list of tags in the default character sheet. Their name is usually directly
indicative of its function. Some tags may be unused in the actual default sheet but can be used in
your custom sheet.
--- Title Area --|NAME|
|LEVELSTR|
--- General --|PLAYER|
|CAMPAIGN|
|ALIGNMENT|
|GENDER|
|APPTITLE|
|LEVELSTR|
|RACE|
|HEIGHT|
|WEIGHT|
|AGE|
|SIZE|
--- Ability Scores --|FOR,%g,0,5,1,1|
|STAT%g.NAME|
|STAT%g.LONGNAME|
|STAT%g|
|STAT%g.MOD|
|STAT%g.BASE|
|STAT%g.BASEMOD|
|STAT%g.TEMP|
|STAT%g.TEMPMOD|
|ENDFOR%g|
|HP|
|DR|
--- Armor Class ---
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|AC|
|AC.FLATFOOTED|
|AC.TOUCH|
|AC.TOUCHMELEE|
|AC.TOUCHRANGED|
|AC.BASE|
|AC.EQUIP|
|AC.ABILITY|
|AC.NATURAL|
|AC.MISC|
|AC.TEMP.ARMOR|
|AC.TEMP.NONARMOR|
--- Initiative/BAB --|INITIATIVE|
|STAT1.MOD|
|INITIATIVEBONUS|
|SPEED|
|BAB|
--- Character Picture --|PICTURE9|
--- Saving Throws --|CHECK.FORTITUDE.TOTAL|
|CHECK.FORTITUDE.BASE|
|STAT2.MOD|
|CHECK.FORTITUDE.MAGIC|
|CHECK.REFLEX.TOTAL|
|CHECK.REFLEX.BASE|
|STAT1.MOD|
|CHECK.REFLEX.MAGIC|
|CHECK.WILLPOWER.TOTAL|
|CHECK.WILLPOWER.BASE|
|STAT4.MOD|
|CHECK.WILLPOWER.MAGIC|
--- Attacks --|MELEE.TOTAL|
|BABONE|
|STAT0.MOD|
|SIZEMOD|
|RANGED.TOTAL|
|BABONE|
|STAT1.MOD|
|SIZEMOD|
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--- ,s --|MAXRANKSCLASS|
|MAXRANKSCROSS|
|FOR,%s,0,COUNT[SKILLS],1,1,1|
|SKILL%s|
|SKILL%s.ABILITY|
|SKILL%s.TOTAL|
|SKILL%s.ABMOD|
|SKILL%s.RANK|
|SKILL%s.MISC|
|SKILL%s.ARMORCHECK|
|ENDFOR%s|
|SKILLINFO| : the misc. notes about skills box.
--- Attacks --|FOR,%w,0,COUNT[ATTACKS],1,1,1|
|WEAPON%w.NAME|
|WEAPON%w.TOTALHIT|
|WEAPON%w.DAMAGE|
|WEAPON%w.CRIT|
|WEAPON%w.HAND|
|WEAPON%w.RANGE|
|WEAPON%w.WEIGHT|
|WEAPON%w.SIZE|
|WEAPON%w.TYPE|
|WEAPON%w.SPECIAL|
|ENDFOR%w|
--- Armor --|FOR,%a,1,COUNT[ARMOR],1|
|ARMOR%a.NAME|
|ARMOR%a.TYPE|
|ARMOR%a.TOTALAC|
|ARMOR%a.CHECKPEN|
|ARMOR%a.MAXDEX|
|ARMOR%a.SPELLFAIL|
|ARMOR%a.SPEED|
|ARMOR%a.WEIGHT|
|ARMOR%a.MAGIC|
|ARMOR%a.SPECIAL|
|ENDFOR%a|
--- Ammo --|AMMO0.NAME|
|AMMO1.NAME|
|AMMO2.NAME|
|AMMO3.NAME|
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--- Equipment --|FOR2,%e,%f,1,COUNT[ITEMS],2|
|EQ%e.NAME|
|EQ%e.EQUIPPED|
|EQ%e.QTY|
|EQ%e.WT|
|EQ%e.COST|
|ENDFOR%e|
|EQUIPPEDWEIGHT|
|TOTALWEIGHT|
|TOTALVALUE|
--- Carrying --|LOAD.LIGHT|
|LOAD.MEDIUM|
|LOAD.HEAVY|
|LOAD.OVERHEAD|
|LOAD.OFFGROUND|
|LOAD.PUSH|
--- Coins --|CASHPP|
|CASHGP|
|CASHSP|
|CASHCP|
|VALUABLES|
--- Misc Notes --|XP|
|XPNEXTLEVEL|
|EYECOLOR|
|HAIRCOLOR|
|DEITY|
|BACKSTORY|
|NOTES|
--- Feats --|FOR,%f,1,COUNT[FEATS],1,1|
|FEAT%f|
|ENDFOR%f|
|FEATINFO|
--- Other Stuff --|LANGUAGES|
--- Spells ---
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|FILTER:SPELLS|
|FILTER:SPELLSPAGE|
|ENDFILTER:SPELLSPAGE|
|SPELLNOTES|
|STARTSPELL|
|SPELLCLASS.HEADER|
|CLASS%t.FULLNAME|
|SLOT%t.0|
|SLOT%t.1|
|SLOT%t.2|
|SLOT%t.3|
|SLOT%t.4|
|SLOT%t.5|
|SLOT%t.6|
|SLOT%t.7|
|SLOT%t.8|
|SLOT%t.9|
|SPELLDC%t.0|
|SPELLDC%t.1|
|SPELLDC%t.2|
|SPELLDC%t.3|
|SPELLDC%t.4|
|SPELLDC%t.5|
|SPELLDC%t.6|
|SPELLDC%t.7|
|SPELLDC%t.8|
|SPELLDC%t.9|
|END.SPELLCLASS.HEADER|
|SPELLCLASS.USED.HEADER|
|CLASS%t.FULLNAME|
|CLASS%t.FULLNAME|
|SLOT%t.0|
|SLOT%t.1|
|SLOT%t.2|
|SLOT%t.3|
|SLOT%t.4|
|SLOT%t.5|
|SLOT%t.6|
|SLOT%t.7|
|SLOT%t.8|
|SLOT%t.9|
|SPELLDC%t.0|
|SPELLDC%t.1|
|SPELLDC%t.2|
|SPELLDC%t.3|
|SPELLDC%t.4|
|SPELLDC%t.5|
|SPELLDC%t.6|
|SPELLDC%t.7|
|SPELLDC%t.8|
|SPELLDC%t.9|
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|END.SPELLCLASS.USED.HEADER|
|SPELL.PRELEVEL|
|END.SPELL.PRELEVEL|
|SPELL.LINE|
|SPELL%a|
|SPELLBOXES%a|
|SPELL%b|
|SPELLBOXES%b|
|SPELL%c|
|SPELLBOXES%c|
|END.SPELL.LINE|
|SPELL.POSTLEVEL|
|END.SPELL.POSTLEVEL|
|ENDSPELL|
|ENDFILTER:SPELLS|
New v.2.10:
|SPELLMEMORIZEDLIST_NAME#| and |SPELLMEMORIZEDLIST_LIST#|
These allow you to display the list of pre-set memorized spells (see the Spells Pop-up Menu) in the
character sheet. The # in the tag is to be replaced with 1, 2, etc. for the list of that #. The first list'
s
number is 1.
--- Psionics --|FILTER:PSIONIC|
|FILTER:PSIONICPAGE|
|ENDFILTER:PSIONICPAGE|
|TOTALPP|
|FREETALENTS|
|PSIMODE1|
|PSIMODE2|
|PSIMODE3|
|PSIMODE4|
|PSIMODE5|
|PSIMODE6|
|PSIMODE7|
|PSIMODE8|
|PSIMODE9|
|PSIMODE10|
|STARTPSIONIC|
|PSIONIC.PRELEVEL|
|END.PSIONIC.PRELEVEL|
|PSIONIC.LINE|
|PSIONIC%a|
|PSIONIC%b|
|PSIONIC%c|
|END.PSIONIC.LINE|
|PSIONIC.POSTLEVEL|
|END.PSIONIC.POSTLEVEL|
|ENDPSIONIC|
|ENDFILTER:PSIONIC|
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Scripting In DM Genie
Scripting is a very powerful way to apply the effect of a feat. This is an advanced feature
however – creating new feat scripts requires at least basic knowledge in programming. If you only
want to edit the scripts (for example change a bonus from +4 to +6), you don'
t need to learn to
program, just change the values at the correct places.
If you wish to create a new routine, use an existing feat as a starting point if possible. Be
careful and save often if you are not sure of what you are doing. A poorly written script could mess
with your character'
s stats, and cause errors while using the program.
The scripting language is VBScript, a subset of Visual Basic. VBScript is quite simple and
you do not need to be a programmer to write a little code. If you know any version of Basic you will
be able to program in VBScript. If you know another programming language like C/C++ or Java,
you will need to familiarize yourself with the syntax of Basic first, but as the name implies, Basic is
pretty easy to learn. Here are some useful links for learning VB/VBScript:
http://www.devguru.com/Technologies/vbscript/quickref/vbscript_list.html
http://visualbasic.about.com/cs/usingvbscript/
http://www.freevbcode.com/
•

Scripting for Feats details how to code the effects of feats.

•

Scripting – General Functions Available summarizes functions available in VBScript

•

Scripting – Debugging gives tips on debugging script code.

•

Scripting – func Object lists members of the func object, which is accessible from all
scripting

•
•

Scripting – Creature lists members of the creature object (usually Cr)
Scripting – Creature Functions lists functions in the creature object

•

Scripting – Race lists members in the race object (usually cRace)

•

Scripting – Attacks lists members in the attack object (usually cAtt)

•

Scripting – LastDamage Object allows you to modify attack rolls.

•

Scripting – Item Properties lists the properties of items you can read/modify.

•

Scripting – Skill Object explains how to modify a skill'
s data.

•

Scripting – Spell Object explains how to modify a spell or psionic power'
s data.

•

Scripting – Modifying Feats explains how to modify a feat'
s data.

•

Bulk Data Entry shows how to use scripting to enter many feats, skills, spells or items at
once.
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Scripting for Feats
Feat Code
There are five pieces of code you can write. All of these are optional. Except for the last one
(Other) you cannot declare any subroutines.
The Cr object holds all the creature'
s information and is always accessible from any of the
feat'
s subroutines. See Scripting – Creature and Scripting – Creature Functions for more
information. To edit a creature'
s attacks see Scripting – Attacks.
If you will need the character'
s race, check the "Return Race in cRace" box. The object
cRace holds the race, but cRace may not be valid. Do not access cRace if it is not valid (check using
func.ValidRa(cRace))! See Scripting – Race for available members in cRace.

Getting a Feat
Enter the code to run when the character gets the feat for the first time. Usually, this code gives
bonuses to various stats. If the "Level-Dependant Effect" box is checked then this code will be
executed each time the PC gains a level. Do not check the box if the feat will give cumulative
bonuses (for example, toughness would give 3 hp at each level if "Level-Dependant Effect" were
checked). Also, do not use check this box if the feat asks something of the user (for example
Weapon Focus requires the user to select what weapon).
If for some reason the feat'
s effects cannot be applied (for example, the user did not select a
weapon when asked to apply Weapon Focus), you must set FeatGet = False which indicates that
the feat will not be selected after all. FeatGet is set to True by default.
If the "Can Take Feat Multiple Time" box is checked then the user can press "Take Again" to
apply the effects again (for example, for a new weapon).

Removing a Feat
Code to remove the bonuses obtained when the "Getting a Feat" code was executed. It'
s unusual
for a PC to remove a feat, but it can happen if the user selected the wrong feat. Make sure all effects
are removed. Use the race to get some default values if needed.
If for some reason the feat'
s effects cannot be removed (for example, the user did not select a
weapon when asked to apply Weapon Focus), you must set FeatRemove = False which indicates
that the feat will stay selected after all. FeatRemove is set to True by default.

Using a Feat
This code is executed when the user presses the '
Use Feat'button from the feats tab. This can be
used to make a reflex save with a special bonus and report the result, for example. User input can be
useful in these cases.

Stop Using Feat
This code is executed when the user presses the '
Stop Using Feat'button from the feats tab. This
could be necessary if '
Use Feat'gives only a temporary bonus.

Resting
The '
Rest'code is run whenever the user selects one of the Rest menu options (see Main
Window Menus). All calls to this code have one parameter set, Hours, an integer. Hours is set to 8
or 24 hours when called from the Rest menu, but is set to 0 when called manually, using the Rest
button from the Feats Frame. When Hours is 0, you can have the script output to the combat log or
use dialogs. Otherwise, it is not recommended to do so.
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Other Subroutines
You can enter subroutines or functions that will be used by any of the three other functions.
You must declare full subroutines, for example:
Sub MySubroutine(Argument1, Argument 2)
(... enter some code...)
End Sub
Function MyFunction (Argument1, Argument 2)
(... enter some code...)
'
Return a value like this
MyFunction = 12
End Function

Special
First, you must choose what the special code will do by selecting an option in "Use of
Special Subroutine". Set Nothing if no special code will be used. Since your Special subroutine will
be called often, keep it as short as possible to avoid slowing the program. Also, never ask for any
user input in a Special subroutine for Attack Bonus or Condition Effects calculation.

Attack Bonus Calculation:
The code is called whenever the attack/damage bonuses are calculated for any weapon the
character has. The object cAtt is the attack in question. Make sure you only modify values that are
re-calculated each time. For example:
cAtt.WeaponDamageBonus = cAtt.WeaponDamageBonus + 1
will cause the weapon'
s damage bonus to grow uncontrollably.

Condition Effects Calculation:
This code is called right after all the effects from all conditions and magic items are totaled
up. You can add to or change any bonus that comes from a condition. Only change variables that
are recalculated in this step. This code is executed before the bonuses are applied throughout (for
example, before calculating the total AC).

Metamagic Feats:
This code is called when casting a spell, before calculating DC or decrementing from the
spell slots available. Usually metamagic feats apply to only one or a few spells. The following
public variables are set and can be modified by the code:
SpellName, SpellNum (# in cr.SpellList), SpellLevel (for the appropriate class),
SpellSlotUsed (same as Spell Level but usually increased), ClassAbbrev (that casts this spell, like
'
Wiz'
), ClassLevel (effective casting level; only for ClassAbbrev), DCBonus, FeatDescription
(string added in the combat log to indicate the feat'
s effect).
Forced is true if the feat must be applied no matter what; usually used when an item
reproduces a spell effect that is metamagicked. For example, a potion could be Aid with the feat
Spell Focus applied; in this case Forced is true and the script doesn'
t check if the item is of the
correct school.
The following aren'
t used yet but are reserved for future versions: DurationMult (multiply
duration by this), RangeMult (multiplier for the range), EffectMult (multiplier of variable numeric
effects), Maximized (set to true if all variable values are maximized).
NoteStr, OtherStr, OtherInt1, OtherInt2
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Metapsionic Feats:
The code for metapsionic feats is identical to that of metamagic feats, with 4 extra variables:
OrigPP is the original number of power points for this power. FinalPP is the number of PP
after applying this feat. AugmentPP is the number of PP applied to augmenting the power'
s effect
(only used by the Augment Power "feat"). FocusUsed is the number of psionic focuses expended
by the feat (usually PC'
s only have 1 psionic focus).
Additionally, the SpellSlotUsed variable will be ignored for metapsionics.
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Scripting – General Functions Available
(Go back to Scripting )
Most standard Visual Basic functions are available in addition to those listed below. Avoid
the "With... End With" statement, as it is not available in VBScript 4.0

Msgbox "My Message"
Displays the message.

res = msgbox("Question?", 4)
Asks a yes/no question, returns in res 6 for yes and 7 for no.

s = Inputbox("Please Enter:", "Title String", "Default Value")
Ask the user to enter a string (defaulting to "Default Value"), which is then returned in s.

Execute "CodeString"
Uses the VBScript engine to execute the piece of code entered in the string. This allows you to run
code that can be changed depending on some paramenters – for example, you could call
func.ChooseString with a different list of parameters by using execute to build the call.

Formatting Rich Text Strings
You can format output to the combat log (in func.AddToCombatLog for example) by inserting the
following RTF codes in this fashion:
\b1 Bold Text \b0
\u1 Underlined Text \u0
\i1 Italics Text \i0
\cf0 Black Text \cf0
\cf1 Red Text \cf0
\cf2 Blue Text \cf0
A new line will follow this text\par
Codes can be nested:
\cf2\b1\u1 Blue and Bold and Underlined Text \b0\u0\cf0
You must separate RTF codes from text, or it may cause the code to not work, or your following
word to not display.

Common String Manipulation
It is beyond the scope of this document to describe in detail the functions for manipulating strings.
However, here are the most common ones and links to detailed explanations from this site:
http://www.devguru.com/Technologies/vbscript/quickref/vbscript_list.html
Mid: Extract inner part of a string
UCase and LCase: Make a string upper and lower case, respectively
Replace: Replace a string within a string
InStr and InStrRev: Search for a string within another string
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Len: Length of a string
RegExp: Regular-expression string searching.
Trim: Remove blank spaces around a string
Split: Splits a string according to a separator string (for instance, the comma)

200

Scripting – Debugging
(Go back to Scripting )
An essential part of writing any computer code is debugging it to ensure it runs as you
intended. Here are some tips:

Use "Check Syntax"
The "Check Syntax" button will help you find errors without having to run the script. The
line and column of the error is displayed.

Read error messages
When a script cannot execute correctly an error number and description is displayed. Along
with the line and column of the error, you can look in your code and attempt to find the problem.
You'
ll also see a string saying "Occured while ...", to help you find what piece of code is causing the
error.

Comment your code
Lines starting with a quote ('
) are comments. Use them to clarify what your code is trying to
accomplish – they will greatly help you if you come back to a piece of code you haven'
t touched in
a while.

Use output at important steps
While debugging, it can be useful to know the value of some variables. For example, you
might use a msgbox call to let you know how your code is proceeding. Remove or comment out any
such debugging output once your code is working correctly.

Be careful about variable types
VBScript only allows the variant data type whereas some functions in the creature object for
example require a specific type. If you get a type mismatch error, try using extra parentheses to
force a conversion. For example:
Cr.FunctionName (Variable1), (Variable2), (Variable3)

201

Scripting – func Object
(Go back to Scripting )
The func object holds several useful functions for you to use. They enable you for example
to interface with the user in more sophisticated ways than just Msgbox and Inputbox.

Miscellaneous Functions
func.AddToCombatLog "Message"
Adds a line to the combat log. Can use rich text tags. Do not add a "\par" code at the end. For a list
of RTF codes, see Formatting Rich Text Strings.
func. MakeRollString (Total, Roll, ParamArray Bonuses() As Variant)
Makes a string for the combat log like "14 (Roll 3, +2 bonustype, -3 bonustype)"
e.g.: MakeAttackString(14,3, +2, "bonustype", -3, "bonustype")
func.RollDice("1d20+4")
Rolls the dice string indicated and returns the value.
func.SetAutoDamage(Damage As Integer, Kind As Integer, Touch As Boolean, AC As
Integer, CritAC As Integer, CritDamage As Integer, Subdual As Boolean).
This allows a script to save damage for use with the '
AutoDamage'menu.
Kind = 0 for melee, 1 for ranged. CritAC is the critical threat AC hit; CritDamage is the extra
damage from a critical.
Everything except Damage is optional and will default to a melee touch attack that hits AC 999
(thus always hits) with no critical. E.g. func.SetAutoDamage 12 will always cause 12 hp of
damage.
func.CopyAttack(vSourceAt As Variant, vDestAt As Variant)
Copies the attack SourceAt into DestAt
func.CheckName(ListOfNames As String, ThisName As String) As Boolean.
ListOfNames = semicolon-separated list of names.
Returns true if ThisName is in ListOfNames
func.Append(StringToChange As String, AdditionalString As String) As String
This function will take StringToChange and add AdditionalString after it, with a comma if
necessary.
The return value is the appended string. Use like this:
cr.FeatMisc = func.Append(cr.FeatMisc, "Weapon Specialization")
func.Remove(StringToChange As String, StringToRemove As String) As String
Takes StringToChange, searches for StringToRemove, and removes it. If there is a trailing comma
or period, it is removed also.
func.GetSizeValue(SizeStr as String)
Returns an integer value based on the first letter of a size string.
M: 0; L: +1; S: -1; and so on. Returns 0 if sizestr is not a valid size abbrev
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func.GetLastDamage()
Returns the LastDamage object, which is the Damage object containing the last attack roll. See
Scripting – LastDamage Object.
The following functions return True if the argument is a valid object of the type specified.
func.ValidCr: Creature
func.ValidRa: Race
func.ValidSk: Skill
func.ValidAt: Attack
func.ValidGr: Group
func.ValidCond: Condition
func.ValidSp: Spell
func.CVInt(in) and func.CVSng(in) convert any input variable to an integer and a single (floating
point) number, respectively. The conversion is safe – that is, there is no error even if the input is
invalid or overflows.

Functions for Detailed User Input
func.ChooseSkill(Question As String) As Long
Asks the user a question and displays a list of all skills. The function returns the skill number of the
skill the user selected (-1 if cancelled).
func.ChooseSpell(FeatName As String, Optional OnlyKnownSpells As Boolean = False) As
String
func.ChoosePower(FeatName As String, Optional OnlyKnownSpells As Boolean = False) As
String
Ask the user to choose a spell or a power for which he will apply FeatName. Returns the name of
the spell or power.
Set OnlyKnownSpells to true (optional) to limit the display to only spells known by the PC
func.Choose (Question As String, ParamArray Elements()) As Long
Asks the user a question and displays a list of choices. After Question, enter each item followed by
a comma and a numerical value corresponding to it. Returns -1 when the user presses cancel. For
example:
MyColorNum = func.Choose("Which is you favorite color?", "Blue",
1, "Red", 2, "Green", 3)
func.ChooseString (Question As String, ParamArray Elements()) As Long
Asks the user a question and displays a list of choices. After Question, enter each item string.
Returns the string For example:
MyColorName = func.ChooseString("Which is you favorite color?",
"Blue", "Red", "Green")
func.ChooseWeapon(FeatName As String) As String.
Returns a string chosen by the user (presumably the name of a weapon).
func.ChooseRace(Title As String, FilterType As Boolean, DefaultType As String, FilterPC As
Boolean) As Integer
- Opens the Choose Race dialog.
Title: Dialog caption
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FilterType: Set true to filter by type
DefaultType: The type to filter
FilterPC: Set true to filter only PC races
Returns the race ID#
func.InputInteger(prompt as string, optional min_value as long = 0, optional max_value as
long = 2000000) as long
Asks for user input as per input box, but validates result to ensure it is an integer (long) value. If
not, it asks for input again. Also validates "min" and "max" (useful for dice input ranges).

Functions to Access Campaign Data
func.SpellIsFromSchool(SpellNum As Integer, SchoolName As String) As Boolean
Returns True is the Spell # SpellNum is from the school SchoolName. (This works by checking if
SchoolName is in the description before the Level: string)
func.GetPPCost(PowerName as string) as integer.
Returns the Power Point cost of the given power
func.GetSkillNum(SkillName As String) As Integer
Returns the skill number corresponding to the name. Will be –1 if the skill isn'
t found.
func.GetSkillObj(SkillNum As Integer)
Returns a skill object from the skill number (see Scripting – Skill Object). This allows you to view
and edit every skill property.
The following functions can still be used by getting the skill object using GetSkillObj allows you to
change the parameters, not just view them.
func.GetSkillName(SkillNum)
Returns the skill name from the skill ID (or number)
func.GetSkillAbility(SkillNum)
Returns the skill relevant ability name for the given skill ID (or number)
func.GetSkillArmorCheck(SkillNum)
Returns true or false depending on whether the skill has an armor check penalty
func.GetSkillTrainedOnly(SkillNum)
Returns true or false depending on whether the skill can only be used by trained PCs (1 or more
ranks)
func.GetFeatName(FeatNum)
Returns the feat name from the feat ID (or number)
func.GetFeatNum(FeatName)
Returns the feat ID from the feat name
func.GetFeatParam(FeatNum As Integer, ParamName As String)
Returns a parameter (ParamName) from the feat of ID FeatNum
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func.SetFeatParam(FeatNum As Integer, ParamName As String, NewValue As Variant)
Sets the feat parameter ParamName to NewValue for the feat FeatNum
func.GetSpellNum(SpellName As String, Optional PsionicMode As Boolean = False) As
Integer
Returns the Spell ID (or number) from the spell name. "Cure Light Wounds, Mass" will match
"Mass Cure Light Wounds". Also, "Tasha'
s Hideous Laughter" will match both "Hideous Laughter"
and "Ta'
s Hideous Laughter".
(Returns 0 if not found)
func.GetSpellName(SpellNum)
Returns the Spell name from the Spell ID (or number)
func.GetSpellLevel(SpellNum, ClassName)
Scan the description to find the spell level matching ClassName
Will return -1 if nothing is found
func.GetSpellObj(SpellNum As Integer)
Returns a spell object from the spell number (see Scripting – Spell Object). This allows you to view
and edit every spell property.
Spells and psionic powers have the same data format in DM Genie – so you can use this same
function to edit a psionic power.
func.GetRaceNum(RaceName As String) As Integer
Returns the race number (ID) from the name of the race
func.GetRace(RaceNum As Integer) As Race
Returns the race object from the # of the race
func.GetRaceFromName(RaceName As String) As Race
Returns the race object from the name of the race
func.GetConditionNum(CondName As String) As Integer
Return the condition number from its name
func.GetNumberOf_Skills() As Integer
func.GetNumberOf_Feats() As Integer
func.GetNumberOf_Spells() As Integer
func.GetNumberOf_Conditions() As Integer
Each of these functions returns the number of X in the campaign. Note that some of the intervening
items might not be valid (deleted spells, etc.). So even if func.GetNumberOf_Skills returns 200,
skill number 145 might have been deleted and so not be valid.

func.GetTimeStat(Name As String, Optional Number As Integer)

This function returns a particular value of the current time, or some information about the current
weather.
The Name argument is a non-case-sensitive string describing the type of value. The Number
argument is required only when requesting moon phase. Moon numbers start at 1.
Here follows a list of accepted parameter names. Returned are integers (longs) unless otherwise
noted:
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Functions to Access Other Creatures
These functions return a Creature object that you can modify exactly like the Cr object. For
example, a feat could set a condition for members of the PC'
s Party.
func.ChooseCreature(Question As String, GroupNum As Variant, ShowEnemies As Variant,
ShowFriends As Variant) As Creature
Presents the user with a list of creatures
- GroupNum: 0 = currently selected group
1 = PC'
s Party
2 = Current Encounter
(under Player Genie there is only one group - all of these choices will use it)
- ShowEnemies, ShowFriends: Set to True to show either or both of these.
Returns: The selected creature object, or Nothing if user cancelled the choice
func.GetNextCreature() As Creature
Returns, as an object, the next creature in the group selected by GetNextCreatureInit
Will return Nothing when it runs out of creatures.
Creatures are returned in alphabetical order. All are returned, enemies or not.
--- Example use: --dim MyCreature
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func.GetNextCreatureInit 0
Set MyCreature = func.GetNextCreature
While (Not MyCreature Is Nothing)
MyCreature.HP = MyCreature.HP - 5
Set MyCreature = func.GetNextCreature
Wend

func.GetNextCreatureInit(GroupNum As Variant)
Initializes the group to be looped in GetNextCreature
GroupNum: 0 = currently selected group
1 = PC'
s Party
2 = Current Encounter
(under Player Genie there is only one group - all of these choices will use it)
func.GetCreatureName(TheName As Variant) As Creature
Returns, as an object, the first creature whose name matches TheName
The search is case insensitive
This looks only in the currently selected group
Returns Nothing if no match is found.
If multiple creatures share the same name only the first is returned.
In this example, MyCreature will be set to the current target of this PC ("LastAttackedCreature"
field) and the target will be damaged by one hit point.
dim MyCreature
Set MyCreature = func.GetCreatureName(cr.LastAttackedCreature)
If Not MyCreature is Nothing then
MyCreature.HP = MyCreature.HP - 1
End if
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Scripting – Creature
(Go back to Scripting )
The current creatures'stats and functions are available in the Cr variable. To access a
variable, you must precede the variable with "Cr.", for example, Cr.HP gives you the current hit
point total.
Some variables are marked '
Read-Only'
, which means that they are recalculated often so that
modifying them once will have no effect. Special code for feats is the exception – it should modify
only '
Read-Only'variables.
Here follows the members of Cr you can access. There are also several useful function is
Scripting – Creature Functions.
Name As String
RaceName As String
LastFoundRaceID As Integer '
Starts at 0, upon 1st detection is set for the whole session
'
Other info
Desc As String
'
Rich-text
'
Plain-text
Notes As String
Languages As String '
languages spoken
Alignment As String
Size As Integer
'
size as number (unused)
SizeStr As String '
size as letter (S, M, L)
ChallengeRating As Single
XP As Long
'
experience point total
'
experience points to reach next level
XPNextLevel As Long
'
Permanent Damage Reduction
DamageReduction As Integer
'
HP absorbed
'
-1 = silver. Ignored from revision 3.5 on
DamageReductionPlus As Integer
'
New DR for dnd3.5
Public DamageReductionStr As String
'
Permanent type of DR
'
---- Description Data -----'
in inches
Height As Long
Weight As Long
'
in pounds
Desc_HairColor As String
Desc_EyeColor As String
Desc_SkinColor As String
Desc_BackgroundStory As String
Desc_Deity As String
SpecialAttacks As String
'
now displayed in the Class Abilities-Frame
SpecialQualities As String
'
now displayed in the Class Abilities-Frame
Age As Long
'
New from 1.12.167
Gender As String '
New from 1.12.167
CreatureType As String
'
Type of creature (same as race), new v.2.06
UncannyDodge As Boolean
'
Like the feat
UncannyDodgeFlanked As Boolean
LastAttackedCreature As String '
New v.170
PictureFileName As String '
New v.1.14.172
'
Levels, just a String. Auto-generated
LevelStr As String
'
Ability scores (current value, including temp. adjustments) Read-Only
Str As Integer, Dex As Integer, Con As Integer
Intel As Integer, Wis As Integer, Cha As Integer
'
Ability scores base value
StrBase As Integer, DexBase As Integer, ConBase As Integer

208
IntBase As Integer, WisBase As Integer, ChaBase As Integer
'
(Note that Int is a math function so Intel is used for intelligence instead)
'
Modifiers for each ability score
StrMod As Integer, DexMod As Integer, ConMod As Integer
IntMod As Integer, WisMod As Integer, ChaMod As Integer
'
Saves, Total of base and temp. bonuses. Read-Only
FortSave As Integer, RefSave As Integer, WillSave As Integer
'
Base saving throw
FortBase As Integer, RefBase As Integer, WillBase As Integer
'
Movement Speed for non-walking modes (string)
SpeedStr As String
'
Current movement speed (calculated)
Speed As integer
'
Base movement speed
SpeedBase As integer
'
Face/Reach, or Space/Reach in DnD 3.5
FaceReach As String
'
Armor Class -------AC As Integer
'
Regular AC
ACFF As Integer
'
Flat Footed AC (no dex)
Touch AC (no armor)
ACTouch As Integer '
ACArmor As Integer '
Is actually permanent _natural_ armor: (Armor bonuses not included in ArmorWorn
and Shield)
ACMisc As Integer '
Size, and any other
ACSize As Integer '
Size mod to AC (unused)
Sum of all temporary mods. Read-Only
ACTemp As Integer '
ACDex As Integer '
Dex bonus to AC (limited by armor possibly)
ACMelee As Integer '
Effective AC vs melee (from conditions)
ACRanged As Integer '
Effective AC vs ranged weapons (from conditions)
ACTouchMelee As Integer '
Touch AC (no armor)
ACTouchRanged As Integer '
Touch AC (no armor)
Sum of all temporary mods for armor/natural. This is from conditions.
ACArmorTemp As Integer '
'
Hit Points
HP As Long
'
Current Hit Point total (as of version 1.17, also includes temporary hit points)
HPBase As Long '
Maximum HP (also includes temporary HP as of version 2.07)
Current Subdual damage
Subdual As Long '
'
The attacks this creature has
NoAttacks As Integer
Attack(0 To MAX_ATTACKS) As Attack
'
Last selected weapon – you can read this as the currently wielded weapon
'
This is the index in the Attack array above.
LastAttack As Integer
'
Attacks of opportunity: How many are left, what is the max # (per round)
AoOLeft As Integer
AoOMax As Integer
'
Base attack bonuses
BAB(1 To MAX_BAB) As Integer '
-99 = no attack
'
Data related to the current combat
Initiative As Single
'
Current initiative value
InitBonus As Integer
'
Total init bonus (w/dex). Read Only
InitMiscBonus As Integer '
Other bonuses like improved init.
InitTempBonus As Integer '
From conditions.
Round As Long '
Round the creature will be in the next time it acts
Enemy As Boolean '
If true, then its an enemy (duh)
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'
----- Conditions ----Condit(0 To MAX_COND) As Boolean
'
is the condition active
ConditInit(0 To MAX_COND) As Single
'
initiative at which it ends
ConditExp(0 To MAX_COND) As Integer
'
rounds left until it ends
ConditExpRd(0 To MAX_COND) As Integer '
round at which it ends
'
The counters
CounterInit(0 To MAX_COUNTERS) As Single '
initiative at which it ends
CounterExp(0 To MAX_COUNTERS) As Integer
'
rounds left until it ends
CounterExpRd(0 To MAX_COUNTERS) As Integer
'
round at which it ends
CounterName(0 To MAX_COUNTERS) As String
'---------------------------------------------------------------------'---- Condition Effects ---------------------------------------'----------------------------------------------------------------------Note that starting in version 2.15, it is recommended to replace calls like
cr.AttMelee = cr.AttMelee + 2
with the more general call:
cr.AddModifier "Att Melee", +2, "Luck"
As you can see, this allows you to specify the type of bonus, allowing for stacking rules to be enforced. The
old calls are still supported, and are the equivalent of adding an untyped (also called unnamed) modifier.
Note that modifier names have spaces, e.g. "Att Melee", "Damage Bonus".
Calls of the type:
X = cr.AttMelee
are equivalent to
X = cr.GetBonus("Att Melee")
and both can be used.
See the Scripting – Creature Functions section for implementation details.
Note that in order to have a game effect, all of these modifiers must be changed from a feat'
s "special" code,
set for Condition Effect. Changing any of these once (like in Get Feat) will have no effect, because they are
recalculated all the time. This is distinct from base values like FortBase, StrBase, which can be modified only
once with lasting effect.
Melee Attack Bonus if creature is defender
DefMelee As Integer '
DefRanged As Integer '
Ranged Attack Bonus if creature is defender
'
attack bonus for this creature with thess condition
AttMelee As Integer
AttRanged As Integer '
ranged attack bonus for this creature with these condition
just partial actions?
CanActPartial As Boolean '
CanActFull As Boolean '
take full actions?
CanAct As Boolean
'
the creature can act at all (partial or full)
LoseDex As Boolean
'
lose any dex bonus to AC
ConditionStr As String '
A short String with the current conditions
ConditionNotes As String '
RTF String with notes about the condition effects
MissChance As Integer '
% chance to miss
'
only a move for this turn
OnlyMove As Boolean
DamageBonus As Integer '
temp bonus to damage (all sorts)
SpellFail As Integer
'
other temp bonuses
SkillBonus As Integer
AbilityBonus As Integer

'
modifier when rolling skills
'
when rolling ability checks

'
-- Various types of AC bonuses --ACGeneral As Integer '
Sum of unspecified bonuses. Corresponds to modifier name "AC".
ACDeflection As Integer
ACDodge As Integer
ACLuck As Integer
ACSacred As Integer
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ACHaste As Integer
ACProfane As Integer
ACInsight As Integer
ACNaturalArmor As Integer
DamageMelee As Integer '
Damage modifier to melee attacks only
DamageRanged As Integer '
Damage modifier to ranged attacks only
'
Damage reduction (plus to overcome)
TempDRPlus As Integer
TempDRAmount As Integer
'
DR, HP absorbed
TempSpellResist As Integer
TempPowerResist As Integer
TempSpellFail As Integer
TempInitModifier As Integer '
Modifier to initiative bonus
TempHPStr As String
'
Unused-Temporary hp - lost first
TempHPGoAway As String '
Unused-HP that go away - as in barbarian rage
TempHPNum As Integer '
Temp HP, added to total.
TempHPExp As Integer
LevelLoss As Integer '
Unused
TempResistanceStr As String
'
returns, for example 5/Acid, 10/cold
'
Bonuses to the saves (from conditions, or feat effects)
RefBonus As Integer
WillBonus As Integer
FortBonus As Integer
'
New ability scores, -1 = keep the old one
NewStr As Integer
NewDex As Integer
NewCon As Integer
NewInt As Integer
NewWis As Integer
NewCha As Integer
'
Modifiers to the current ability score (Str = StrBase + ModStr)
ModStr As Integer
ModDex As Integer
ModCon As Integer
ModInt As Integer
ModWis As Integer
ModCha As Integer
SaveVsFear As Integer '
saves vs fear effects only
SaveVsCharm As Integer
ConditionMaxDex As Integer
'
Max Dex from conditions
ConditionCheckPenalty As Integer
'
----------------------------------------------------------------'
---- End Condition Effects -----------------------------'
----------------------------------------------------------------'
----- Skills ----'
The skills for this creature
SkillRanks(0 To MAX_SKILLS) As Single
'
Ranks bought (can be .5)
SkillMisc(0 To MAX_SKILLS) As Integer
'
Any misc mods (race, synergy...)
SkillTotal(0 To MAX_SKILLS) As Integer '
Misc+ranks+ability mod. Read-Only
SkillTemp(0 To MAX_SKILLS) As Integer
'
Temporary, from conditions. Read-Only
SkillInfo As String
'
Info such as craft (pottery), etc.
ForcedClassSkills
'
comma-separated list of skills that are always class skills.
'
----- Feats ----FeatList(0 To MAX_FEATS) As Boolean
'
true = has the feat
FeatMisc As String
'
info like Empower (Magic Missile), etc.
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'
----- Items ----'
Data for items
NumItems As Long
Items() As Item
'
array of item records
'
The following read/set the property for the item # entered in parentheses
'
for example. Cr.ItemCharges(num) = 3
'
x = cr.ItemCount(num)
ItemName(num) '
(read only)
SetItemName(num, NewName)
ItemGP(num)
ItemWt(num)
ItemIgnoreWeight(num)
ItemCount(num)
ItemEquipped(num)
ItemDesc(num)
ItemFound(num)
ItemNumContained(num) '
(read only)
ItemCharges(num)
ItemChargesFull(num)
'
New v.2.06 – Value indicating whether sorting is locked out for this PC
ItemSortLockedOut As Boolean
'
Armor and shield (read from equipped items)
'
These cannot be read directly – use GetArmorStat (see below)
Private ArmorWorn As Armor
Private Shield As Armor
'
Weight/value of items (calculated)
TotalWeight As Single
EquippedWeight As Single
TotalGP As Single
'
Calculated load values
LoadLight As Long
LoadMedium As Long
LoadHeavy As Long
CarryingMultiplier as single '
multiplier to carrying capacity (not including size)
'
Money Money Money
Cash As Single
CashPP As Long
CashGP As Long
CashSP As Long
CashCP As Long
Valuables As String

'
total, in gp. Calculated

'
gems and such

'
----- Spells ----'
This creatures'spell list
SpellList(0 To MAX_SPELLS) As Boolean
'
true = has the spell
SpellMem(0 To MAX_SPELLS) As Byte
'
times memorized
SpellSlotFull(0 To MAX_CLASSES, 0 To MAX_SPELL_LEVEL) As Byte '
max spell slots
SpellSlot(0 To MAX_CLASSES, 0 To MAX_SPELL_LEVEL) As Byte
'
remaining spell slots
SpellMaxLevel(0 To MAX_CLASSES) As Byte
'
Max level for each spell casting class (unused for now –
always 0!)
SpellKnownByClasses(0 To MAX_SPELLS) as string '
Return or set the "Known By" list for the given spell
SpellResistance As Integer
SpellNotes As String
'
Misc notes about spells '
New v.1.14.172
'
New v.2.03
'
Preset lists of memorized spells to use each morning (see the Spells menu)
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SpellMemorizedListName() As String '
The name of the list (e.g. "Dungeon")
SpellMemorizedList() As String
'
The list (like in stat blocks)
SpellMemorizedNum As Integer
'
----- Classes ----NumCrClasses As Integer
ClassName(0 To MAX_CLASSES) As String
ClassLevel(0 To MAX_CLASSES) As Integer
ClassLevelBase(0 To MAX_CLASSES) As Integer
ClassNotes(0 To MAX_CLASSES) As String

'
Abbreviation
'
Base level (in case levels were lost)
'
Notes for the class

Level As Integer
'
Total levels in classes (read only)
ECLevel As Integer
'
Equivalent level (read only)
RaceLevelAdjust As Integer '
Level Adjustment from race. (read only)
TemplateLevelAdjust As Integer '
Level Adjustment from templates applied, new v.2.04 – this is writable
TotalHD As Integer
'
Total HD = class levels + race HD (ignoring 1) (read only)
RaceHD As Integer
'
Race HD (not adjusted) (read only)
'
----- Psionics ----PowersList(0 To MAX_POWERS) As Boolean
'
powers the char has
'
akin to spell resistance
PowerResistance As Integer
PowerPointsMax As Long
'
Max stored PPs (total of Base + Ability + Temp)
PowerPointsMaxBase As Long
'
Base Max stored PPs
'
bonus from ability score (read only)
PowerPointsMaxBonus As Long
PowerPointsMaxTemp As Long
'
Temporary bonus to max PP
PowerPoints As Long
'
Number left
TalentsLeft As Integer
'
talents left
PsionicFocus As Integer
'
Number of psionic focuses
'
New v.2.05
'
-- Hit Die details –
'
Modify these values manually to change a PC'
s hit die (for example, when templates reroll HD).. See also
the RerollHD, RecalcHP functions and other related functions.
The number of entries in the HD columns (is equal to the number of hit die)
HD_num As Integer '
HD_Roll(1 To MAX_LEVEL) As Integer '
The die rolled for this particular level, e.g. '
8'
The number of hp rolled for this roll (e.g. 6)
HD_hp(1 To MAX_LEVEL) As Integer '
HD_source(1 To MAX_LEVEL) As Byte '
The source of this hit die:
'0: Race
'1: Class
'2: Creature advancement class
'3: Race, but lost because of class
HD_Con(1 To MAX_LEVEL) As Byte '
Get the con bonus? Set <> 0 if yes
'
New v.2.07
GrappleBonus As Integer '
Permanent grapple bonus (added to size, etc)
GrappleTemp As Integer '
Temp grapple bonus (later, unused for now)
'
new v.2.11
'
More Custom Variables, these are displayed in the new Custom tab.
CustomVar (0 To 15) As Long
'
new 2.12: Permanent Energy Resistance
PermanentResistance As String
'
Internal detailed resistances (not saved: they are recalculated on each CalcConditions)
'
Note that the way these are saved, they are overlapped – that is, if you have "10/cold" and "20/cold", only
one instance of ResistanceName "cold" with a ResistanceVal of 20 will show up.
NumResistances As Integer
ResistanceName() As String '
Name of the energy (acid, cold, etc.)
ResistanceVal() As Integer '
# of HP absorbed
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Scripting – Creature Functions
(Go back to Scripting )
Many of these are fairly self-explanatory. Comments in green, after the function definition,
explain the function further. Precede your call to the function with "Cr."
'
---- Basic Character Stats -----Function GetCrClass(ByVal num As Integer) As Class
Function GetClassLevel(ClN As String) As Integer
Function GetClassNum(ClN As String) As Integer
Function GetLevel() As Long
'
Returns the total character level of the PC
Function GetRace() As Race
Sub ReadSpeedStr()
'
Reads '
SpeedStr'string variable to determine base walking speed
Sub CalcSpeed()
'
Calcs the speed from Armor and/or load using the RULES.TXT
'
Sets it in the Speed variable
Function GetSizeMod() As Integer
Sub IncreaseSize(TheNewSize As String)
'
Increases the size of the creature (used in monster advancement, or templates)
'TheNewSize is a one-letter string abbreviation of the size (S for Small, etc.)
Function GetXPNextLevel() As Long
'
Returns amount of XP for the next level to be gained.
Sub AddToDesc(RTFText As String, AddHeader As Boolean)
'
Adds the text to the description (rich text format) Set AddHeader to true.
Function GrappleTotal(StrDetails As String, Optional AddBonus As Boolean = True) As Integer
'
Returns the total grapple bonus, and the details for the calculation in StrDetails
'
If AddBonus is false, the "other" bonus is not added.
Function ChangeCon(NewCon) As Integer
'
To change a PC'
s consitution and affect the base hit points at the same time.

'
---- Hit Dice and Hit Points -----Function GetNumHD() As Integer
'
Returns the number of hit die
Sub RerollHD (NewHD As Integer, RaceOnly As Boolean, Optional DiscardClasses As Boolean = False,
Optional MultiplyHitDie As Single = 1)
'
For Templates:
'
For the total HD the creature currently has, reroll as though it were actually rolled with a dice of value
"NewHD"
'Set RaceOnly to true and class HD are kept the same value
'if DiscardClasses is true then HD from classes (except monster advancement) are ignored
'If MultiplyHitDie isn'
t 1 then the number of hit die after dropping classes/race is multiplied by that number
Sub AddHitDie(roll As Integer, newHP As Integer, Source As Byte, ConBonus As Byte)
'
Roll: die rolled for this particular level, e.g. '
1d8'
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'
newHP: The number of hp rolled for this roll (e.g. 6)
'
source: Source of this hit die
'
conBonus: Get the con bonus? Set <> 0 if yes
Sub RemoveHitDie(num As Integer)
'
Remove hit die # num from the list of hit dies.
Sub RecalcHP(ResetHPLeft As Boolean)
'
Recalculates total HP, from each hit die'
s total
Sub AddBaseHPManually(NewTotal As Integer)
'
Fixes each HD individually so that the final total is NewTotal
Function MakeHDString() As String
'
Returns the HD of the creature in the xd8+3+xd6 etc.

'
---- Skills ----Sub ReadSkills(ins As String, Optional AddMiscBonusesOnly As Boolean = False, Optional
SubtractMiscBonuses as Boolean = False)
'
Reads "Balance +2|2, Spot +4" etc... into skills
'
if AddMiscBonusesOnly then only the misc bonuses are added - nothing else
'
if AddMiscBonusesOnly is false then also, all ranks etc are reset to 0 before the read
' If SubtractMiscBonuses AND AddMiscBonusesOnly are True, then the misc bonuses are substracted
instead of added
Sub CalcAllSkills()
'
Recalculate all skill totals. Note: This does NOT run the SkillBonus global script, as you cannot run a script
within another script.

'
---- Spell Casting and Psionics ----Function CanCastArcane() As Boolean
'
Returns true if one of the classes can cast arcane spells
Function CanCastDivine() As Boolean
'
Returns true if one of the classes can cast divine spells
Function ClassIsPsionic(ByVal Index As Integer) As Boolean
'
Returns true if the character'
s class number Index is a psionic class
Function ClassSpellCasting(ByVal Index As Integer) As Boolean
'
Returns true if the character'
s class number Index is a spellcasting class
Sub AutoSpellList(Optional defS As String = "")
'
Prompts the user to create a spell list
Sub ClearSpellList(Optional MemorizedOnly As Boolean = False)
'
Clear old list of spells,
' or only resets the # memorized to 0 if MemorizedOnly is true
Sub ReadSpellsKnown(ins As String, Optional PsionicMode as boolean)
'
Reads a comma-separated string into a list of spells
'
Set PsionicMode to true when read a list of Powers (same as ReadPowers)
Sub ReadSpellsMem(ins As String, Optional DetailedInfo As Boolean = False, Optional ForceClass As String
= "")
'
Reads a comma-separated string into a list of times spells were memorized
'
Doesn'
t clear list beforehand
'
DetailedInfo: Always keep false
'
ForceClass : Set to "" to automatically choose the class. Set to "Race" for example to read spell-like abilities
Sub ReadPowers(ins As String)
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'
Reads a comma-separated string into a list of Powers
'
Same as ReadSpellsKnown(ins, true) since version 2.09.
Function UseSpellSlot(ClassName As String, LevelOfSpell As Integer, NumUsed As Integer)
'
Substract NumUsed slots from slot # LevelOfSpell for class ClassName
Function SpellSlotsToFull() As Boolean
'
Resets spell slots, returns TRUE if anything changed
Function GetSpellDC(ByVal ClNum As Integer, ByVal SpLevel As Integer) As Integer
Function GetSpellCastLevel(ByVal ClNum As Integer) As Integer
'
Get the effective spellcasting level for # Class ClNum
Function GetPsionicManifestLevel(ByVal ClNum As Integer) As Integer
'
Get the effective psionic manifesting level for Class # ClNum

'
------------ Advanced Spell/Power Learning Functions----------These functions can be used when ReadSpellsKnown and ReadSpellsMem are not
sufficient.
The functions require the Spell ID: use func.GetSpellNum to find it.
All of these functions will work equally on psionic powers as on spells.
!
"
#
"$
% !
" &
'
- Learn a spell/psionic power, and specify the "Known By" class '
SpellId: The ID# of the spell in question. Use Func.GetSpellNum("SpellName", False) or
Func.GetSpellNum("PsionicPowerName", true)
'
ForceClass = "X": Always set the known class as X. For instance, set to "Race" to force a spell to be a racial
ability.
'
AllowInput = If True then prompt the user if needed (that is, if there is more than one possible class that
could use this spell)
'
DefaultClass = "X": Use X when a choice would be presented (AllowInput must be false). If no user input is
allowed, and DefaultClass is not set, then the first valid class found is used.
'
---'
E.g. To give a spell-like ability:
num = func.GetSpellNum("Fireball", False)
if num > 0 then
call cr.LearnSpell(num, "Race")
End If
---Sub SpellKnownMemorize(ByVal SpellID As Integer, MemorizeStr As String)
'- Add a memorization to the list '
SpellID: ID of the spell (use func.GetSpellNum)
'
'
If the spell is not already known it will be learned automatically (using LearnSpell)
'
An extra memorization is added to the list for that spell.
' The class that has it memorized is set by MemorizeStr
'
---'
For instance, this will memorize the spell Fireball as a Sorcerer
num = func.GetSpellNum("Fireball", False)
if num > 0 then
call cr.SpellKnownMemorize(num, "Sor")
End If
---Sub SpellKnownUnMemorize(ByVal SpellID As Integer, SlotNumber As Integer)
'
Remove a memorization from the list, the one at index SlotNumber (starts at 1)
'
SpellID: ID of the spell (use func.GetSpellNum)
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Function SpellKnownFindMemorizedSlot(ByVal SpellID As Integer, ClassName As String) As Integer
'
- Look in the MemorizedList to find a slot to call –
'Explanation: Each spell has a list of memorized slots, and the class that memorized it. For example, a
Clr/Pal who memorized Bless for each class in a certain order might have '
Clr, Pal, Clr, Clr'in the list of slots
for Bless
'Basically this allows you to know if a spell has been memorized for a specific class or not. It returns 0 if the
class name does not match any slots
'
'
SpellID: ID of the spell (use func.GetSpellNum)
'
ClassName: The class that memorized the spell
This variable is the index in the list of memorized slots that was last selected. You can either read or set the
value (also see SpellKnownFindMemorizedSlot, above) :
cr.SpellKnownLastSelection(ByVal SpellID As Integer) as Integer
This variable is a string with the list of memorized slots. It is formatted with the pipe character as a separator,
and metamagic feats in parentheses. For instance: "Clr|Clr(maximized)|Pal"
cr.SpellKnownMemorizedList(ByVal SpellID As Integer) as String
Function SpellKnownBySpecificClass(ByVal SpellID As Integer, TheClassName As String) As Boolean
'
- Is this spell known by a certain class? '
Returns true/false depending on whether that spell is known by that class
'
'
SpellID: ID of the spell (use func.GetSpellNum)
'
TheClassName: The class that the spell should know

'
------------ Items ----------Function CoinWeight() As Single
Sub SpendGP(OriginalCost As Single)
'
Spends that amount of money. OriginalCost is in gp.
Sub ReceiveGP(NumGP As Single)
'
Add a certain amount of gold (or other) coins to the character'
s cash
Function HasArmor() As Boolean
Function HasShield() As Boolean
Function GetArmorStat (ByVal LookShield As Boolean, ByVal StatName As String) As Variant
'
Returns the stat for the armor/shield used.
'LookShield: Set to true to get shield data, otherwise its the armor.
'StatName: Either "Name", "Ac" (Non-magical ac bonus), "Magic" (magical bonus),
' "MaxDex", "Check" (skill check penalty), "SpellFailure"
'
"PROFICIENCY": 0 = none; 1 = light; 2 = medium; 3 = heavy
Sub CalcLoads()
'
Calculate carrying capacity, saves in the creature'
s variables
Sub ReadEquipment(sEquip As String)
'
Reads an equipment string (like from a stat block format) and adds it to the inventory.
'
Will look for Standard Items matching the name and use them, if any are found.
Sub RemoveItem(num As Integer, Optional SellPercent As Integer = 0)
'
Removes item # num (find a particular item by scanning from 1 to cr.NumItems
'
Set SellPercent to 100 to get 100% of the value in gp added to coins.
'
The following functions need as a parameter the item number and a string with the item property. See the list
of properties in Scripting – Item Properties.
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Public Function GetItemStat(ItemNum As Integer, PropertyName As String, Optional ArrayNum As Integer =
1)
'
Returns the property named PropertyName from the item ItemNum
'
If PropertyName is an array, the index looked at is ArrayNum
Sub SetItemStat(ItemNum As Integer, PropertyName As String, ValueToSet As Variant, Optional ArrayNum
As Integer = 1)
'
Sets the property named PropertyName from the item ItemNum
'
If PropertyName is an array, the index looked at is ArrayNum

'
---- Attack-related functions -------Function GetCurrentAttack() As Attack
'
Returns the last selected attack
Function ChooseOneAttack(FeatName As String, AddingFeat As Boolean) As Attack
'
Asks the user to choose one of the attacks of the creature to which to apply a feat (FeatName).
'
This doesn'
t actually apply the feat however.
Sub AddAttack(NewAttack As Attack)
Sub RemoveAllAttacks()
Sub RemoveAttack(AtNum As Integer)
Function MakeNewAttack() As Attack
'
Creates a blank attack and adds it to the character. Returns the attack object.
Sub MakeBab(FirstBAB As Integer)
'
Make the 2nd/etc. base attack bonuses based on the FirstBab value
Sub FindWeaponHand()
'
Looks at the handedness of the current weapon. Sets CurrentWeaponHandedness
Function FindArmorWeight(LookShield As Boolean) As Single
'
Looks in the items and finds the Weight of the armor
Function UnhideAllAttacks() As Boolean
'
Sets hidden to false for all attacks.
'
Returns True if something changed
Function MoveAttack(AttackNum As Integer, Movement As Integer) As Integer
'
Moves the attack AttackNum in the list by + or - Movement
Public Function AdjustDamageForDR(OrigAmount As Integer, DamageType As String, ByRef
ReturnDRCause) As Integer
'
This functions reads the damage reduction components of ths creature
'
OrigAmount: Original damage
'
DamageType: Type of damage (like '
S/B, fire'etc.)
'
Returns: What damage is left after reduction.
'
ReturnDRCause: Is set to a string explaining the cause of the lowered damage

'
------- Conditions-related functions ----------Sub SetCondition(CondName As String, ByVal CondOn As Boolean, ByVal Expiration As Integer)
'
Looks for a condition named CondName, and sets it to CondOn for Expiration rounds.
Function SetCondName2(CondName As String, Optional Changes As String) As Integer
'
Set the condition, checks for the NOT string.
'
For example "NOT Fatigued" will remove the Fatigued condition whereas
'"Fatigued" alon will set it.
Function GetCondition(CondName As String) As Boolean
'
Returns true if the condition is set
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Sub AddModifier(BonusName As String, ByVal Value As Single, Optional ModType As String, Optional
Subname As String = "", Optional VariableName As String, Optional nSource As String, Optional ExtraString
As String, Optional SemiPermanent As Boolean = False)
'
This adds an arbitrary bonus/modifier to the PC'
s list
' BonusName: See RULES.TXT for a full list of acceptable bonus names. Examples are "Att Melee" or "AC
Deflection".
' Value: The numerical value of the modifier. Can be a floating point (decimal) number.
' ModType: Optional. The type of the modifier - this can be Luck, Circumstance, Enhancement, etc. or any
of the standard modifier types. You can also define new modifier types - just type in a different value than
those in the combo box.
' Subname: Optional. The "subname" is a specialization of the name. For instance, for skill bonuses in
general Name is "Skill", but you need to specify Subname to the name of the skill, like Listen, Spot, etc...
This also applies to DR and energy resistances.
' VariableName: Optional. Name of a custom variable that will replace the value. See below
(cr.SetVariable, etc.) for code to set and retrieve variable values.
' ExtraString: Optional. This is an extra string of information that, in this version, has no game effect.
' nSource: Optional. String indicating what the source of the modifier is. This is set automatically in scripting
to say '
Feat X'
, but can be overriden.
' SemiPermanent:
' Set to TRUE to put the modifier in the '
DM Modifiers'condition - that is, the modifiers that can be
modified on the fly by the user in the '
Condition Modifiers Editor'(Ctrl+F6, see Detailed Modifier Viewer).
Function GetModifier(BonusName As String, Optional Subname As String = "", Optional ExtraString As
String) As Single
'
This function calculates and stacks the matching bonus from all conditions, scripts,
' according to the rules and returns the total bonus value.
' Also, optionally, returns ExtraString, which is extra info from the condition.

'
----------- Custom Variables --------------'
You can declare general variables for use in your feats. Variables are:
'- Persistent: They are saved when closing the program.
'- Unique to each PC
'- For best compatibility, use strings
'
There is no real limit to how many variables a single PC can have,
'
other than memory concerns it can be up to 32000.
'
Custom variables can be displayed in the character sheet using the tag |CUSTOMVAR:
TheNameOfMyVariable|
'You can also filter HTML in the character sheet using the format
|FILTER:CUSTOMVAR: TheNameOfMyVariable|
<b>This html code will only be displayed if the variable is not empty</b>
|ENDFILTER|
Sub SetVariable(VarName As Variant, VarValue As Variant)
'
Creates (if necessary) a custom variable of name VarName and sets its value to VarValue.
'VarName is NOT case-sensitive
'Make sure you use a unique name for VarName, for example:
' WeaponFocus
' UncannyDodgeRog
Function GetVariable(VarName As Variant) As String
'
Get the custom variable of name VarName and returns its value.
'VarName is NOT case-sensitive
Sub RemoveVariable(VarName As Variant)
'
Removes the Variable called VarName. Make sure you call this in FeatRemove to avoid leaving junk!
'VarName is NOT case-sensitive

'
------ Feats -------
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Function HasFeatName(FeatName As String) As Boolean
'
Returns the value of the named feat as true/false
Sub GiveFeatName(FeatName As String, ClassAbil As String, NewVal As Boolean, Optional
AddSecondTime As Boolean = False)
'
Set the named feat as true/false (depending on NewVal)
'ClassAbil is the class corresponding to it if it'
s a class ability
'If AddSecondTime is true then add the feat again if the feat can be taken multiple times (e.g. Weapon
Focus)
Sub ReadFeats(ins As String, Optional DontClearFeats As Boolean = False)
'
Reads a comma-separated string (ins) into a list of feats.
'
Set DontClearFeats to true to keep the current list, and only add to it.
'
Does not call the GiveFeat script code.
Sub RecalculateLevelDependantFeats()
'
For level-dependant feats, recalculate the FeatGet code because level (might) have changed
Function RunFeat(ByVal FeatNum As Integer, ByVal RunWhat As Integer, Optional ByVal RestHours As
Integer = 0) As Boolean
'
-- This functions runs a feat as though the user had clicked a button on the feat tab '
FeatNum: The feat ID
(use func.GetFeatNum)
'
RunWhat: USE button = 2; STOP button = 3; REST button = 4;
'
RunWhat: The Get Feat script is 0 and the Remove Feat script is 1 – but it is not recommended to run these
directly!
'
RestHours: Parameter passed to the REST function

'
------ Other Functions ------Function TurnUndead() As String
'
Makes a turn undead check. Returns the appropriate string to display in the Combat Log.
'
As of version 2.11, this is deprecated by the action button.
Function Rest(FullDay As Boolean) As String
'
Rests the character after a night'
s sleep
'
Set FullDay to True to rest for 24 hours (8 hours otherwise)
'
Returns the description of what happened to this character
Sub Stabilize()
'
Stabilize a dying creature
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Scripting – Attacks
(Go back to Scripting )
The following variables apply to Attack objects, for example those returned by the
Cr.ChooseOneAttack function, or by looking at the members of the Cr.Attack() array.
Name As String
'Name of the weapon only
Kind As Integer '0 = melee, 1 = ranged
Touch As Boolean 'True = melee or ranged TOUCH attack
CrRef As Creature
'Creature that "owns" this attacks
Size As Integer
SizeStr As String
DamageType As String
Range As Long
Weight As Single

'As number, unused
'"S", "M", "L"
'Slashing/Piercing/Bludgeon as String "S/P/B"
'Range increment in feet
'New v.1.12.168

'------ Attack --------'Sum of attack bonuses for weapon only: this is a permanent value.
WeaponAttackBonus As Integer
MagicBonus As Integer
'Magical enhancement - basically used for DR ONLY
'Sum of attack bonuses, less the base attack bonus. This is calculated.
AttackBonus As Integer
'Total Attack bonus for each attack (recalculated)
ab(1 To MAX_BAB) As Integer
'------ Damage --------'Sum of damage for weapon only: this is a permanent value.
WeaponDamageBonus As Integer
'CALCULATED sum of damage bonuses
DamageBonus As Integer
'Number of dice to throw
NoDice As Integer
Dice As Integer
'Value of dice
'damage dice (2d6+3)
DamageStr As String
DamageNote As String
'" and poison" for example
'Second dice of damage (for example "1d8 + 1d6 + 32"
NoDice2 As Integer 'Number of dice to throw (2nd dice)
Dice2 As Integer
Reach As Integer
Material As Integer
Subdual As Boolean
'true = is dealing subdual/ nonlethal damage now.
NormalSubdual As Boolean 'true = a regular attack is subdual/ nonlethal
'true = switched from normal to subdual (or vice-versa)
TempSubdual As Boolean
'String (19-20/x2)
CriticalStr As String
CritRange As Byte
'Range of critical hit. 2 = 19-20 for example
CritMult As Byte
'Multiplier of damage
'Hand used to fight:
'
0=Primary,
'
1=Off-Hand with two weapons
'
2=Primary hand with 2 weapons
'
3=Two-handed
'
4=Off-Hand, but only one weapon.
HandUsed As Integer
'These are calculated from HandUsed
PrimaryHand As Boolean
'if true, in the primary hand, fighting two-weapons
'if true, in the second hand
OffHand As Boolean
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'From the feats
Finesse As Boolean
'dex instead of str
PowerAttack As Integer
Expertise As Integer
'Natural attacks
NoOfAttacks As Integer
IsNatural As Boolean

'max no of attacks
'all attacks are at BAB(1)

'New v.2.00 – Second dice of damage
NoDice2 As Integer 'Number of dice to throw (2nd dice)
Dice2 As Integer
DamageStr2 As String
'damage dice (2d6+3)
DamageNote2 As String
'"plus poison"
DamageBonus2 As Integer
'Specific to the 2nd dice
CriticalStr2 As String
'String (19-20/x2)
CritRange2 As Byte
'Range of critical hit. 2 = 19-20 for example
CritMult2 As Byte
'Multiplier of damage
'Damage type for each dice of damage (magic, fire, etc. – used for Damage
Reduction)
DamageType1 As String 'Renamed version 2.00
DamageType2 As String
GiveSecondDamage As Boolean
WeaponDamageBonus2 As Integer
'New v.2.05
SpecialNote As Integer 'Mostly used to set something as "lycanthrope attack"
Hidden As Boolean 'Set to true to hide that attack
'New v.2.07
OffhandWeaponIsLight As Boolean 'Not saved but re-calculated
'new v.2.11
Category As Integer
'As in, light/2-handed, etc. Used for what handedness
is allowed. And for weapon sizes.
'0: N/A, 1: Unarmed, 2: Light, 3: One-handed, 4:Two-handed, 5:Ranged
HandAllowed(0 To 7) As Boolean

'Which handedness are allowed

Functions
Sub ReadCriticalStr()
'Takes the values in CriticalStr and calculates range/multiplier
Sub MakeCriticalStr()
'Makes the string from the values.
Function RollDamage(DetailedRoll As String) As Integer
'Returns hp of damage
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Scripting – Race
(Go back to Scripting )
The following are the members of the Race class. They are accessible in a feat script if you
check the "Need Race" box. Refer to a member like this: cRace.Name
Id As Integer

'Unique ID for this campaign

Name As String
Size As String
HD As String
'1d8 format
'standard or average HP rolled
StdHP As Integer
sInit As String 'Initiative bonus as a string
sSpeed As String
'AC 14 (+3 Dex, +1 Size)
sAC As String
sAtt As String
'Attacks string
sDam As String
'Damage string
'(and reach)
Face As String
SpecAtt As String
'Special attacks
SpecQual As String
'Special qualities
Climate As String
Org As String
'Organization
Cr As Single
Treasure As String
Alignment As String
'Advancement
Advance As String
Desc As String
'Rich-text
Languages As String
'To calculate
InitBonus As Integer
Saves As String
abil As String
Skills As String
Feats As String

'Unused – just use CInt(sInit) instead

'-- Armor Class -AC As Integer
'Total AC
ACMisc As Integer
'Misc AC box
ACNatural As Integer 'Natural AC
'More Armor/shield
ArmorName As String
ArmorAC As Integer
ShieldName As String
ShieldAC As Integer
'Ability scores (base, or average value)
Str As Integer, Dex As Integer, Con As Integer
Intel As Integer, Wis As Integer, Cha As Integer
'Note that Int is a function so Intel is used for intelligence instead
'Modifiers for each ability score
StrMod As Integer, DexMod As Integer, ConMod As Integer
IntMod As Integer, WisMod As Integer, ChaMod As Integer
'The attacks this race has
NoAttacks As Integer
Attack(0 To MAX_ATTACKS) As Attack
'Saves
FortSave As Integer, RefSave As Integer, WillSave As Integer
'Base attack bonuses (-99 if no attack)
BAB(1 To MAX_BAB) As Integer
'Newer data fields
SR As Integer

'Spell resistance
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PR As Integer
'Power resistance
SpellList As String 'Known spells (or spell-like abilities)
PowersList As String 'Known powers
DamageReduction As Integer
'-1 = silver
DamageReductionPlus As Integer
'-- PC Race data --'(New from v.1.11)
PCRace As Boolean
LevelEquiv As Integer
BonusSP1st As Integer
BonusSPEach As Integer
ExtraFeat1st As Integer
ExtraFeatLevel As Integer
ExtraPP1st As Integer
ExtraPPEach As Integer
FavoredClass As String

'Bonus skill points 1st level
'Bonus skill points at each level
'# of bonus feats at 1st level
'# of levels between the next bonus feat
'Bonus power points 1st level
'Bonus power points at each level
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Scripting – LastDamage Object
The LastDamage object can be accessed from the func.GetLastDamage function. It holds the last
rolled attack results along with info needed to re-roll it. You can change these values directly, for
example, if you want a feat or action button to do an attack.
Kind As Integer
'0 = melee, 1 = range, 2 = thrown
Touch As Boolean
'Set to true if it was a touch attack
AC As Integer
'The AC that's beaten by this attack
CritAC As Integer
'It is a critical hit for this AC or less
Subdual As Boolean
'Subdual or not?
' --- These are to allow you to reroll --Dice As Integer
'Value of dice (e.g. 1d6 = 6)
NoDice As Integer
'Number of dice to throw
DamageBonus As Integer
'Added to roll
CritMult As Integer
'Multiplier for a crit
'Natural 20s or 1s set either of these to true
AutoHit As Boolean
AutoMiss As Boolean
'Extension in version 2.09
'1st Dice of damage:
Damage1 As Integer
'Regular damage
CritDamage1 As Integer
'Critical Damage
DamageType1 As String
'Types of the damage (usually S (for slashing), fire, etc.)
'2nd Dice of damage:
Damage2 As Integer
CritDamage2 As Integer
DamageType2 As String
'A string which will output to the combat log, instead of the normally generated
value. Set to "" to use the default string. Damage will still be subtracted
normally, etc.
ReplacementText As String
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Scripting – Item Properties
These properties are accessible through the cr.GetItemStat() and cr.SetItemStat() function
calls. You need to know the item number – to find a particular item you can loop through all items
and search for a matching name.
Pass the parameter name indicated as a parameter. The names of properties are not casesensitive. When calling arrays, add the optional parameter ArrayNum; and do not put parentheses in
the parameter name. e.g.
call cr.GetItemStat(1, "TreasureChance", 3)
…will access the value of TreasureChance(3) (which is the chance of a major treasure).
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Scripting – Skill Object
You can read and modify skill data by first running func.GetSkillObj(SkillNum As Integer). This
function returns the skill object. For instance:
dim MySkill
set MySkill = func.GetSkillObj(num)
if func.ValidSk(MySkill) then
msgbox MySkill.Name
end if

Members of the Skill Object
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Scripting – Spell Object
You can read and modify spell (or psionic power) data by first running
func.GetSpellObj(SpellNum As Integer). This function returns the spell object. For instance:
dim MySpell
set MySpell = func.GetSpellObj(num)
if func.ValidSp(MySpell) then
msgbox MySpell.Name
end if
Spell levels for example are extracted directly from the rich text description of the spell. To modify
such data, you will need to find the relevant string in the Desc member, and modify it. For instance,
replacing "Clr 0" with "Clr 1" would, in effect, change the spell level from 0 to 1 for clerics.

Members of the Spell Object
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Scripting – Modifying Feats
How to read/modify a feat from a script:
func.GetFeatParam(FeatNum As Integer, ParamName As String)
Returns a parameter (ParamName) from the feat of ID FeatNum
func.SetFeatParam(FeatNum As Integer, ParamName As String, NewValue As Variant)
Sets the feat parameter ParamName to NewValue for the feat FeatNum

Feat Parameters
Feed the name of the parameter as ParamName. The type of value expected/returned is indicated.
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Bulk Data Entry
(Feature not available in Player Genie)

What is Bulk Data Entry?
You might have large number of skills, feats, spells, etc. typed in a text or Word file in a
repetitive format, which you would like to input into DM Genie for in-game use. While it is
possible to copy/paste names and descriptions one by one, for many items it is very time
consuming. This feature automates this data entry.

How Does it Work?
The input text has to be list of rich-text formatted descriptions, with separators between
them (see below). DM Genie will find the text between separators and send it to a script you write
for processing. Since the script can be pretty much infinitely customized, this allows for any text
format you may have.
Warning: this feature could mess up an existing campaign if not used carefully. It is highly
recommended that you make a backup of your entire campaign (ZIP the entire folder) before using
Bulk Entry. Alternatively, you can make a new empty campaign just for testing this, and then export
the files from it.

Separator
DM Genie needs someway to know where one item'
s description starts and the other ends. A
certain string that will not be present anywhere else serves this purpose – for example, "###". There
should be no separator at the beginning of the text, but there should be one at the end. For instance:
My Item Name
Some descriptive text….
###
My Second Item Name
Some descriptive text….
###
My Third And Final Item Name
Some descriptive text….
###
The separator does not need to be alone on a line. It will be removed before processing more
text. For example, to read a comma-separated value file, you could append a ### as the last column.
Your separator would be ",###". Then you can use the split function to split the text string according
to a separator, in this case, the comma. For instance
dim sArray()
sArray = split(text, ",")
Name = sArray(0)
Price = func.CVSng(sArray(1))
Hint: Microsoft Word has a powerful search and replace function that can search for
specific formatting. For instance, if all the names of skills in your text file are bold and red, you can
search for this formatting and quickly insert the separator.

234
Note: Text gets removed from the box as it is processed – so make sure you have a copy
somewhere.

Replace Behavior
By default the program will prompt you if the new item you are adding already exists. You
can set it to automatically replace, or automatically skip existing items. Automatically replacing the
items will make it faster to debug your script.

Scripting
The most difficult part of data entry will be designing a working script – but once you are
successful it will make the rest of your data entry much faster. You need your script to extract the
necessary data from a plain or rich text string. For example, take the following skill description:
HIDE

(DEX; ARMOR CHECK PENALTY)
Check: Your Hide check is opposed by the Spot…

First you will want to extract the name. Use for instance the func.GetLineNum function to
return only the first line in the text. You can use func.Capital to capitalize only the first letter of
each word.
Next you want to extract the skill'
s relevant ability. For this you need to extrat the second
line, and keep only the first word, after the parenthesis.
Then there might be extra info after the ability – as in "Trained only" or "armor check
penalty". You can use instr to search for these strings (watch out for case – you can use ucase to
make all strings uppercase for comparison)
The description should be easy – textRTF is set for you, just assign it to the right member
(like NewSkill.Desc).
For easy of use with the Custom Data Editor, you can set the item'
s source string to the
name of the book from which your new element is taken (NewSkill.Source, NewSpell.Source, etc).
That way it would be easy to delete all items of source X if there was a mistake.
You can use outputting to the combat log, or message boxes to help you in debugging.
The following variables are accessible (depending on the type of object selected):
•
•
•
•

•
•

•

text: The plain text extracted between the separators. Any blank lines at the beginning or end
have been trimmed.
textRTF: The RTF text between the separators. Any blank lines at the beginning will have been
trimmed.
ForceCancel: Set to true (ForceCancel = true) to stop processing immediately. The latest item
is NOT added. This might be useful in debugging your script.
ForceSkill: Set to true (ForceSkip = true) to skip this particular item. This might be used to
filter your data input, to add only feats corresponding to a certain criteria for example.
Processing continues afterwards
NewSkill or NewSpell: The object that will soon be added to the campaign'
s data.
num: For feats: the feat number to use to modify the feat'
s parameters. You will use
func.SetFeatParam to edit this feat. It will then be added (possibly at a different feat number) to
the normal list of feats.
num: For items: the item number to use to modify the item'
s parameters. You will edit the item
using cr.SetItemStat. cr is just a dummy creature that temporarily holds the item. After creation
the object is copied to the standard items list.
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What about Races?
There is a separate feature for Automatic Race Creation – it is accessible in the race editor.

What about Classes? Templates?
Sorry, the descriptions of classes don'
t usually follow any regular format and so would be
near impossible to script. It will probably be faster to enter the data manually than to try to script a
reader.
For templates, the meat of the problem is in scripting it – there are basically only 4 fields:
name, description, requisite code, and main code. DM Genie cannot write template scripts for you,
sorry, even if you are running a HAL 9000!

Can I see the example code again?
If you changed the code for a type of entry, but want to get the sample code again, just
remove your code entirely, click on a different entry in Type Of Data, and click back. The default
code will be restored.

